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Preface

Preface

Welcome to the IDEA Workbook. IDEA is a comprehensive file interrogation tool for auditors,
accountants, and investigators. With IDEA, you can:

e Analyze complex data

e  Extract unusual items

e  Create audit samples

e Identify duplicate transactions

e  Carry out many other functions that are easy to perform using the specially
designed, intuitive Windows interface

This Workbook has been produced as a comprehensive tutorial for new IDEA users in North America
who are unable to attend a scheduled training course in their area. It goes into more depth than the
Getting Started Tutorial in the user guide provided with IDEA and illustrates some common audit
tests. Step-by-step instructions with solutions are provided to explain how to perform three separate
audits/investigations as follows:

e Accounts Receivable Audit
e Accounts Payable Audit and Fraud Investigation

e Inventory Analysis

Each of these audits/investigations increases in complexity in using IDEA's functions and tests,
building on the experience learned in earlier sections. Therefore, it is recommended that the sections
be completed in sequence. However, you may also wish to review a particular section before
conducting a similar audit, investigation, or analysis.

Each section within an audit/investigation has an audit objective as well as an IDEA lesson objective
explaining the particular features of IDEA to be learned during the exercise.

The data files for each audit/investigation have been provided on the accompanying CD. The data
files have been created in a variety of file formats to provide experience in importing data from a
number of difference sources. The numbers of records and fields within each data file have been
restricted for speed and practicality.

We hope you enjoy using IDEA.
We wish to acknowledge the assistance provided by Efrim Boritz and Malik Datardina and the

University of Waterloo Centre for Information System Assurance
(http://accounting.uwaterloo.ca/uwcisa/).






Setting the Scene

Section 1

Introduction to the IDEA Workbook

For the purposes of this Workbook, you are an audit manager with a firm of Chartered
Accountants, Dynamic Accountants, based in Ontario, Canada.

Your client portfolio includes a number of medium-sized companies, family-owned businesses and
retailers. In order to prosper in the ever-increasing competitive market you have identified the need
to:

e Improve the efficiency of audits
e Improve the quality of audits and business advice given to clients
e  Provide added-value services to clients

e Win new clients by offering exciting new services

You have seen demonstrations and read articles on how the IDEA Data Analysis Software will
enable you to meet these needs and you have recently purchased IDEA.

You have selected your premiere client, Bright IDEAs Inc., a rapidly expanding retailer of innovative
promotional material, to pilot your use of IDEA. Both you and the Chief Financial Officer, Mr.
Cuthbert, are concerned that the levels of controls have not increased to meet the growth in the
business and after consultation with your client you decide to use IDEA on the Accounts Receivable
area of the audit. Additionally, the client asks that you investigate a suspected case of fraud and to
assist with a problem they have identifying obsolete stock and the subsequent calculation of
inventory provisions. All audits and investigations were highly successful and have identified
problems and weaknesses, which would have been extremely difficult to accomplish without the use
of IDEA. As a result of your testing and recommendations that the client has implemented, his
business has won the “Business of the Year” award and the Chief Financial Officer has publicly
praised your services resulting in many new clients.



12 | IDEA Version Ten Workbook

How this Workbook This Workbook provides an overview of the process of auditing using IDEA and provides step-by-

is Organized

step instructions for carrying out the following audits/investigations that you conduct for Bright
IDEAS Inc.:

e Accounts Receivable Audit
e Accounts Payable Audit and Fraud Investigation

e Inventory Analysis

Each audit/investigation is provided in a separate section of the Workbook. An overview to each
section explains the objectives of the audit/investigation, how to plan for the testing, and how to
request the required data.

A wide range of data file formats have been used to provide you with experience at importing
different file types.

Instructions are provided for preparing for the exercises, including copying the relevant data files.

The exercises have been designed to cover most tests and options within IDEA and both the audit
objectives and the exercise details are stated for each test carried out. Each section increases in
complexity. Therefore, it is advised that the exercises are completed in order. However, you may
wish to repeat or review sections, particularly before conducting a similar live audit. Solutions are
provided for each exercise and many images of menu or toolbar button selections, completed dialog
boxes, resultant databases, and reports are included for clarity.

Note: You can customize many options, including toolbars, within IDEA. This Workbook provides
instructions and images using the default toolbars and settings.

Please read the following section that outlines the use of IDEA before commencing the exercises.
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Overview of the The stages of Using IDEA

Use of IDEA
The exact process of using IDEA varies with circumstances, but the main steps are set out in the
following chart.

The first three stages are planning stages and are key to getting the most out of IDEA.

Consider Audit
Objectives

Determine how IDEA is
appropirate for the audit

Specify the data required

Arrange download of the
data

Utilize IDEA

Review and
Housekeeping
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Determine How IDEA is Best Utilized

In order to decide how to use IDEA on an audit, a brief evaluation of the following topics should be
completed with an assessment of whether the benefits outweigh the costs:

e Key audit objectives and problems
e Volume and depth of information held on computer

e Fase of downloading data
Objectives and Problems

IDEA is most useful when there is a problem to solve on an audit. It may be assessing the extent of
bad loans, debts, or inventory provisions, looking at performance in collecting cash or simply
speeding up the time to prove calculations. Whatever the reason, there should be a core purpose
which drives the use and benefits of IDEA.

IDEA is generally used for substantive testing. When there is a need to determine if items are in
error, a problem needs to be quantified, or certain items identified, then IDEA should be used. IDEA
can also help with checking procedures. An indirect way of checking procedures is to draw an
inference about the effectiveness of procedures based on the results of substantive tests; e.g., it
may be inferred that if there are no errors then the procedures must be working. Conversely, if
there are errors then it may be inferred that procedures are being applied incorrectly and that
controls are not effective. IDEA can also be used when checking computer-based controls by re-
performing edit checks, matching and other computer-based procedures.

Refer to subsequent sections in this Workbook or the online Help available from the Help menu in
IDEA to learn more about the uses of IDEA and its tests.

Volume

Classically, data analysis techniques are appropriate with a large volume of small value transactions.
Generally, this is true with IDEA,; therefore, the greater the volume of data the more useful IDEA will
be for the investigation. If there are fewer than a few hundred records, then IDEA is unlikely to
provide much benefit over manual work.

For large files, say over 100,000 records, then a calculation of the required disk size should be made
(i.e., number of records multiplied by the approximate space each record takes). IDEA can be used
on files with several million records, but a fast computer with a large amount of disk space will be
essential.

The amount of data available for each item also makes a difference to the potential benefit of using
IDEA. Items with a full history and comprehensive detail will allow a wide variety of tests. IDEA will
be restrained to some simple calculations, analysis, and sampling if only the sparest information is
available.
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Typically, IDEA will be useful when a client has:

e  Accounts Receivable: more than 200 balances and 1,000 transactions
e  Fixed Assets: more than 1,000 items
e [nventories: more than 1,000 stock lines

e  Purchases: more than 2,500 transactions
Ease of Download

If there is a major cost in using IDEA then it is likely to be incurred when downloading the data. The
data has to be transferred from the “host” (source) computer to the computer running IDEA or
onto a network location accessible by the auditor/analyst’s computer. This may be quite simple and
only take a few minutes or it may be more complex and involve a query or report being written. It
may also require the use of equipment to convert data or to read a particular tape or cartridge
format. If a bureau or agency is used, they may charge for their services. Some technical assistance
may be required and technical assistants may charge for their services as well.

In most cases, the client will supply you the accounting files, or a printout of the files, via CDs or
email messages.

Once a downloading method has been set up and used for a particular system or computer,
subsequent downloads are usually straightforward and the costs (if any) will be known. However,
for the first time, an estimate of time and costs will need to be made.

When to Use IDEA

The likely benefits from using IDEA can be assessed from the audit objectives and expected
problems, as well as the volume and width of data. Additional consideration should be given to the
usefulness of additional analysis over what is currently provided by the system and whether any
special factors apply, such as fraud detection and investigation, and special investigations.

Costs are largely determined by the effort involved in obtaining and downloading data. There is
some time in actually performing the IDEA tests, although this is not normally significant. It is also
usual that far more “exceptional” items and queries will be identified when using IDEA than with
other methods, and these may require follow-up time. Alternatively, these items may be given to
management for follow-up.

The use of IDEA often replaces other tests and provides overall time savings. Alternatively, the
reason for using IDEA may be to add to the scope, in which case the extra costs should be defined.
Clearly the cost of using IDEA must be balanced against the benefits.

| 15
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In summary, IDEA should be used in audits where:

e There is a core purpose or reason
e There are a reasonable number of records
e There is a depth of information on the items

e The data transfer is technically feasible at a reasonable cost and volumes can be
accommodated on computers or networks

Audit In routine audits, IDEA can be used to meet the following objectives:

Objectives . .
) Mechanical Accuracy and Valuation

One of the first things IDEA should be used for is to total the records in the file and to prove the
accuracy of any calculations. Add up the records in the file by using the Field Statistics property.
Calculations can be checked either by appending a new field (in the Field Manipulation dialog
box), using the Criteria link in the Properties window to create a calculation of the item, or by
performing an exception test of miscalculations using one of the Extractions tasks.

The accuracy of any management reports may involve a wider use of functions to achieve the result
of reproducing the report. In these cases, performing a series of joins and/or summarizations or
running the Aging task, in the case of aged debt analysis, may be necessary.

Analysis

IDEA can help with the preparation of figures for an analytical review. In particular, IDEA can
generate analyses that would not otherwise be available. The Stratification task (from the Analysis
tab on the IDEA Ribbon) generates a profile of the population in value bands, groups of codes, or
dates. This is particularly useful when auditing assets such as Accounts Receivable, inventories,
loans, or for a breakdown of transactions. Additionally, the information can be summarized by
particular codes or sub-codes. Figures can also be compared against previous years to determine
trends. A chart can be produced if required.
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Existence and Validity
A number of tests are available for proving validity:

o Exception testing can be used to identify unusual or strange items. These may
be simply large items or where the relationship between two pieces of
information on an item does not correlate (e.g., rate of pay and pay grade). Many
fields of information can also be checked for allowable values (e.g., standard
fees).

e Statistical sampling is commonly used to test for validity in a manner that allows
for evaluation across a population. The more sophisticated methods, such as
Monetary Unit Sampling, are difficult to implement manually. Wherever tests
need to refer to physical documentation or assets rather than computer records,
an appropriate statistical sampling technique should be used.

e Duplicates testing can be very effective in certain circumstances, such as testing
payments or looking for double input of ticket numbers during inventory counts.

It may be necessary to join (using the Join Databases task) two databases together first in order to
perform a validity test (i.e., transaction file to a master file).

Completeness
The two main tests for completeness are Gap Detection and matches:

e  Gap Detection (under the Analysis on the IDEA Ribbon) identifies missing
numbers or days. There obviously must be a sequential number/date on source
documentation for this to work. Receivables and sales files can be tested for
missing invoice numbers. It may also be appropriate to test for gaps on a series of
check numbers and for completeness of inventory ticket numbers.

e  Matching crosschecks between a master file (e.g., maintenance contracts) and
transactions (e.g., invoices) and can be performed to see if there are any items on
the master file for which a transaction has not been recorded.

Cut-off

Year-end ledger, inventory files, or transaction files can be tested for cut-off by testing for items
with dates or sequence numbers above or below the year-end cut-off.



18 | IDEA Version Ten Workbook

Determine Data
Requirements

Other Audit Objectives

IDEA can often provide useful information in complex areas such as provisions and valuations by
producing a number of “views” based on a series of different parameters.

Taking inventory as an example, you can:

e Identify which items have not moved in 3, 6, 9, and 12 month bands
e  Match items against post year-end sales to see what has not sold
e  Test net realizable value on items that have sold

e  Check items that were in inventory last year against what items have not sold this
year

Any audit, which has a need for analysis of data, computational work, or exception testing, will
benefit through using IDEA.

Many of the more interesting uses are fraud related such as cross-matching address files between
payroll and accounts payable ledgers, identifying duplicate supplier invoices, and matching bank
accounts on payroll with supplier master files.

Once it has been determined that IDEA will be used and the objectives have been defined, it is
necessary to identify the data required. This is often a two-way process in that the tests to be
carried out are limited to the data that is available. Data may be required from more than one file or
computer system.

To take inventories for example, the main master file would be requested. This might contain
quantities, costs, and details of each item. To test for slow moving items, it may be necessary to
request a history file with details of all movements. Similarly, in order to check if any costs are
higher than selling price, a separate file of sales prices from the sales system might be required.

There are two main sources of finding out what data is stored:

e [T staff that support the system (possibly third party)

e  Users, who input, review and own the data

It is also worthwhile to review the standard reports available as these can be imported as an
alternate source for the data.

Systems documentation describes, in theory, what should be held; but in practice, fields may be
used for a different purpose or not at all. For example, it is no use designing a test based on date of
birth only to find that the users do not bother entering dates of birth! Hence, a discussion on what
data is held is always recommended.
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Areas to Consider

In deciding what data is required it may be worthwhile examining:

Addresses: These can be used for performing “fuzzy matching”, such as
checking if any supplier addresses are the same as employee addresses. They may
be needed for confirmation purposes. However, addresses take up a considerable
amount of space. It may be possible only to include the first portion of an
address.

References: All fields with reference numbers should be picked up. These are
likely to be needed for any joins to other files and are good for gap and duplicate
tests.

Flags and codes: It is important to understand what the flags and codes mean.
Often additional items are needed based on the codes. They rarely take up much
space and should be included.

Dates: Dates are particularly useful. Care must be taken to understand how dates
are used by a system and what they actually represent.

Descriptions: Long descriptions can be truncated if space is short, but it is often
useful to have a short description on the final output.

The need for other fields depends on the audit tests. If in doubt, include a field but at the end of an
audit, as part of the review process, it is worthwhile noting what has been useful and what was
not. In subsequent audits only the necessary fields need to be imported.

| 19






Accounts Receivable Audit

Section 2

Introduction What are the risks associated with Accounts Receivable that could be addressed by computer

assisted audit procedures? And what tests can help address those risks? This section summarizes the
business and audit risks that arise in the context of Accounts Receivable and the potential tests that
can be used to address those risks.

Potential Risks

The following table identifies the key risks, explains the business and audit implication of each risk
and the audit objectives that could be addressed by audit tests.

RISK IMPLICATIONS AUDIT
OBIJECTIVES
The file is Items could be omitted, or the listed items may not be  Completeness
incorrectly included in the totals reported in the financial Accuracy
consolidated or statements. The Accounts
summed. .
Receivable could be overstated or understated
depending on the direction of the error.
Foreign currency Management may not be aware of the impact of Accuracy
transactions are transactions in foreign currency and may fail to take
not translated steps to manage currency risks. The Accounts
correctly Receivable could be overstated or understated
depending on the direction of error.
Credit is granted The business will sell goods to parties from which they  Valuation
to customers that  will not be able to collect cash. This has potential
are likely to implications on liquidity and bad debt expenses.
default.
Customers are Double billing can negatively affect customer Existence,
double satisfactions. Also, revenues and receivables would be  Validity,
overstated Valuation
Accounts Receivable  Accounts could be entirely or partly invalid. Partially Existence,
are invalid or invalid accounts may be the result of delays in processing  Validity,
incorrectly stated. transactions or errors in applying credits and payments Accuracy

to accounts.

Fictitious accounts could be due to fraud.




22 | IDEA Version Ten Workbook

RISK IMPLICATIONS AUDIT
OBIJECTIVES
Improper allocation  As mentioned earlier, improper allocation of payments to  Existence,
of credits and accounts could affect the aging of the Accounts Validity,
payments. Receivable and this would affect management’s ability to  Accuracy
determine an effective course of action for handling the
customer’s account. For example, sales to customers
could be blocked or the customer may be sent to a
collection agency, even though the customer is current
on their accounts. Improper allocation of payments to
accounts could also be an indicator of fraud.
Accounts Receivable If the aging of the Accounts Receivable is not correct, Valuation
is not properly then management may fail to take action on overdue
aged. accounts in a timely manner and permit sales to poor
credit risks. Also, the calculation of the allowance for
doubtful accounts and bad debts expense would be
affected.
A significant The business could be exposed to a combination of Presentation
percentage of the credit and liquidity risks if these large customers do not
receivables is pay their debts in a timely fashion. Also, the company
concentrated in a may be deemed to be economically dependent on the
few customers. identified customers, and this may need to be noted in
the financial statements.
Improper If a credit balance is classified as an Accounts Receivable  Presentation
classification of (AR) instead of an Accounts Payable (AP), then it could
amounts. distort the current ratio which could be part of a debt

covenant.
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Potential Tests

The following audit tests are suggested when auditing an Accounts Receivable system. However,
the exact tests carried out for a particular client will depend upon the system used and the data
available. Common tests include:

Mechanical Accuracy and Valuation

e Total the file. It often pays to separate out debits and credits.

Revalue foreign debts, if applicable.

Check transaction totals to the balance on each account.

Analysis

Profile debtors using a numeric stratification to see the number of large debts and
what proportion of value is in the larger items.

Produce an aged debt analysis. Consider how to deal with unallocated cash and
credit notes. IDEA, by default, ages these on their date rather than allocating
against the oldest item or any other treatment. It is often worthwhile splitting the
file into invoices, unallocated cash, etc. using multiple extractions, and then aging
the individual files.

Exception Tests — Existence and Valuation

e Identify old items (i.e., greater than three months old).

Identify large balances either in their own right or compared to turnover.

Select accounts for which no movements have been recorded in a set time.

Report credit balances.

Identify unmatched cash or credits.

e  Compare balances with credit limits and report exceptions (i.e., accounts with
balances in excess of their credit limits or accounts with no credit limits etc.).

Test for items with invoice dates or numbers outside the expected range.

Identify partial payments of debts.

Identify invalid transaction types.

Identify customer addresses that are “care of” or flagged not to be sent out.
Gaps and Duplicates

e Test for duplicate invoices (both invoice number and customer/value).

e Use duplicate exception testing for less obvious input errors, such as the same
vendor ID assigned to two different vendor names, the same vendor name
assigned to two different vendor IDs, payment of the same invoice number and
amount to two different vendors, etc.
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Case Scenario:
Accounts
Receivable

Matching and Comparison Tests

e  Compare the balance on an account with its turnover.

e Match the sales transactions to the Customer Master information to identify sales
to new or unauthorized customers and those with exceeded credit limits.

e  Compare to Accounts Payable for possible contra accounts.
Sampling

e Select samples (random or specific) for functional testing and confirmation (and
produce confirmation letters).

As part of the year-end audit of Bright IDEAs Inc., the audit manager of Dynamic Accountants has
decided to use IDEA on the Accounts Receivable audit in order to:

e Improve the quality of the audit
e Improve efficiency

e  Provide value added services

This section covers the types of tests that can be carried out using IDEA with some practical
examples of obtaining the data, importing, and performing tests.

When auditing Accounts Receivable, the main objective is to form an opinion on the validity of the
debt. Items of particular concern are old invoices, unmatched cash, and large balances, particularly
where customers are in difficulty. These can all be identified using exception tests.

One of the key tests is to perform a confirmation by choosing the required balances and sending
out letters. This requires customer master information such as addresses and credit details (usually
held in a master file) as well as the transactions.

Accounts Receivable data is often obtained by requesting statements as a print report file that can
be imported into IDEA. Care must be taken to ensure statements have been produced for all
accounts by totaling all items and checking that this agrees to the General Ledger control account.
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Obtaining the Data Having thought about the possible audit tests the audit manager decides the following data files will
be needed for the audit:

e  Accounts Receivable database containing data at March 31, 2015

e  Customer Master File
Note: One of the simplest format data files to import into IDEA is a Microsoft Access file. Another
simple way to import data is to obtain printouts that are “printed” (or spooled) to file rather than
the printer and then use the Report Reader tool for IDEA to read the required data into IDEA for
testing.

Further discussions with the IT staff have determined that the Accounts Receivable data can be
provided in Microsoft Access format.

A suitable printout of the data required from the Customer database exists; therefore this will be
requested in electronic format (i.e., a print report file).

Request for Data Files for Audit Purposes

Please supply the following data from the Accounts Receivable system in Access format and
supplied on USB or CD using compression utilities, if necessary.

Outstanding Transactions Between January 1, 2015 and March 31 2015.

FIELD FORMAT

Account Number c10

Invoice Number c10
Transaction type C1

Gross amount N 10,2

Goods & Services Tax — GST N 10,2

Provincial Sales Tax — PST N 10,2
Indicator if paid C1

Date paid D YYYYMMDD

Customer Reference c12

Note: In the record definitions, C refers to Character, N to Numeric and D to Date. € 10 means a
character field of length 10. N 10, 2 denotes a 10-digit number with 2 decimal places.
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Please supply the following Customer Master data as available on report AR-1 as an electronic

report file:

FIELD FORMAT

Account Number c10

Customer Name C30

Customer Address 1 C25

Customer Address 2 C25

Customer Address 3 C25

Zip Code c8

Credit Limit N 8,2

Data is required for the following period: Year-end March 31, 2015.
Please also supply the following control totals for reconciliation purposes:
. Outstanding balances at year-end March 31, 2015

. Number of transactions supplied

. Number of customers
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Audit Program From the available or possible tests, the audit manager decides on the appropriate tests and
prepares the following audit program for you to complete.

Audit Objective:

To ensure that Accounts Receivable shown in the Financial Statement are free from material
misstatement.

AUDITING PROCEDURES ASSERTIONS WORK EXTENT
DONE BY | OF
(INITIALS) | TESTING

1 Obtain the data files from the client and
load onto the PC.

Load IDEA and create a Managed Project
for Accounts Receivable for Bright IDEAS
Inc.

2 Verify Accounts Receivable totals agree:

a) Import the Accounts Receivable details,
b) Check the total, cVv
¢) Compute field statistics, and

d) Reconcile control totals to the trial
balance.

3 Select a sample for detailed testing and EO
confirmation.

4. Prepare an age accounts analysis to review | V
the profile of debtors

5. Identify old and large accounts for EV
detailed testing.

6 Identify all credit notes \

7 Prove calculation: \
a)Calculations of net value and b) Totals
by account

8 Identify accounts exceeding their credit \
limit:

a) Import the Customer Master File and

b) Extract balances over their approved
limit.

Key to Assertions: Completeness, Existence, Ownership, Valuation, Presentation
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Audit Setup Objective:
To be able to load data, run IDEA and create a new Managed Project.
Exercise Description:
This exercise covers copying data into a folder, loading IDEA and creating a new Managed Project.

IDEA Functionality Covered:

e Create a new Managed Project

e Specify the Project Properties
The following data files have been provided with this Workbook:

e ACC_REC2015.ACCDB - Accounts Receivable at March 31, 2015
e  CUSTOMER.TXT - Customers Report in Text Format
Accessing IDEA
From the Windows Start screen, click the arrow in the bottom-left corner.
Alternatively, In the Apps view, scroll to the IDEA group and click IDEA.
Create a New Project
To facilitate housekeeping, it is recommended that a separate Project be used for each audit or
investigation. All information relating to the audit, including data files, equations, views or report

definitions, import definitions, etc. may be stored in the Project.

This exercise will explain how to create a Project and enter client information that will be printed on
all reports. Note that once a Project is set, it remains the active folder until changed.

If you have used previous versions of IDEA you will have been used to using Working Folders, this
has changed in V9 of IDEA. IDEA now uses Projects and a Library to store the files created by
IDEA. The Projects concept within IDEA allows for better segregation of files. There are two
alternatives when creating a new Project: Managed Project and External Project.
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Managed Projects are stored in the following location on your computer:
C:\Users\[UserID]\Documents\My IDEA Documents\IDEA Projects
External Projects can be stored at other locations on your computer.

After creating a Project you will see that IDEA was created the following project structure:

, Custom Functions.|LE
, Equations.ILE

| Exports.ILB

J Import Definitions.|LE
| Macros.|LB

| Other. LB

J Results.ILE

J Smartfnalyzer|LBX

J Source Files.|ILB

J Visualization.ILE

1. From the IDEA Ribbon, make sure the Home tab has been selected and then click Create.

Home Data Analysis View Macros SmartAnalyzer Custom Macros

Export ~
sas | -® - A 3 Save As o
Project | Create |Select pichjye Properties  Desktop Select  Passport
Overvi . Send Using E-mail Server
Projects Import Export IDEA Server CaseWare

2. Select the Managed project option and enter Accounts Receivable Audit as the Project
Name.

Create Project

(®) Managed project 0K

Project name: Accounts Receivable Audit
Cancel

() External project

Folder name:

Once you click on OK, IDEA will create a new folder called:
C:\Users\[UserID]\Documents\My IDEA Documents\IDEA Projects\Accounts Receivable
Audit
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3. From the Home tab, in the Projects group, click Properties to change the Project

Properties.
Home Data Analysis View Macros SmartAnalyzer Custom Macros
Export -
@ L Lo O ) - Savens 9
Project Create Select a4 Properties | Desktop Select  Passport
Overview . Send Using E-rnail Server
Projects Impaort Export IDEA Server CaseWare
4. Inthe Project Properties dialog enter the following information:
Report name: Accounts Receivable Audit
Report period: Jan 1, 2015 - Mar 31, 2015
Project Properties
Project name:  Accounts Receivable Sudit (Managed) 0K
Report name: | Accounts Receivable Audit
Report period: |Jan 1, 2015 - Mar 31, 2015 Cancel
Locked by: Help

Click on OK to accept the changes.

Load Data

1. Copy the following data files that came with the Workbook:

e ACC_REC2015.ACCDB - Accounts Receivable at March 31, 2015
e  CUSTOMER.TXT - Customers Report in Text Format

to

C:\Users\[UserID]\My IDEA Documents\IDEA Projects\Accounts Receivable Audit\Source
Files.ILB

This is the default location within a Project to store any source files.
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Objective:

To import the data file for testing.

Exercise Description:

The Accounts Receivable Transactions file, Acc_rec2015.accdb, is a Microsoft Access file that IDEA
will import directly. This is carried out using the Import Assistant that determines the file type.
Once imported, the file is examined and totalled.

IDEA Functionality Covered

e Import a Microsoft Access database

e  Use the Database window

Determine the number of records in the database

1. From the Home tab, in the Import group, click Desktop.

Home Data Analysis View Macros SmartAnalyzer

LT ® (! o ]
Project Create Select p. pi e Properties | Desktop Select  Passport

Overview - Server
Projects Import Export IDEA Server CaseWare

The Import Assistant dialog box appears.
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Import Assistant “

Select the format:

- Advanced Record Definition Editor
- AS400

- dBASE

- Microsoft Access

- Microsoft Excel

- QODBC

- Print Repart and Adobe PDF
- SAP SmartExporter

- SAP/AIS

- Text

Computer location: My Computer

File name: | ments\IDEA Projects\Accounts Receivable Audit\Source Files.ILEY E“

Optional definition file: | E"
Edit template

< Back Next> | | Cancel | | Hep

2.  Select Microsoft Access from the list of available formats.
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Select the file to import by clicking the Browse button then navigate to and select the
following file:

C:\Users\[UserID]\Documents\My IDEA Documents\IDEA Projects\Accounts Receivable
Audit\Source Files.ILB\Acc_rec2015.accdb

o) Select File
T .« Accounts Receivable... » SourceFiles.|LB v & Search Source Files.|LB pel

Organize - Mew folder =~ [ @
o) Mame Date modified Type Si
#& OneDrive - — :
Bl Acc_rec2015.accdb 2/5/2016 9:51 AM Microsoft Access ...
. Documents

J Pictures

/M This PC

m Desktop
| Documents
4. Downloads
o Music
=| Pictures
& Videos

iy Local Disk (C)

—w Data (E})

& b4 S &

File name: | Acc_rec2015.accdb v | |Microsoft Access files (*.mdhb; * v

Cance'

Click Open.

Click Next.

The Microsoft Access dialog box appears. IDEA automatically checks the box of the first
table to be imported.

Select the Scan records for field length option.

For this exercise we will select the Scan all record option, but note you can also select the
Scan only number option that allows you to specify the number of records to be scanned.

Do not select the Create a record number field option for this exercise.
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8.  In the Output file name field, enter Accounts Receivable.

Microsoft Access®

g

Select tables: Acc_rec2015 oK
Indude all
Clear All

Cancel

Help

Character Field Options
Scan records for field length
()Sscan al

(®) Scan only

[]create a record number field

QOutput file name: | Accounts Receivable

9. Click OK.

The Accounts Receivable - Acc_rec2015 database will be imported, opened, and selected
as the active database. When the database is created, the table name is added as a suffix to
the output file name.

File Explorer #

Bl N @ O
[pesktop Project

o~

Marne Records
------ 7 Accounts Receivable-Acc_rec2015 300




10.
11.

12.
13.

14.
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Note: About the Microsoft Access dialog box:

e Tables - IDEA can import multiple tables from the Microsoft Access file. To import
multiple tables select the tables to be imported by clicking the associated check
boxes. To select or deselect all tables, click Include All or Clear All, respectively.
When selecting multiple tables, the options selected are applied to all selected
tables. Each table is imported as a separate database. In the creation of the tables
in Microsoft Access, if the field type is Date/Time, IDEA will create a separate field
for the Time. To avoid this, change the field type in Access Table Design to Text.
Once in IDEA, the field type can be changed back to a Date field. Also note, that
the Time field can be deleted through Field Manipulation.

e  Output File Name - The total length of the full path name which includes the
output file name, cannot be greater than 256 characters. The output file name
cannot include any of the following characters: /\<>*"2[ ]| :

We want to change the database name to Accounts Receivable. To do this we must first
close the database.

From the File tab, click Close Database.

From the File Explorer window, right-click on the database name and click Rename.

The database name is highlighted.
Delete “- Acc_rec2015” from the database name.

Press Enter.

The new database name is displayed in the File Explorer window.

File Explorer ?
3 o

Desktop Project

Mame : Records
...... 7 Accounts Receivable 300

In the File Explorer window, double-click Accounts Receivable.

The database is now open and selected as the active database in the Database window.
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Selecting a Control Opjective:

Total Field _
To prove the data has been imported correctly.

Exercise Description:

By examining the Accounts Receivable database, you will become familiar with the data and what
is on the IDEA screen, as well as learn to specify a Control Total field and determine the number of
records in the database.

IDEA Functionality Covered:

Select a Control Total field.

1. The Accounts Receivable database appears in the Database window. Maximize the
Database window

ol [ o S cl s o8 CaseWare IDEA - Accounts ReceivableIMD - B

Home Data Analysis View Macros SmartAnalyzer = i}
i RRE R B G e
LIT] D Y = o ]

@ Save As
Project Creste Select ppcpjye Properies Desktop Select  Passport
Overview N I-% Send Using E-mail Server
Projects Import Export IDEA Server CaseWare
F”e Explorer " ACCOUNT_NO | INVOICE_NO | TYPE | GROSS_AMT GST PST F A Propert‘es i
GRoMNB | 1 |cozo 46000 | 234554 15345: 173.74 | v Database
@ o =~ 2 | RoO8 46001 I 69272 4532 5131 P
Desktop Project . [ 3 |woos 46002 | 337.61 2209 250 P v Data
Name 4 | D014 46003 | 230654 : 15090: 17085 P W@ History
3 Accounts Receivable "5 |Ho14 46004 | 230654 15090 170.85 P i Field Statistics
6 | Mo14 46005 | 1124151 73541 8327 P i Control Total
| 7 | co20 46006 | 3,039.84: 198.87; 22517 i Criteria
8 |ROOS 46007 | 1971.26: 12896 14602 P
9 | Goao 46008 | 234554 15345 17374 P i » Results
10 | M020 46009 | 3617.01: 23663: 26793 P
11| w23 46010 I Te91 523 5% v Indices
12 | TO04 46010 | 39.94 261 296
13| F123 46012 | 50.00 3.27 370 P + Mo index
[ 14 | To03 46013 | 3,543.54: 231.82: 26248 =
15 | NOD1 46014 | 376658 24641 273010 : ¥ Comments
i NDO2 46015 | 2499 1.63 185 P i Add comment
17 | F123 46016 | 2,10000: 137.38: 13536
(18 | A123 46017 | 50.00 3.27 3.70
19| A123 46018 | 210000 137.38: 15536
20 | M123 46019 | 197565 129.25: 14634
21 Go1o 46020 | 2,34554 ¢ 15345 17374
< > |22 1010 46021 | 3,689.05: 241.34: 27326 P
ey | G > |

Running Tasks Search Results

Managed Project: Accounts Receivable Audit Mot connected to IDEA Server Number of Reco Disk Space:
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2. Scroll through the data using the scroll buttons and bar on the right side of the window until
you get to the bottom of the file. Also scroll left and right using the horizontal bar at the
bottom of the Database window.

Note: The file contains invoices, credit notes, and cash that are still in the Accounts
Receivable database at the year-end. Also note the number of records on the Status Bar at
the bottom right of the screen (i.e., 300). The available disk space on the Project drive will
also be displayed on the Status Bar.

3. Scroll back to the top of the file.

When displaying a database, the field (column) widths are optimized to the width of the
data or the field names, whichever is wider. Field widths may be adjusted by moving the
field name separators or optimized by double-clicking the field name separators.

4.  From the Properties window, click Control Total.

Properties ?

i = Database

~" Data
mn History
gn Field Statistics

in Captrol Total

T Cﬁia

Control Total

Show the net total of one spedfic field for recondliation purposes.

i w Resy

5. In the Select Control Total dialog box, click the GROSS_AMT field and click OK.

Select Control Total
GST
ST Cancel
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6. If prompted to calculate the Control Total, click Yes.

The control total of 435,864.85 appears in the Properties window.

Properties #

i » Database

« [ata
History
Field Statistics

Control Total: 435,864,825
(GROS5_AMT)

Criteria

You are now ready to verify that the data has been imported correctly and to commence
audit testing.

Field Statistics Objective:

To verify that the correct data has been supplied and that it has been imported correctly before
commencing testing.

Exercise Description:
View the Field Statistics for the Numeric and Date fields in the Accounts Receivable database.
The statistics will be used for:

e Agreeing totals
e Gaining a general understanding of the ranges of values in the database
e Testing for date cut-off, (i.e., the date range)

e Highlighting potential errors/areas of weakness to focus subsequent
investigations

IDEA Functionality Covered:

e  Field Statistics

e  Printing Field Statistics



1.
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From the Properties window, click Field Statistics.

Properties

ii w Database

Data
History

omoE

i v Re

Freld Statistics
é_ﬂitrol Total: 435,864,835 (GROSS AMT)

U Field Statistics
Display statistics for numeric, date and time fields.

a

If prompted, click Yes to create statistics.

Field Statistics are displayed for the GROSS_AMT, GST, and PST fields.

Study the Field Statistics Results for the GROSS_AMT, GST, and PST fields. Note in
particular the Net Value, Average Value, Minimum Value, and Maximum Value

statistics.

Note: The values displayed in blue are drill down values. Selecting these values allows you to
see the items included in that statistics category.

Accounts ReceivablelMD X
ol O Svih | D@ @B

Field Type Mumeric Statistics GROSS_AMT | GST PST

[T | » Nt Value w 29,511.00 33.408.54

%ﬁ: Absolute Value 509.929.85 3216332 36.412.04

Numeric Fields # of Records 300 300 300

GROSS_AMT #of Zero tems 0 12 12

Postive Value 472,897.35 30.837.16 34,910.49
MNegative Value -37.032.50 -1,326.16 -1,501.55
#of Posttive Records 255 254 254
H of Negative Records 45 3 M
# of Data Emors 0 0 0
# of Valid Values 300 300 300
Average Value 1.452.88 58.37 111.36
Minimum Value -3.145.73 -205.80 -233.02
Maximum Value 18,34553 1,200.44 1,38527
Record # of Min 236 236 236
Record & of Max 262 262 262
Sample Std Dev 2.996.06 193.09 21864
Sample Varance 8,976,402 .64 3728240 47.801.50
Pon St Diey 2991 07 192 76 218 77
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4. Inthe Field Type box, click Date and study the statistics. Note in particular the Earliest
Date and Latest Date statistics, which are useful for determining the period of the
database. Note that the totals per client have been provided with the software for
reconciliation purposes:

FIELD CONTROL TOTAL PER | CONTROL TOTAL IN
CLIENT DATABASE
GROSS_AMT 369,255.13 435,864.85
GST 25,193.36 29,511.00
PST 28,525.83 33,408.94
FIELD EARLIEST DATE LATEST DATE
DATE 2014/11/04 2015/04/01

Verify your results from Field Statistics to the above. Can you suggest why the database
statistics do not agree with the control totals? The answer is provided in the next exercise.

5. If your computer is attached to a printer, print the Field Statistics.
a. Select the four fields: GROSS_AMT, GST, PST and DATE.
b. From the Field Statistics toolbar, click the Print button.
c. From the Print dialog box, click OK.
The Field Statistics report for each selected field will be printed two per page.
6. Click Data in the Properties window to return to the database.
Note: Although the Field Statistics may be viewed at any time, once generated, it is
recommended that a printout be kept in the audit file along with any reconciliation reports

provided.

Also note that your data or the History of your database can be published to a PDF or a
Microsoft Word document.

7.  To Publish to a PDF or Microsoft Word document:
a. Ensure the correct database is active.
b. From the File tab, click Export and then Publish to PDF (or Microsoft Word).
Windows Save As dialog box appears.
c. Enter the file name.
d. Navigate to the location you want to save the file in.

e. Click Save.
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Reconcile the Objective:

Database To reconcile the Accounts Receivable database to the totals provided.

Exercise Description:

This exercise will identify some of the reasons why databases do not reconcile to totals provided. It
will also explain the following:

e How to perform an extraction
e Rules for entering equations
e How to view and read the history log

e How to annotate the history log
IDEA Functionality Covered:

e  Extractions

e Equation Editor

e Database window
e  History Logs (View)
e Insert Comments

e Delete Comments

In the previous exercise, we ascertained that the database did not reconcile to the totals provided.
This may be due to:

e  Errors on importing the database (although this is not generally a problem with
Access files)

e  Cut-off problems, (i.e., transactions before or after the stated period of the
database - after March 31, 2015)

e Or anumber of other reasons
In fact, there are two problems with this database:

e An after-date transaction as shown in the Field Statistics.

e A number of invoices have been paid (i.e., the PAID_FLAG field contains P). This
is a common feature. Paid invoices remain on the system for a period, although
marked as paid, so that they can be included on customer statements for
information.

It will be necessary to exclude all paid invoices and after-date transactions to reconcile the data to
the totals provided. However, the original data file cannot be edited within IDEA, since the integrity
of the data is always assured. Therefore, the required data will be extracted into a new database
using the Direct Extraction task and entering the following equation:

PAID_FLAG <> “P” .AND. DATE_DATE < “20150401"

This formula identifies those items which are unpaid and before April 1, 2015.
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Note the following when entering equations:
e When entering text, the text must be enclosed in quotes (“").

e |DEA is case sensitive.

e Dates must be entered in the format YYYYMMDD (without any separating
characters such as “/”) and enclosed in quotes ().

e The symbol <> is used for not equal to.

To perform the extraction:

1. From the Analysis tab, in the Extract group, click Direct.

Home Data Analysis View Macros Smartfnaly

@ =% Direct | =2 Top Records = Gap Detection Ca Duplicate Key =

Re-run = Indexed = Key Value ] Benford's Law [ Statistics =

Tasks Extract Explore

2. Change the default File Name provided from EXTRACTIONT to Acc Rec March 31 2015.

Direct Extraction H
Records to extract: (@) Starting record #: 1
()Range Ending record #: 300 Create Fields
Create a virtual database -
Fields
Database order: |No index v Delete
File Name Criteria Cancel
=

1 | Acc Rec March 31 2015 EH Help

2




Section 2: Accounts Receivable Audit |43

3. To enter the equation, click the Equation Editor button. The Equation Editor will appear
and is used to enter the required equation.

4. Enter the required equation as follows:
a. Double<lick the field name PAID_FLAG to insert it into the Equation box.
b. Click the <> (not equal to) button.
c. Click the " button and note that the cursor is inserted between the quotes.
d. Type the letter P (upper case).
e. Move the cursor outside to the right of the quotes.
f.  Click the AND button (it inserts .AND.).
g. Double<lick the field name DATE_DATE to insert it into the Equation box.
h. Click the < (less than) button.
i.  Click the Calendar button and select the date of April 1, 2015 from the

calendar. Notice that the date is automatically encapsulated in “” and input in

the proper format.

5. Once the equation has been entered, check the syntax by clicking the Validate button.

Equation Editor [ = |
MEO =2 KAHX 2 # 2 K @2
Equati
1= - Al
"t,() === <=z <> +-*/ AND OR NOT MOD BXP [P - Character @Functions o)
- Numeric
PAID_FLAG <> "P" AND. DATE_DATE < "20150401" - Date / Time @F:nrti_nns are ava\\ah‘le for
. " performing more complex
:“!at?;ng | operations such as date
onditional arithmetic, statistical
il Financial

calculations and text

~ Custom Functions searches, IDEA functions
begin with the '@ symbol.
They are very similar in
style and operation to
functions found in other
software packages such as

? Microsoft Excel and dBASE.
Each @Function calculates a
Test Equation result based upon the
Record Number: 1| 5 |Evaluate parameters passed to the
@Function. Parameters are
passed in parentheses. For
Field Type Len Dec ~ example, @Round
{Amount) will round a
ACCOUNT_NO Character 4 1} field called “Amount” to the
INVOICE_NOD Character 5 a nearest whole number,
TYPE Character 1 a Additional help on
GROSS_AMT Murneric a 2 @Functions is available by
= selecting the required
G5T Humneric 8 2, @Function in the st tothe
< . " 5 Insert Function left. The syntax,
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6. If a syntax error occurs in your equation, correct the expression and recheck the syntax. The
equation should be as shown in the above screen. Click the Validate and Exit button.

Direct Extraction

Records to extract: (@) All Starting record #:
) Range Ending record %: 300 Create Fields
Create a virtual database Ficlds
Database order: | Mo index v Delete
File Name Criteria Canicel
1 | Acc Rec March 31 2015 PAID_FLAG <= "P" .AND. DATE_D,I Help

2

7. Click OK to run the extraction. The resultant database Acc Rec March 31 2015 will be

displayed.

Note that the Control Total for the GROSS_AMT field, 369,255.13, as displayed in the

Properties window now reconciles to the total provided.

8.  View the Field Statistics for this database by clicking Field Statistics in the Properties
window. If you get the message, “Statistics are not available for all fields. Do you wish to
create statistics for all fields without statistics?” - click Yes. Notice the Net Value totals for

the GST and PST fields also reconcile to the totals provided.

9.  View the statistics for the DATE field and note the Earliest Date is 2014/11/04 and the

Latest Date is 2015/03/31.

10.  Print and file the Field Statistics reports for each field as explained in the previous exercise.

11.  Click Data in the Properties window to return to the database.
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12.  The Acc Rec March 31 2015 database is now displayed as a “child” of the parent database,
Accounts Receivable, in the File Explorer.

File Explorer !
T =
Ll C N @
Desktop Project
Mame Records
=-A§ Accounts Receivable 300
L@ Acc Rec March 31 ... 253
History Log

IDEA maintains a hierarchial History log of how each database has been created. These logs cannot
be modified and should be printed out at the end of the audit, reviewed and filed along with all
other audit documentation. Alternatively, if you use electronic working papers the History log may
be exported to a text file.

To view the History log:

1. From the Properties window, click History. Note that the details of the file import, selection
of the Control Total field and the extraction have been recorded. Notice that the History is
displayed as a series of collapsed nodes.

. a Accounts Receivable IMD X m
File Explorer T opotte B T T Fiter
Ea B Ej F E Database Date
Desktop Project ] Accounts Receivable-Acc_rec2015.I1MD
Name : Records +] Accounts ReceivableIMD
=& Accounts Receivable 200 =] &cc Rec March 31 2015.I1MD
{57 AccRec March 31 ... 253 (] Control Total Field Changed  1/8/2016 3:56:07 PM
+] Record Extraction 1/8/2016 3:56:07 PM
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2.

Expand each node by clicking on its + button. Alternatively, expand all the nodes by clicking
the Expand All Details button on the History toolbar. The IDEAScript code that can be
used for re-running the audit at a later date is included in the History log.

ft et L PR Nl Ao Rec March 31 2015.IMD X

ﬁ Exporttoc E Z E= Z= Filter
Databaze Date User ~
Accounts Receivable-Acc_rec2015.IMD
Accounts Receivable. |MD
=] Acc Rec March 31 2015.MD
Control Total Field Changed  2/5/2016 2:12:15 PM IT Ottawa

B Record Extraction 2/5/2016 2 IT Ottawa

File name: Ch\Users\IT Ottawa\Docurnents\ My IDEA Documentsh|DEA
Projects\Accounts Receivable Audit\Acc Rec March 31 2015.1MD

Mumber of records: 253

Control field: GROSS_AMT

Control total: 369,255.13

Extraction from: Ch\Users\|T Ottawa\Documents\My IDEA Documentsh\|DEA

ProjectshAccounts Receivable Audit\Accounts ReceivableMD

Mumber of records: 300

Indexed by: Mo index

Extraction Range: 1-300

Extraction Criteria: PAID_FLAG <= "P" AND. DATE_DATE < "20150401"
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Add a Comment

IDEA allows you to add comments to an active database. Comments are used to explain the
findings of a database and can also be used to display warning messages.

1. Annotate the database by clicking the Add comment link in the Comments area of the
Properties window.

i w Comments

in Add comment

Add comment

Add a new comment to the database.

2.  Enter the following comment:

Database Reconciliation — Database reconciles to totals provided by client.

Database Comments n

= @ @
adn= HH o
Comment Link Priority  Date User

Click here to add a new comment

Database Reconciliation - Database reconciles to Medium  2/3/2016 2:21:08 IT Ottawa
totals provided by client. PM
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5.
6.

Click the Link column, then the ellipse button to select Acc Rec March 31 2015.

Database Comments

2 @ Ty
./
Comment Link Pricrity Date User
Database Reconciliation - Database reconciles to totals Ch\Users\|T Ottawa'\Deo... | :dium 2/5/2016 2:21:08 PM IT Ottawa
provided by client.
Select Database ﬂ
Deskt: j
esktop ijefl oK
MName Records Size Modified Cr...
- ; ; Cancel
= Receiv... 300 91 /572018 2. /..
5§ Acc Rec Marc... 253 49 2/5/2016 2. 2. i

|| bxtraction tro
Click OK.
Close the Database Comments dialog box.

Return to the database by clicking the Data link in the Properties window.

To delete a comment:

Right-click the required comment link in the Comments area of the Properties window and then
click Delete Comment.
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Random Record Objective:
Sampling _ . _ _ . .
To choose a sample of items for confirmation and determine any other testing to prove validity.
Exercise Description:

This exercise uses random sampling that is the standard sampling technique used by Dynamic
Accountants.

IDEA Functionality Covered:

e  Extract a random sample of items
e Close an active database

Ensure Acc Rec March 31 2015 is the active database with the Database View selected.

1. From the Analysis tab, in the Sample group, click Random.

Analysis View Macros SmartAnalyzer
- s pmn g . - .
Records = Gap Detection Cg Duplicate Key~  ~ © Summarization =] Aging 5 Join Ea Visual Connector ol Attribute Monetary Unit
=1 Stratification .7 Pivot Table #] Variables ~
Value = Benford's Law [z Statistics - I Chart Append Compare = Other~

Explare Categorize Relate Sample

The Random Record Sampling dialog box appears.

Random Record Sampling
Mumber of records to select: | 1] | | oK |
Random number seed: | 13529 Ficlds
Starting record number to select: | 1 = Cancel
Ending record number to select: | 253 = Help

allow duplicate records: [
Create a virtual database:

File name: | Rand Samp

2. Enter 20 as the Number of records to select.

3. Accept the random number seed provided by IDEA. This is used to start the algorithm for
calculating the random numbers. If a sample needs to be extended then entering the same
random number seed but entering a larger number of records to select will produce the
same original records with the required additional records.

4.  Accept the default range from which the sample will be selected. By default, the range is the
first and last records (i.e., 1-253).

5.  Leave the Allow Duplicate Records option unselected in order to prevent IDEA from
selecting the same record more than once.
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In the File name box, enter Sample of Acc Rec Transactions.

Click OK to run the sample extraction.

View the resultant database and note the additional field, SAM_RECNO, added to the
database as the right-most column. This additional field contains the corresponding record

numbers from the original database.

Data Analysis View Macros SmartAnalyzer
@ =2 Direct =2 TopRecords = Gap Detection Cg Duplicate Key - = Summarization Aging B3 Join
S Stratification (7 Pivot Table
Re-run = Indexed = Key Value [ Benford's Law [2) Statistics - Ll Chart o Append
Tasks Extract Explore Categorize
. Acc Rec March 31 2015IMD X
F | | € Exp | orer * DATE_DATE DATE_TIME CUST_REF COMMENT SAM_RECHO
N - 1 |3/28/2015 00:00:00: N 1515 217
[a B ~ F m D [ 2 | 2/25/2015 00:00:00 :) 1347 86
[PESEE MG | 3| 2/12/2015 00:00:00 : R 3885 52
MName Records || 4 | 2/27/2015 00:00:00 : R 3791 a8
=-E# Accounts Receivable 300 || 5 |3/7/2015 00:00:00 ;U 7856 132
& Acc Rec March 31 ... 253 || 6 |2/18/2015 00:00:00 U 4316 72
..i7§ Sample of Acc .. 0 || 7 |2n82015 00:00:00  F 3582 67
& | 3/5/2015 00:00:00 : L 1592 108
| 9 |3/21/2015 00:00:00: T 3403 163
10 | 2/16/2015 00:00:00 Q 9494 60
1] 3/5/2015 00:00:00: O 9423 125
12| 3/27/2015 00:00:00: E 3930 211
13| 3/30/2015 00:00:00 : S 7835 23
14| 3/21/2015 00:00:00 : B 2960 167
15 | 2/18/2015 00:00:00 : H 1539 1
16| 3/5/2015 00:00:00 ;| 8272 116
17 | 1/28/2015 00:00:00: C 9610 13
18 | 2/25/2015 00:00:00: G T16 84
EEl 1/31/2015 00:00:00: A 4754 18
20 | 3/31/2015 00:00:00: C 1807 ON ACCOUNT 247
>
< >
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9.  From the File tab, click Close Database to close the Sample of Acc Rec Transactions
database.

Data Analysis Wiew Macros SmartAnalyzer

Passport
P Database
Database
Open Database
- Open an IDEA database in the Database window.
0
Print P
E}-::pljl't
Close Database
Help % Close the active database.
Options Close

Exit

Close All Databases

% Close all open databases.

Close all

Note: A sample of transactions was extracted in the above exercise. However, you may wish to
extract a sample based on account numbers and then extract the transactions relating to the
selected account numbers.

This would be performed by the following procedure:
1. Summarize the outstanding balances by account number.
2.  Extract the required sample of account numbers.
3. Optionally, join the sample of account numbers to the transactions database using the
account number fields in each database as the match keys and selecting the Matches only

option in the Join Databases task to provide the detail behind each transaction.

This procedure is not used in this exercise, as it requires a number of the more complex functions
within IDEA that will be covered in later exercises.



52 | IDEA Version Ten Workbook

Age Analysis Objective:

To produce an age analysis of outstanding invoices at year-end in order to identify the number and
value of old debts and to make the necessary provisions in the final accounts for potential write-offs.

Exercise Description:

This exercise will teach you how to perform an age analysis, view the Aging Results, understand
the Aging Results toolbar options, export the results to a report, and print the report.

IDEA Functionality Covered:
e Aging
e Aging Results View
1. Ensure Acc Rec March 31 2015 is the active database.

2.  From the Analysis tab, in the Categorize group, click Aging.

Home Data Analysis View Macros SmartAnalyzer

.!v‘} 2 Direct =2 Top Records = Gap Detection Cg Duplicate Key~  ° £ Summarization| &
=1 Stratification . Pivot Table

Re-run = indexed = Key Value =] Benford's Law 2| Statistics - | Chart

Tasks Extract Explore Categorize

3. Using the calendar control, accessed by clicking on the Calendar button, change the date in
the Aging date box (which currently displays the computer’s system date) to 2015/04/01.

Note: The aging date must be entered as one day after the year-end or period-end dates
from which you wish to age the data.

4 April 2015 ]
MoTuWeTh Fr Sa Su

1 2 3 45
B 7 & 9 101112
13 14 15 16 17 18 19
20 21 22 23 24 25 26
27 28 29 30

4. Do not specify criteria for the test. A criterion would limit the test to only those records
satisfying the specified criterion.

5. Inthe Aging field to use box, accept the DATE_DATE field.

6. Inthe Amount field to total box, accept GROSS_AMT as the amount field to total for
each interval.

7. Inthe Aging interval in box, accept Days.



10.
11.

12.
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Change the Aging interval days to: 31, 59, 91, and 121. Only 4 intervals are required,
therefore enter 0 for the 5th interval. The 6th interval will also be excluded from the analysis.

Do not select the Generate detailed aging database option.
Do not select the Generate Key summary database option.

Enter Age Analysis Report as the name for the Results output.

Aging
Aging date: | 2015/04/01 555:'

Criteria: Cancel
Aging field to use: | DATE_DATE v Help
Amount field to total: | GROSS_AMT v
Aging interval in: | Days W
L 31 = 391 = 50 =
2 |53 = 4 121 = 6 180 =

[ ] Generate detailed aging database:
File name: Aging Fields

Create a virtual database

[ ] Generate key summary database:

File name: = Age Summary Key

Create result:

MName: | Age Analysis Repnrﬂ

Click OK to generate the Results output named Age Analysis Report.
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13.

The Aging Analysis Report is displayed in a new Results output view of the Database
window. Note the new link in the Results area of the Properties window.

- . -
ONGEN2) 2 Zis o & CaseWare IDEA - Acc Rec March 31 2015.IMD
Home  Dats | Analysis | View  Macros  SmartAnalyzer
@ 2 Direct =2 TopRecords 5 Gap Detection g DuplicateKey~ =~ Summerization [ Aging Zloin % Visusl Connector 1 Attribute S MonetayUnit~ e [
. S Stratification (7 Pivot Table =1 Random 1 Variables = 0 Vi
erun 2, = : : . iscover Visualize
Indexed = Key Value Benford's Law (2] Statistics | Chart Append = Compare = Other~
Tasks Extract Explore Categorize Relate Sample Visualization
Acc Rec March 21 2015.MD X ~ .
File Explorer s Properties ®
T
—~ .  ~ Datab
sle N @ rt(D.. #Records (¥)Re.. Debits %) De... Credits %) Cre.. Net Value ) Ne apaze
[Desktop Project 0 o om ] ) o] om o] om Data
T B e 3 2| s 25371526 6282 3134083 640 27.77443) 6168 istory
(5.7 Accounts Receivable 300 59 &7 2648 51.31355 2248 5.027.23 13.60 35.351 37 2 31
159 Acc Rec March 31.. 253 91 21 830 49,72404 1224 0.00 0.00 49,724.04 13.47
- 121 2 073 311875 077 0.00 0.00 311875 084
Sample of Acc ... 0
121+ 1 oa 23455 058 wo|  om 23455 064 Crtern
ERR 0| o ] | om | om
i v Results
Totals 253| 10000 40622325 10000 3636812 10000 36325513 10000

' Age Analysis Report
i ¥ Indices.

v Noindex
i w Comments

Add comment

Database Reconciliation -
Database reconciles to

. 5 totels provided by client.

[T Loy |

Running Tasks Search Results

Managed Project: Accounts Receivable Audit Not connected to IDEA Server

Disk Space: 820.08 GB

The Aging Analysis Report produces the following summary information for each age
interval:

e  # Records: The number of records in a specified interval

e % Records: The percentage of the total number of records

e Debits: The debit value for the records in the specified interval
e % Debits: The percentage of the total debit value

e Credits: The credit value for the records in the specified interval
e % Credits: The percentage of the total credit value

e Net Value: The net value of the records in the specified interval

e % Net Value: The percentage of the total net value

Note: Any credit notes and/ or unallocated cash have been aged on their own date and not
offset against oldest items.

A summary record is created in the Aging Analysis Report for each interval specified.
Additionally, it produces a summary for:

e Interval @: Items dated on or after the aging date, in this case 2015/04/01
e Interval 121+: Items older than the final period specified
e ERR: Items with invalid or missing dates

e Totals: Totals for all intervals
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Note that there are 3 old debts (i.e., older than 90 days). These will be identified in the
following exercise.

14.  Click on the View the result graph button on the Aging Results toolbar. View the graph.

Acc Rec March 31 2015.IMD X

Lt Bx -

Y Auis: | # Records v

RS W-F- oo s RAEBEHK P

160

140

120

100

g0

# Records

20

o M 50 o 121 121+ ERR
Int (Days)
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15.  Rightclick the chart and click Properties. From the General tab, select the 3D option to
change the graph from 2-dimensional to 3-dimensional. Click OK.

Properties - =

Gereral | Series | Y fodz

Colors 3D
Falette: EEEEDE W [+] 3D
Rotated wiew
Background: W [
[] Cluster (7 axis)
Chart oo W
W
Effects

Stacked: mk Side by Side w

%
Paxes: [ Flat Frame w
Anti-Aliasing
X 3 = Y. (30 k=
Ok Cancel Apply

16. Right<lick the chart and then click Edit title. An edit box will appear at the top of the chart.
Enter the title: Aging at April 1, 2015.

17.  Use the Y Axis list box at the top of the graph to change the y-axis to Net Value.
18.  If your computer is attached to a printer, click Print on the Operations toolbar.

19.  Click the View the result grid button to return to the Aging Results output in the
Database window.

20.  Return to viewing the database by clicking on the Data link in the Properties window.

Note: Only a Results output was generated in this exercise, the additional optional databases
were not selected. Please read the IDEA Help system for further information on the optional
databases. If the amount of free disk space is a concern (particularly with large databases),
careful consideration should be given as to whether optional databases are required.
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Understanding the Database Window

The Database window is IDEA's main window. Each database is opened into a separate tab in the
Database window.

The Database window has a number of properties which can be accessed through links in the
Properties window, including:

e Database
e History
e  Field Statistics

e  Results

To change properties, click the relevant link in the Properties window. Scroll buttons are available
for navigating through the property views.

Data

When a database is opened, the data is displayed in the Data property in the Database window.
The Data property has a spreadsheet-like appearance with the record numbers displayed in the first
column. Views (i.e., changes to the display format of the data) may be saved and re-opened as
required. Changes to the display of data in the Data property are saved with the database and will
be re-applied when the database is opened.

History

The History property of the Database window maintains an audit trail or log of all operations
carried out on a database, including its import and each audit test. It produces a linear log so that
the process of how the file was created can be traced. The History log is contained within the IDEA
database (filename.imd).

Field Statistics

The Field Statistics property provides statistical information on the values of Numeric, Date and
Time fields within the database, such as net, maximum, minimum, and average values; numbers of
debit, credit, and zero value items; and date statistics, such as the earliest and latest date. The Field
Statistics property gives a valuable initial analysis of the database by helping the auditor to gain an
understanding of the data and perhaps even identify problems to be investigated further, such as
negative inventory items, zero-value check payments, or after date transactions.
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Extract High Value
and Old Items

Results
The following tests in IDEA produce Results output displayed in the Database window.

e  Gap Detection

e Benford's Law

e Aging

e  Stratification

e Summarization (optional)

e Pivot Table

e  Generate Random Numbers
e Chart Data

e Correlation

e Trend Analysis

e Time Series
The Results may be accessed by clicking the relevant link in the Results area in the Properties
window. Any number of Results may be created for a database and each will be given an
appropriate name.
The Results remain in the IDEA database and may be viewed or printed at any time. The description

of the Results tab may be changed to a more meaningful name. Results may also be deleted if
required.

Objective:

To identify high value items and old items.

Exercise Description:

This exercise uses extractions to identify high value invoices (i.e., > $10,000) and old invoices (i.e.
before 31 December 2014) found in the Acc Rec March 31 2015 database. This exercise will teach
you how to extract data from the database, perform multiple extractions, and understand the
benefits of multiple extractions.

IDEA Functionality Covered:

e  Extractions

e  Multiple Extractions

1. Ensure that Acc Rec March 31 2015 database is selected as the active database and the
Data property is selected in the Properties window.

2. From the Analysis tab, in the Extract group, click Direct.

The Direct Extraction dialog box appears.
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3. Adefault File Name is provided. Change this to: High Value Amounts as shown below.

Direct Extraction
Records to extract: (@) Al Starting record #: 1
(O Range Ending record #: 253 Create Fields
Create a virtual database Filds
Database order: |No index W Delete
File Wame Criteria Cancel
1 |High Value Amounts Help

2

4. Click the Equation Editor button.

5.  Enter the expression GROSS_AMT > 10000.

Note: Do not enter the currency symbol or thousands separators when entering numbers.

Equation
o . I::I = == »* & &= >z 3 + - * _.'r AMD OF MWOT MOD EXP E
GROSS_AMT = 10000

6.  Once the equation has been entered, check the syntax and close the Equation Editor
window by clicking the Validate and Exit button.
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10.
11.

12.

13.
14.

15.

Click the second row of the Direct Extraction dialog box and notice that a default file name is
provided.

Enter the file name: Old Invoices.

Click the Equation Editor button.

The Equation Editor appears and is used to enter the required equation.

Enter DATE_DATE <= “20141231" using the Calendar button to select the date.

Once the equation has been entered, check the syntax and close the Equation Editor
window by clicking the Validate and Exit button.

In the Records to Extract area, accept the default selection of the All option to extract the
records from the whole database.

Direct Extraction
Records to extract: (@) All Starting record #: 1
(C)Range Ending record #: | 253 Create Fields
Create a virtual database Ficlds
Database order: |No index v Delete
File Name Criteria Cancel
1 | High Value Amounts GROSS_AMT = 10000 Help
2 | Old Invoices DATE_DATE <= "20141231"

3

Click OK to run the extractions.

Two new databases have been created as shown in the File Explorer window. High Value
Amounts will be the active database. View this database, record the results, and view the
History log. Open the Old Invoices database. View this database, record the results, and
view the History log.

e High Value Amounts: There are 10 records totaling $139,479.86.
e Old Invoices: There are 3 records totaling $5,465.29.

From the File tab, click Close All Databases to close all databases.

Advantages of Performing Multiple Extractions

The extractions are performed with a single pass through the database, saving considerable time
when testing large files. Up to 50 extractions may be carried out at one time.
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Identify and Review Objective:

All Credit Notes _ , _
To identify all credit notes.

Exercise Description:

This exercise will identify all credit notes (i.e., where TYPE = “C") using the Criteria property. The
differences between the Extraction and Criteria will also be explained.

IDEA Functionality Covered:

Criteria.
1. Open the Acc Rec March 31 2015 database.

2.  Click the Criteria link in the Properties window to load the Equation Editor.

* X | Properties o

PAIC = || i w Database

o Data
W History
@l Field Statistics
@ Control Total: 369,255.13
W Criteria

[ m

Criteria

Enter criteria to filter the records displayed.

3.  Enter the following equation: TYPE = “C".

4.  Click the Validate and Exit button on the Equation Editor toolbar to check the syntax and
exit the Equation Editor.
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5.

The criterion will appear beside the Criteria link in the Properties window and will be
applied to the database. Note the Status bar, at the bottom right of the application
window, indicates that 34 of the 253 records meet the criterion. Note also that the Control
Total for the database has changed and is calculated for the 34 records.

OB = = = CaseWare IDEA - Acc Rec March 31 2015.IMD -
Home Data Analysis View Macros SmartAnalyzer Custom Macros & )

21 Summarization £ Aging

@ 2 Direct =2 TopRecords = Gap Detection [ Duplicate Key+ T3 Join % Visual Connector 511

Z1 Stratification 17 Pivot Table

Re-un i indexed = KeyValue  fi Benford's Law [ Statistics = el Chart 2 Append = Compare Sample Visualization
Tasks Extract Explore Categorize Relate
i | R 2 Rec March 31 20151MD x . B
File Explorer ACCOUNT_NO | INVOICE_NO | TYPE | GROSS_AMT | GST | PST | PAI A Properties
= = 1 | NoDS 46045 C 876 123 139 i + Database
GleMm 2 |A123 46049 C 796 517 585
Desktop Project 3 |F123 46052 C 789 517 -5.85  Data
Name 4 | T005 46054 c 1530] <100 113 i History
-9 Accounts Receivable 5 | To10 46185 [d 1,588106 10390 117.64 i Field Statistics
57 Acc Rec March 31 2015 6 |At28 45186 c -43100: -2820 -31.93 i Control Total (22,707.08)
%3 High Value Amounts E 46187 c 43100} -2820| -31.93 (GROSS_AMT)
T Old Inveices 8 |Fi28 46188 c 43100 -2820| -3193 i Criteria: TYPE= "C"
-5 Sample of Acc Rec Transa.. | 8 | F130 46189 [d 431000 -2820  -31.93
10| To10 45190 c 154: 010 -0 ¥ Results
1| Mi28 46191 c 63479 4153 -47.02 i Age Anatyss Report
12 | M130 46192 C ma5] 2911 320
13| PO10 45193 [d 07831 7054 7087 i v Indices
14 | 010 46194 c 14931 088  -1.11
15 | MO14 46216 c 194575 -127.29 | -144.13 + Noindex
16 | C020 46217 C 23451 1534 737 e "
17 | To10 46218 C 581 038 043 omments
18 | D014 46219 c 2500517 000 000 5 Add comment
| 19 RO25 46220 c WB14; -6 727 i Database Reconciliation -
20 Hol4 46221 c 250051 -16358 -185.22 Database reconciles to totals
21| wo2o 46022 C 244782 16014 18132 provided by client,
< > [22]8010 46223 c 0117 -086]  -075 v
File Explorer JEE < >

Running Tasks Search Results

Managed Project: Accounts Receivable Audit Mot connected to IDEA Server Mumber of Records: 34/253  Disk Space: 21

Right-click the Criteria link in the Properties window and click Clear to return to viewing
the whole database.

Apply the following new criterion to the database: GROSS_AMT < 0. There are 44 items
including 10 unallocated payments (TYPE = “P").

Clear the criterion to view all records.
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Differences Between Extractions and Criteria

The Criteria property is similar to the Extractions tasks in that it is used to identify items satisfying
a given equation.

However, the Criteria property does not generate an output database, it simply displays, in the
Database window, only those records satisfying the criterion. Additionally, nothing is written to the
History log when using the Criteria property.

When running tasks where entering criteria is optional, Criteria may be simple or complex. Any
criteria used remains available in the Criteria link for that database, and can be selected and applied
as required. Right-click on Criteria to access the list of Criteria used.

Equations can also be saved and reapplied through the Equation Editor for use in extractions and
Virtual fields.

IDEA lists, and allows you to gain access to, the eight most recently opened Criteria for the current
database. When a Criteria is longer than 50 characters, the menu will display only the first 47
characters followed by an ellipses.

Note the recent Criteria list is not passed down to child databases.

Conclusion

There are several unallocated payments on account that should be brought to the client’s attention.
The number of credits is also high.
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Calculate the Net Objective:

Transaction To prove the accuracy of the calculation of the net amount.

Amount
Exercise Description:

Calculate the net amount from the GROSS_AMT, PST, and GST fields. This involves appending a
Virtual (or Calculated) field to the database and entering the appropriate field equation.

IDEA Functionality Covered:
e  Field Manipulation
e Appending virtual fields

e Displaying the format of the database

e Changing field names in a database

1. Ensure the Acc Rec March 31 2015 is the active database and Data property is selected in
the Properties window.

2. From the Data tab, select the Field Manipulation task by selecting the button at the corner
of the Define Action Field button.

Home Data Analysis View Macros SmartAnalyzer
=. @
m V2 ' B RE § OO0

Copy Index  Sort Describe Append Medify Remove  fipg Define Find Find Go
Sorted Order - Action Field - Mesxt To

Clipboard Order Fields ___._b % Search

: | Acc Rec March 31 2015.MD_x | IRNRPRVEREFI.

n
Fi |e E}{p | orer ACCOUNT_NO | INVOICE_MI  modify or print the record
— — 1 [ co2o A6000 definition; add or delete

[E B F_/ F | 2 | coz0 26006 calculated fields.

Alternatively, you can double click within the data grid to bring up the Field Manipulation.
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3.  Click Append on the Field Manipulation dialog box and enter the following details:
e Field Name: NET
e Field Type: Virtual Numeric
e Field Length: Do not enter
e Decimals: 2
e Description: Net Amount

Field Manipulation

Field Name Type Len | Dec Parameter Description ~

5 |G5T MNurmneric 8 2

- Append
6 |PST Numeric 8 2
7 |PAID_FLAG Character 1 Delete
8 |DATE_DATE Date 3 YYYYMMDD Print
9 |DATE_TIME Time 3
10 | CUST_REF Character 10 Copy
11 | COMMENT Character 1l Cancel
12 | NET Virtual Mumeric 2 MNet Amount

Help

4. Click the Parameter box to load the Equation Editor for building the equation. Enter
GROSS_AMT - (GST+PST)

Equation
L) === o2 o4z 2z o= o+ - F 7 AND OR NOT  MOD EXP E

GROSS_AMT - (GST + PST)|
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5. Once the equation has been entered, check the syntax by clicking the Validate and Exit

button.
Field Manipulation
Field Name Type Len | Dec Parameter Description ~

5 | GST MNumeric 8 2

- Append
6 |PST Numeric 8 2
7 | PAID_FLAG Character 1 Delete
8 DATE_DATE Date 8 Y MMDD Print
9 DATE_TIME Time 8
10 | CUST_REF Character 10 Copy
11 | COMMENT Character 1l Cancel
12 NET Virtual Numeric 2 GROSS AMT - (GST + PS..| Met Amount

w Help
6. Click OK.

7. Click Yes to continue and to append the field to the database.

8.  Scroll right and view the resultant field that is added as the right-most field of the database.
Note that the values in this field are displayed in the color teal. This distinguishes a Virtual field
from an original imported field.

9.  Place the cursor over one of the Virtual field values and note the equation in the tool tip
that is displayed.

Acc Rec March 31 2015.IMD X

PST | PAD_FLAG | DATE_DATE | DATE_TIME | CUST_REF | COMMENT NET | Pro perties
1] 17 1174/ 00:00:00 A 5574 | ~ 20 escription: et Amount
2 | 2257 00:00:00 : X 9574 - 24 Type: Virtual Mumeric
3 502 00:00:00 |V 587 . |Equation: GROSS_AMT - (GST + PST)
4 296 00:0000 Q 8882 | - [ Decimals 2
5 | 26248 00:00:00: D 8050 i 304024 Field Statistics
6 | 279.01: 00:00:00 K 3049 Control Total: 369,255.13
7 | 15556 ! 00:00:00 | Q 451 (GROSS_AMT)
o o i 4smnsmnac ARARLAA KA 194 riboria

10.  View the History of the database and note the recording of the Virtual field equation.

11.  Return to the Data property.

Note: The Virtual field will not be editable in any child database created from the parent
database.
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Analyze the Objective:

Balances and Taxes
by Account

To total the Accounts Receivable and taxes by customer to prove customer balances. Identify the
top ten debtors.

Exercise Description:

Use the Summarization task to total the Accounts Receivable and taxes by customer account
number.

e Summarize (i.e., total) data by a key
e  See the differences between the Summarization options

e Create a list of unique items in a database

IDEA Functionality Covered:

e Using Quick Summarization

e Indexing databases with a single key (Quick Index)

Note: In this exercise, the Quick Summarization option can be used as there is only one field in
the key i.e., ACCOUNT_NO.

1.

Ensure Acc Rec March 31 2015 is the active database and the Data property is selected in
the Properties window.

From the Analysis tab, in the Categorize group, click Summarization.

Home Data Analysis View Macras SrartAnalyzer

@ A Direct =2 Top Records = Gap Detection Ca Duplicate Key~ | £ Summarization | £] Aging

= Stratification .+ Pivot Table
Re-run = Indexed = Key Value 1 Benford's Law [ Statistics = | Chart
Tasks Extract Explore Categorize

Select or enter the following:
e Fields to Summarize;: ACCOUNT_NO
e  Numeric Fields to Total: GROSS_AMT, GST, PST, NET

Click the Fields button and note that no fields are selected. This stops unnecessary
information being included in the summarized database. Click OK to return to the
Summarization dialog box.

Select the Use Quick Summarization option.

Accept the Create database option. This creates a database of the resultant account
records. This database will be joined to the Customer Master database in a later exercise.

Do not select the Create result option. This would write the results to a new Results output
with dril-down and graphic capabilities. Criteria can be specified for a summarization. If
asked to include transactions before a specific date, the Criteria option would be used. For
this exercise, the Criteria option will not be used.



68 | IDEA Version Ten Workbook

8.  In the File name field, enter Balances by Customer.

9. Click OK.
Summarization
Fields to summarize: Mumeric fields to total:
By: |ACCOUNT_NO v [V]GROSS_AMT oK
Then by: [v]esT )
[w]PsT Fields
Then by: MET
Cancel
Then by:
Thenby:
Then by:
Then by:
Then by:
Criteria:
Use Quick Summarization Statistics to indude:
Create database V| Sum Average
[Jindude % in output database Maximum Variance
Minimum Standard deviation
®) Use fields from first occurrence
Use fields from last occurrence [ create result
File name: | Balances by Customer Result name:  Summarization

10.  View the resultant database, adjust column widths if necessary, and note the following
fields:

e ACCOUNT_NO: List of all customer accounts for which there has been
transactions

e NO_OF_RECS: Number of records (i.e., invoices, credits) per account
e  GROSS_AMT_SUM: Gross balance by account

e  GST_SUM: Total GST by account

e PST_SUM: Total PST by account

e NET_SUM: Total net balance by account
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In addition to providing totals for the selected Numeric fields, the Balances by Customer
database shows 51 customers with balances.

= o A - o [
Sl (a8 o 2 El s O CaseWare IDEA - Balances by Customer.IMD | x|
Home Data Analysis View Macros SmartAnalyzer &2 1
:v" =2 Direct =2 Top Records = Gap Detection Cé Duplicate Key - S Summarization Aging & & ’
R :§ Stratification 7 Pivot Table
e-run o = 1 : . - o
+ Indexed Key Value & Benford's Law [ Statistics Ll Chart Re\vate SHI’TFﬂE Vlsualizatmn
Tasks Extract Explare Categarize
. PR CE RPN VLR olances by CustomeniviD < [ . .
Fl |e Exp‘orer ACCOUNT_NO NO_OF_RECS | GROSS_AMT_SUM | GST_SUM | PST_SUM | A Propertles
P - 1| a123 9 700108 9473 67342 i w Database
Ls B ~ F ul 2| a128 6 5779.09: 37807 42808
[EEsibh F R | 3 | Boos 1 431000 28200 -31.93 ' Data
MName Records 4 [ BO10 8 4.408.15 23839 32653 &e History
(-5 Accounts Receivable 300 |5 cozo 7 916490 59958  678.87 i Field Statistics
=-8f Acc Rec March 31... 253 (& |D014 [ 1390022 1,073.53 1,215.54 i@ Control Total
.59 Balances by C... 51 |[7]po2s 12 1073156 83296 94301 & Criteria
-7 High Value A... 0 [B]F2 7 3445741 35625 40340
5@ Old Invoices 3 8 [F128 [ 5,778.08 378.07 428.08 i w Results
; 20 [[10|F130 1 431000 -28200 -39
11| Goto 9 6,753.60 1 44184 50027 ¢ w Indices
12| Go2o 7 1420879 935441 1,050.17
13| HO14 8 15,389.16 0 1,006.77 | 1,139.94 ~ Mo index
14 | HO25 12 10,30278 0 80491 91135 —
(15| Koo I 13,5445 82589 93514 dCommenty
16| MO10 8 5993.901 392121 44400 = Add comment
17 | M014 2 2277103 148970 1,686.74
18 | MO20 5 5068121 331551 37542
19| Mo25 12 16,25436 0 1,00843 | 1,243.74
20| M123 7 1191239 87824 99440
< > [21] w28 4 480275 31420 35577,
File Explorer L\brary‘ < >

Running Tasks Search Results

Managed Project: Accounts Receivable Audit Mot connected to IDEA Server MNumber of Records: 51 Disk Space: 827.56 GB

11.  In order to identify the top ten debtors, sequence the records in descending
GROSS_AMT_SUM value by creating an index. If there is a single field in the key (i.e.,
GROSS_AMT_SUM), the "quick” index option can be used as follows:

a. Double<lick the field name GROSS_AMT_SUM. This will index the database on
the GROSS_AMT_SUM field in ascending order.

b. Double-click the field name a second time to index in descending order.

Note that the Indices area of the Properties window displays the index
GROSS_AMT_SUM/D.

The largest balance is $45,736.81 for account WO025 (with 11 transactions).

12.  Close all databases by clicking the File tab and then Close All Databases.
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Check Debtors Bright IDEAs Inc. services must be paid for in advance unless a credit check has been performed
Against Authorized for the customer and an entry made on the authorized customer credit list.

Credit Risk opjective:

To test that all transactions, such as invoices, credit notes, and payments are recorded for valid
customers. To identify where credit limits have been exceeded for any customer.

Exercise Description:

Import the Customer Master file that has been supplied as an electronic report file using the Report
Reader module.

The Balances by Customer database will be matched (joined) to the Customer Master database.
Accounts where the credit limit has been exceeded will be identified.

IDEA Functionality Covered:

e How to import a print report file using the Report Reader module within IDEA

e The need to plan for the field types, if the database is to be joined, matched, or
compared with another database

e Join or match data in different databases

e The different join options

e Identify the number of mismatches on key fields
e  Perform an extraction

e  Find all records containing specific data

The Customer Master file has been supplied as a Print Report in text format. Report Reader is
used to extract data from Print Report files, importing it into IDEA.

Print report file: CUSTOMER
Import the Print Report file
1. From the Home tab, in the Import group, click Desktop to access the Import Assistant.
The Import Assistant dialog box appears.
2. Select Print Report and Adobe PDF.

3. Click the Browse button to navigate to and select the required file.
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4.  Select Customer.txt and then click Open. Notice the various types of Print Report files IDEA
can import.

S Select File
T .« Accounts Receivable... » Source Files.ILB v & Search Source Files.ILB P

Organize Mew folder 1= - E 7]

- Name Date modified Type 5i

#@& OneDrive

. Documents

| Customer.xt 6/9/2015 11:21 AM Text Document

. Pictures

% This PC
mm Desktop
| Documents
& Downloads
Jf Music
=| Pictures
& Videos
iy Local Disk (C:)
—a Data (E)
v < >

[ SEYEN v

File name: | Customer.txt ¥ All Reports (*.prn,*.bdt, *.csv,*.as v

5.  Click Next to open the Report Reader.
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6. Maximize the Report Reader window. Scroll through the report and notice the information
that is included in the report:

e Account Number
e Name

e Address

e  Credit Limit

el Report Reader - Customer.ixt = =
File Edit Layers View Traps Fields Help
a7
=
g
Bright IDEAs Inc =)
Customer Master Listing
Account Number Name Address Credit Limit
A001 Dan Ackroyd Audenshaw 20000
125 New Street
Montreal
Quebec
HZS 3H2
A123 Mike Atsil The Vetinary House 20000
123 Dog Row
Thunder Bay
Ontario
K3a 7G1l
2128 Ivan Aker The 0ld House 10000
v
< T >
Ready Ln, Col Page

Note: The Report Reader uses a set of layers to define the data to be imported into IDEA.
The first step is to identify the Base Layer. The Base Layer is the line(s) that contains the
lowest level of detail information in the report. It is very important to select the line from the
first record in the report, even if that line contains spaces instead of having every column
filled with data.

Once the Base Layer is defined, Append Layers that provide related information to the Base
Layer can also be defined. The Base Layer and Append Layers are identified by Traps.

Traps can be Text, Numeric, Space, Non-Blank, Floating, or actual words that uniquely
identify each occurrence of the record in the report. Keep the Traps as simple as possible.
Do not overlook the possibility that spaces or spaces combined with numbers or text could
be the best Traps.
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Define a Base Layer

1. Scroll through the report and identify the line(s) that contain the lowest level of detailed
information and highlight the lines with the cursor (click and drag). Since the address
information is a multiple line field, the Base Layer will contain 5 lines.

2.  Select Create a standard layer and then click Yes.

s Report Reader - Customer.txt = B
File Edit Layers View Traps Fields Help

Bright IDEAs Inc
Customer Master Listing

silejaq platd

Account Number Name Report Reader Credit Limit

‘What do yeu want to do with the sample inefs]?

a001

(®) Create a standard layer
) Create a floating layer
Exclude it from the oulput

Yes Cancel Help

Al123 Mike Atsil The Vetinary House 20000
123 Dog Row
Thunder Bay
Ontario

K3a 761
al28 Ivan Rker The 0ld House 10000
v
< o >

The Report Reader will display a Field Editor (the section between the two yellow lines)
where the fields that need to be included in the database are defined. Scroll through the
report and notice each section of data begins with an account number. The best Trap for
the Base Layer is a combination of text and numbers, based on the account number
(TNNN).
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3. Place the cursor in the Anchor Editor area above the account number in the Field Editor.
On the Report Reader toolbar, click Text Trap once and click Numeric Trap three times.

= Report Reader - Customer.txt* = =
File Edit Layers View Traps Fields Help
2 TR®LR %

TNNN

Field Details #
# A001 Dan Ackroyd Audenshaw -
125 New Street -

Montreal
Quebec

H2S 3H2 v
~
Bright IDEAs Inc
Customer Master Listing
Account Number Name Address
aA001 Dan Ackroyd Audenshaw

125 New Street
Montreal

Quebec

H2S 3H2 .
< >
Ready Ln, Col Page

Notice each section of data that begins with an account number is highlighted.
4.  Scroll through the report to make sure all the information is highlighted.
Identify Field Anchors

Selecting the information that will become the data fields in the database is done by identifying
Field Anchors. Using the cursor, you will highlight each Field Anchor contained in the Base Layer.
Make sure the widths are large enough to include information that may be slightly off position or
extremely long. Watch for items that appear as spaces in the Base Layer line, but contain values in
other lines

1. In the Field Editor (the row with the pound sign (#)), highlight the account number
information.

Note: If a mistake is made while highlighting the field, click the Remove Field Anchor
button on the toolbar to remove the Field Anchor or rightclick the Field Anchor to display
a shortcut menu. Both actions remove the Field Anchor that is active and highlighted.

2. The color of the selected field will be orange and all the account number fields of the detail
lines in the report will be highlighted.

Now that the Field Anchor in the Base Layer has been highlighted, it is necessary to name
and detail each field. This is done using the Field Details window.
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3. In the Field Details window, enter the following details:
e Layer Name: Layer-1
e Name: ACCOUNT_NO
e Type: Character
e Offset: 5
e Actual Width: 4

g Report Reader - Customer.txt (Customer.jpm)* = =
File Edit Layers View Traps Fields Help
i TRLR @ L
LLLL Field Details "
# Dan Ackroyd audenshaw - .
125 New Street
Montreal =/ Layer Information “
Quebec
425 3m2 L LeyerMeme [Loyer
\-I Field Information
A Name ACCOUNT_NO
Type Character
Bright IDEAs Inc
Customer Master Listing
. Positi
Offset 5
Actual Width 4
Account Number Name Address =1 Attributes
_—_— ] Blank Cells Leave blank
Multi-line Mo v
A001 Dan Ackroyd Audenshaw
125 New Street
Montreal
Quebec
H25 3H2 v
< >

4. Inthe Field Editor, highlight the customer name information, leaving enough room for the
larger data.

5. In the Field Details window, enter the following details:
e Name: CUST_NAME
e Type: Character
e Offset: 23
e  Actual Width: 28

6. In the Field Editor, highlight the address information, leaving enough room for the larger
data.

7. In the Field Details window, enter the following details:
e Name: ADDRESS
e Type: Character
o Offset: 57
e  Actual Width: 33

e  Multi-line: Yes

8. 8. In the Field Editor, highlight the credit limit information, leaving enough room for the
larger data.
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9.  In the Field Details window, enter the following details:
e Name: CREDIT_LIM
e Type: Numeric
e Offset: 95
e Actual Width: 7

10.  When you are done the fields should match the following table:

NAME TYPE OFFSET ACTUAL WIDTH
ACCOUNT_NO Character 5 4
CUST_NAME Character 23 28
ADDRESS Character 57 33
CREDIT_LIM Numeric 95 7
- Report Reader - Customer.txt (Customer.jpm)* = =
File Edit Layers View Traps Fields Help
G TR0 % B B o % ® Q]
TNNN . .
7
# |Dan Ackroyd Rudenshaw ) Field Details
125 New Street ozl
Montreal -I Layer Information ~
Quebec Layer Type
zs 3m2 L LeverName [Layerd
= Field
~ Name CREDIT_LIM
Bright IDEAs Inc Type Mumeric
Customer Master Listing Decimals 0

Implied Decimals No

-l Position

Offset 95
Account Number Name Address Actusl Width 7
=)
Blank Cells Leave blank
aQo1 Dan Ackroyd Audenshaw Vulti-line o v
125 New Street Name
Meontreal Name of this field.
Quebec
H25 3H2
v
< >
Ready Ln, Col Page:

Since all the required information can be defined in the Base Layer, Append Layers will
not be defined for this exercise.

11.  Click the Save Layer button on the toolbar.
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Importing into IDEA

1. Before importing the file into IDEA, it is recommended to preview the entire database. Once
the Base Layer has been defined, click Save Layer. Once the layer has been saved, the
IDEA database can be previewed at any time by clicking Preview Database on the toolbar.
The preview should look like the following example.

ol Preview Data

ACCOUNT_MNO CUST_NAME ADDRESS A

A Dan Ackroyd Audenshaw 125 New Street Meantreal

A123 Mike Atsil The Vetinary House 123 Dog Row Thunder Bay
A28 lvan Aker The Old House Ottawa Ontario

BOO1 Kim Basinger Mesh House Fish Street Rouyn

BOO2 Richard Burten Eagle Castle Leafy Lane Sudbury

BOO4 Jeff Bridges Arrow Road Morth Lakeside Kenora

BOO8 Denise Bent The Dance Studic Covent Garden Maontreal

BO10 Carter Bout Removals Close Ma Fixed Abode Road Toronto

Bo22 Rennie Biggs Gotaway Cottage Thunder Bay Ontario

conl Tom Cruise The Firm Gunnersbury Waskaganish

Coo3 Jehn Candy The Sweet Shop High Street Trois Rivieres

Con4 Jamie Lee Curtis Wanda Avenue Welham Green Maontreal

Coos Kevin Costner Water Way Wet Street Ottawa (
cooa Wyn Chester Gun Lane Sudbury Ontario I
Coz20 Penny Cillin The Doctors Surgery Green Park Chibougamau
D002 Robert De Nire TheRing Madison Square Garden Orleans

7| nann [T . W T RASKA P [ J— P T

Refresh

SRR
o] | =] 2[3[ 2] 3] o] o] N[ @] r] a] o] o] +

A
v
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2. Before importing the file into IDEA, it is also recommended that one use the Scan for Errors
task. Scan for Errors identifies any items that may not import properly such as fields where
the length is too short and fields that are not in alignment with the preceding fields. Click
the Scan for Errors button on the toolbar.

-t Report Reader - Customer.txt* -
File Edit Layers View Traps Fields Help

2 - & o @, e

~ .
Field Details #
Bright IDEAs Inc i
Customer Master Listing
Report Reader
Account Number Name
!.\ There were no validation errors in this report. [~
AOQO01 Dan Ackro i
Street
,
H2S8 3H2
A123 Mike Atsil The Vetinary House
123 Dog Row
Thunder Bay
Oontario
K3Aa 761
v
< >
Ready Ln,Col Page:

3. Once the Scan for Errors validation is complete, save the Report Reader template for
future use with similar reports. Click File > Save Template As. Give the template a name
and save it to the Project Folder. For this exercise, we will name the template Customer
Master. The Project Folder is the preferred location unless the templates are shared items
and need to be stored elsewhere.

Click the Import into IDEA button on the toolbar.
Click Yes to proceed with the import.

Select the Generate field statistics option

N L

Name the database Customer Master and then click Finish.
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Set the Control Total Field

Select the CREDIT_LIM field as the control amount field for the database by clicking on the Control
Total link in the Properties window.

o Zmisd CaseWare IDEA - Customer MasterMD - o lEN
Home Data Analysis View Macros SmartAnalyzer & )
4 Export -
s RBRE R B G e 3
Project Create Select pcpiye Properties Desktop § Select  Passport
Overview - & Send Using E-mail Server
Projects Import Export IDEA Server CaseWare
R a Balances by CustomerIMD X . 2
File Explorer ACCOUNT_NO | CUST_NAWE 7oDREsSs ~| Properties
sl 1 | ADO1 Dan Ackroyd Audenshaw 125 Mew Stre i w Database
B |—‘B - @ 0 || Quebec H25 3H2
Desktop Project 2 |A123 Mike Atsil The Vetinary House 123 Dog F ~ Data
Name Records ||| Bay Ontario an History
E|—I Accounts Receivable 300 3| a1z van Aker ;:1; CS)[\;Hou;e Ottawa in Field Statistics
=-ap .:\—cc Rec March 31... 233 4 o1 Kim Basinger Mesh House Eich Street & Control Total: 1,595,000
¥ Balances by C... 51 Quebec 5V 2A9 (CREDIT_LIM)
T High Value A.. 10 15| Boo2 Richard Burton Eagle Castle Leafy Lane i Criteria
& Old Invoices 3 - Ontario L3M 953 -
T Sample of Acc.. 20 |6 Boos Jeff Bridges Arrow Road North Lakeside aficults
-5 Customer Master 87 || Ontario M3R 251
7 | BOO Denise Bent The Dance Studio Covent Ga Indices
Quebec H55 3H2
BO10 Carter Bout Removals Close Mo Fixed Al ~ Mo index
Toronto Ontario -
9 | B022 Ronnie Biggs Gotaway Cottage Thunder B ¥ Comments
K3 6F3 -
10/ Cool Tom Cruise The Firm Gunnershury W Add comment
Quebec G1A BHS
11| Co03 Jahn Candy The Sweet Shop High Street
Quebec JBV 3A1
12| Cond Jamie Lee Curtis Wanda Avenue Welham G
Quebec H45 3H2
< > 23] cons Kevin Costner Water Way Wet Street ¥ _
il < >

Num

e  The control amount of 1,595,000 is displayed.

e There are 87 records, i.e., 87 customers
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Join the Balances

IDEA enables multiple databases to be viewed at one time. This is particularly useful when joining or
matching databases as it enables you to identify the common key by which the databases will be
matched.

2.

3.

Open the Balances by Customer database (leaving the Customer Master database open).

From the View tab, in the Tabs group, and click Horizontal.

Home Data Analysis Wiew Macros SmartAnalyzer

=

=]
& Open 3 Refresh 5 = @m
L. Highlight Spaces a
Eg Save = Reset T= roup
“ @ Zoom Records

Alignment Display Group Tabs

Views Format -]

Horizontal [Vertical

Identify the field that is the common field by which the two databases are to be joined. In
this case, the common field is ACCOUNT_NO.

= = o - o
(O BP: N W= == = == 7} CaseWare IDEA - Customer Master.IMD EN
Home  Dats  Analysis | View  Macros  SmartAnalyzer  Custom Macros © ?
2 Open £ Refresh T Field Statistics +E -
L1 Highlight Spaces 6
F'p Save o Reset T= roup
“ [ Zoom Records
Views Format ] Alignment Display Group Tabs
- [ Balsnces by CustomerIMD | - -
7 7
Fl‘e Exp‘orer ACCOUNT_NO NO_OF_RECS ‘GRUSSﬁAMTﬁSUM GST_SUM | PST_SUM | NET_SUM ~ Propenles
RO F - HEE 9! 7001080 59473 67342 58293 |+ patabase
& o n 12 | 128 [ 5779.00 37807 42808° 49R2M4
Desktop Project |3 | Booe 1 43100 -2820  -31.93. -370.87 ~ Data
Mame 4 | Bo10 8 440815 28339 32653, 379323 #i History
[ i# Accounts Receivable | 5 | €020 I 9,164.90 599.58 678.87 | an Field Statistics
=T Acc Rec March 312015 [ Jetn d | LIRSl a] i Control Total: 1,595,000
77 Balances by Customer | 7 | D025 12 10,731.56 832.96 9431 (CREDIT_LINM)
-7 High Value Amounts |8 |F123 I 344574 35625 40340 #i Criteria
57 Old Invoices 9 |Fi28 [ 577900 37807 42808
%9 Sample of Acc Rec Transa... | < > ¥ ¥ Results
- |Custorner Master Customer Master.MD X -
¢ ¥ Indices
ACCOUNT_NO | CUST_NAME ADDRESS ~
1| Aot Dan Ackroyd Audenshaw 125 New Street + Noindex
|| Quebec H25 3H2
2 |A123 Mike Atsil The Vetinary House 123 Dog Row i ¥ Comments
Bay Ontario K3ATG1
3| at28 lvan Aker The Old House Ottawa i Add comment
|| P1D 804
4 | B0O1 Kim Basinger Mesh House Fish Street
Quebec 15V 2A9
5 | BOO2 Richard Burton Eagle Castle Leafy Lane
| Ontario L3M 953
< > 1’6 | eood Jeff Bridges Arrow Road North Lakeside v
I Library | < >

Running Tasks Search Results

Mot connected to IDEA Server

Managed Project: Accounts Receivable Audit

Number of Records: 87 Disk Space: 22.52 GB

Note: An alternative way to create or change tab groups is by right-clicking on the database
tab and selecting either New Horizontal Tab Group or New Vertical Tab Group. Notice
you can also arrange the databases in a vertical format.

Access the Field Manipulation task by either double-clicking over the Database window.
Confirm that the common field is the same format (i.e., Character) in both databases.

(Having checked one file, click on the window for the other file and repeat the exercise).
Note: The window with the blue title bar is the active window.



Section 2: Accounts Receivable Audit |81

Close the Customer Master database and maximize the remaining window.

Ensure that Balances by Customer is selected as the active database (this is known as the
primary database for the join).

From the Analysis tab, in the Relate group, click Join.

Home  Data | Analysis | View  Macros  Smarbhnalyzer 2
E\/) 2 Direct =4 Top Records &5 Gap Detection g Duplicate Key= - cummanzation k] Aging 52 Visusl Connector 1 Attribute = Monetary Unit~ ol (g
1 Stratification i Pivot Table

=% Random 3] Variables ~
Re-un = |ndexed = Key Value 5T Benford's Law [E) Statistics - & Append = Compare Discover Visualize

| Chart =) Other+
Tasks Extract Explare Categarize Relate Sample Visualization

Click the Select button to choose the Customer Master database as the Secondary
database.

Select Database B
Desktop Project oK
Mame . Records Size Modified Cr...
= Cancel
Accounts Receiv... 300 92 1/872006 4. 1/.
. iCustomer Master a7 34 1/18/2016. 1/ |

Notice the Primary and Secondary database details in the Join Databases dialog box.
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10.  Specify the common match key by clicking the Match button to display the Match Key
Fields dialog box:

a. Click the Primary text box and select ACCOUNT_NO from the list of fields.
b. Note the Order text box and accept the default, Ascending.

c. Click the Secondary text box and select ACCOUNT_NO from the list of fields
and then click OK.

Match Key Fields
Primary Order Secondary 0K
ACCOUNT_NO (C) Ascending |ACCOUNT_ NG (C) w]
Delete
Cancel
Help

There are 5 join options at the bottom of the Join dialog box. These cover whether only
matched items are required, non-matches and so on.

MATCH OPTIONS DESCRIPTIONS
Matches only Extracts records with matches in both
databases.
Records with no secondary match Extracts records from the primary

database with no matches in the
secondary database.

Records with no primary Extracts records from secondary database
match with no matches in the primary database.
All records in primary file Extracts records from primary database
with or without matches in secondary
database.
All records in both files Extracts all records from both databases.

11.  Select the All records in both files option.
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12.  In the File name box, enter Customer Balances and Limits. The Join Databases dialog
box should appear as in the image below.

Join Databases
Primary database: Balances by Customer Fields
Mumber of records: 51 Cancel
Criteria: Help

Secondary database: Customer Master Select

Mumber of records: 87 Fields

File name: | Customer Balances and Limits| Match

() Matches only () all records in primary file

() Records with no secondary match (@) All records in both files

() Records with no primary match

Create a virtual database

13.  Click OK to join the selected databases. View the resultant database and notice the “gaps”
in the data where there have not been matches on the keys.
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14.  Click the History link in the Properties window and then locate and expand the section for
the Join Databases task.

Customer Balances and Limits

EiExportto § & = B Filter

Database | Date User
|+l Accounts Receivable-Acc_rec2015.IMD

|+l Accounts ReceivableMD

|+l Acc Rec March 31 2015.IMD
Balances by Customer.|MD
(=] Customer Balances and Limits.IMD

B Join Databaszes 2/5/2016 3:55:23 PM IT Ottawa
File name: ChlUsers\|T Ottawa\Documents\ My IDEA Documentsh|DEA
ProjectshAccounts Receivable Audith Custorner Balances and
Lirnits.IMD
Mumber of records: m
Control field: Mo Contrel Total
Control total: Me Contral Total

Unmatched primary recs: 14

Unmatched secondary r.. 50

Join primary file: ChUsers\|T Ottawa\Documents\My IDEA Documentsh|DEA
Projects\Accounts Receivable Audit\Balances by CustomerIMD

Mumber of records: 5

Join secondary file: ChUsers\IT Ottawa\Docurnentsi My IDEA Documnentsh|DEA
Projects\Accounts Receivable Audit\Custormer Master.|MD

Mumber of records: a7

Type of join: All records in both files
Key used: ACCOUNT_NO/A - ACCOUNT_NO/A
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There are 101 records in the Customer Balances and Limits database (87 primary records + 14
unmatched primary records as discussed below).

There are 14 unmatched primary records. These are balances for customers that are not on the
Customer Master database. To identify these unmatched primary records, return to the Data
property and run the Direct Extraction task using @Isblank(ACCOUNT_NO1), where
ACCOUNT_NO1 is the account number field from the Customer Master database.

Equation
L) === o o= ez 2z o=x o+ - F 0 AND OR NOT  MOD EXP E
D sElank(ACCOUMNT_MNO1)

? ||@lsBlank(<str> String)
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There are 50 unmatched secondary records. These are customers for whom there have been no
transactions. These may be either new or dormant customers.

To identify the unmatched secondary records, run the Direct Extraction task on the Customer
Balances and Limits database using @IsBlank(ACCOUNT_NO), where ACCOUNT_NO is the
account number field from the Balance by Customer database.

Equation

“* () ===><<=>= < +-*/ AND OR NOT MOD Exp [ 9]

Blank{ACCOUNT_MO)
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Alternative Method to Identify the Unmatched Items

1. Ensure the Customer Balances and Limits database is active.

2.  Locate one instance of an unmatched item (i.e., record number 26) and select the
ACCOUNT_NO1 field that is "empty” (character fields are filled with spaces).

3. Right<lick over the field and click Display All Records Containing "".

Append Field...
Muodify Field...
Remowve Field(s)...

Field Manipulation...

Create Report...

Wiews »

Display All Records Containing

Show Field Stats...
Highlight Spaces

foom...
Define Action Field...

Save as Selected...

Close Database Ctrl+D
Close All Databases

Delete Database

All records satisfying the criterion will be displayed. To return to the whole database, right-click the
Criteria link in the Properties window and click Clear. Repeat the process for ACCOUNT_NO =",
using the first record.
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Credit Limits Exceeded - Extraction

Extract all customers where the credit limit has been exceeded.

1.

o M oD

Ensure the Customer Balances and Limits is the active database and the Data property is
selected.

From the Analysis tab, in the Extract group, click Direct.
In the File Name field, enter Credit limits exceeded.
Click the Equation Editor button.
Enter GROSS_AMT_SUM > CREDIT_LIM.

Equation

"to0) === 2 4 4z 2z s> o+ - 0 AND OR NOT MOD EXP E
GROSS_AMT_SUM = CREDIT_LIM

al
Once the equation has been entered, check the syntax and exit the Equation Editor by
clicking the Validate and Exit button.

In the Records to extract area, accept the default selection of the All option to extract the
records from the whole database, and then click OK.
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8.  View the resultant database, record the results, and view the Field Statistics.

Balances by CustomerIMD X Custorner Balances and Limits.|MD X m
o v T| O @ B W fx
Field Type Mumeric Statistics MNO_OF_RECS | GROSS5_AMT_...
(TR | ) et Value h 161,345,682
Time Absolute Value 78 161.34568
Numeric Fields H of Records 16 16
NO_OF_RECS H of Zero ttems 0 0
EETD_SSSU—;MT—SUM Postive Value 78 161,345,683
PST_SUM Megative Value 0 0.00
# of Positive Records 16 16
H of Negative Records 0 0
H of Data Emors 0 0
H of Valid Values 16 16
Average Value 488 10.084.11
Minimum Value 1 146.41
Maimum Yalue 12 4573681
Record # of Min 5 6
Record # of Max 9 16
Sample Std Dev 365 1237175
Sample Varance 1358 153,061,261 57
Pop Std Dev 357 11,978.94
Pop Varance 1273 143,454 532 72
Pop Skewness 0.506731 1.807357
Pop Kurtosis -0.547640 2524018
L4 >

e  There are 16 records totalling $161,345.68

e  Fourteen are unmatched primary records where there is no matching account
number in the Customer Master database.

e  Two customers, R025 and W025, have exceeded their credit limits.
9.  From the File tab click Close All Databases to close all databases.
Conclusion

Matching to the authorized customer list found 14 debtors not permitted to have credit and 2 in
excess of their limits.
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Audit Findings The following audit findings were reported to the client:

e  The profile of accounts showed most debt to be current with only $5,465 more
than 3 months old. Ten items represent 38% of the total debt.

e There are a significant number (see list) of credit items and several unallocated
payments received which need to be resolved.

e  Credit has been given to 14 customers without this being authorized and two
customers are over their credit limit.



Introduction

Section 3

Accounts Payable Audit and Fraud
Investigation

What are the risks associated with Accounts Payable that could be addressed by computer-
assisted audit procedures? And what tests can help address those risks? This section
summarizes the business and audit risks that arise in the context of Accounts Payable and the
potential tests that can be used to address those risks.

Potential Risks

The following table identifies the key risks, explains the business and audit implication of each
risk and the audit objectives that could be addressed by audit tests.

RISK IMPLICATIONS AUDIT
OBJECTIVES
1 Payments are made  Unauthorized suppliers could represent former  Existence,
to unauthorized suppliers that supplied goods or services of Validity
suppliers. unacceptable quality and should have been

removed from the list of suppliers; or they
could be fictitious suppliers set up by dishonest
personnel to receive automated payments.
Payments made to unauthorized suppliers
could therefore represent either error or fraud.

2 Payments are made  Payments made to individuals or employees Existence,
to individuals or could represent a diversion of company Validity
employees. payments, indicating fraud.

3 Unauthorized Unauthorized premiums may represent Existence,
premiums are given  overpayments to suppliers in return for Validity
to suppliers. kickbacks.

4 Invoices are paid Delays in processing Accounts Payable Cut-off,
late. approvals can result in a loss of available

! . . Completeness
discounts for timely remittances and P

understatement of liabilities in a particular
period.
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RISK IMPLICATIONS AUDIT
OBJECTIVES
5  Invoices are paid on  Irregular payments may reflect processing Existence,
irreqular dates. errors or fraud. Validity
6  Invoices are Duplicate payments can result from the failure  Existence,
processed twice. to cancel documents to prevent re-use or Validity
processing errors in Accounts Payable such as
restoring a backup file twice.
7 Payments are made  Perpetrators of fraud may arrange payments Existence,
in a way to be to avoid detection. For example, large Validity

undetected by
audits.

amounts may be split into several smaller
payments to coincide with a perpetrator’s
transaction approval limits or avoid limit checks
on large payments.

8 ltems (e.g., purchase
orders, checks) are
missing.

Potential Tests

Since Accounts Payable are often not
authorized for payment until there is a three-
way match of purchase order, receiving
document and supplier invoice, missing
documents could result in Accounts Payable
being understated.

Completeness

The following audit tests are suggested when auditing an Accounts Payable system. However the
exact tests carried out for a particular client will depend upon the system used and the data
available. Common tests include:

Mechanical Accuracy and Valuation

e Total the file. It often pays to separate debits and credits.

e Revalue foreign payables, if applicable.

e  Check transaction totals to the balance on each account.

Analysis

e  Stratify the size of payments and extract any exceptionally high payments.

e Analyze payment days and identify suppliers with favorable payment terms.

e |f the computer system captures the approving authority for a transaction,
examine the value distribution for each manager.
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Exception Tests - Existence and Validity

e Identify payments to unauthorized suppliers by matching the payments and
authorized suppliers list.

n o

e Search payments file for payees without “Inc”, “Ltd", or “Co" in their name to
identify payments to individuals.

e Test for large discounts.

e Test for duplicated invoices using value and supplier code as the key fields for one
test and purchase order number for another. The second processing of invoices
can be used to establish a value on the Profit/Loss (P/L) to make a fraudulent
payment. (This will also pick up accidental duplication.)

e |dentify payments made on Sundays or other days/dates that are not valid.

e  Examine to see if amounts are being approved at or just below break points in
authority level by a value distribution across the whole ledger. If approval
authority is not directly available, perform subsidiary analysis by types of supplier
or approving department (i.e., marketing).

e Look for split invoices to enable approval to be kept by an individual. Extract all
invoices within 90% of an approved limit (preferably for a suspected manager or
department) and search for all invoices from that supplier. Sort by approving
manager, department and date to identify possible split invoices or summarize
payments by invoice number to determine how many partial payments have been
made for each invoice.

e  Tests for total payments in year exceeding previous years by more than 25%.
e Test for large one-off payments to suppliers.

e Using the first five or six characters of the name, match supplier names against a
list of employee surnames from a payroll or personnel file.

e Test for duplicate sounding supplier names.

e Test for incomplete or unusual supplier details.
Gaps and Duplicates

e Test for missing items or gaps in the check number sequence.



94 | IDEA Version Ten Workbook

Case Scenario:
Accounts Payable

The Chief Financial Officer of Bright IDEAs Inc. is concerned that a particular member of the
Accounts Payable Department is living beyond his means and that the pattern of payments does not
correlate to that of previous years. He has asked Dynamic Accountants to perform a special review
of the Accounts Payable system to test for any irregularities.

Purchase/payments fraud is probably the most common type of fraud in an organization. It may be
the simple submission of a dummy invoice, the reuse of another valid invoice, withholding of a
credit note, or a more complex arrangement.

Many frauds involve the manipulation of the payments information on accounts within the Accounts
Payable ledger. Examples include the creation in the ledger of a fictitious supplier, or branch of a
genuine supplier, or reactivating a dormant account. Particularly vulnerable are miscellaneous
accounts, but the fraud perpetuated on a genuine supplier's account (with or without the supplier’s
collusion) must not be overlooked. The cost must be charged somewhere and there are often
general accounts that are more loosely controlled than others and accounts with high levels of
transactions (i.e., purchase of material) where a fictitious item can be buried.

Many purchasing systems now are complex with automatic re-ordering so that once a supplier has
been set up and/or a requisition input, payment will be processed automatically.

Staff may also be in collusion with suppliers to commit fraud by receiving gifts or kickbacks for
planning business, or by paying invoices on more favorable terms than other suppliers, or as per the
organization’s policy on payments. Also, ordering and payment authorization levels may be
exceeded by splitting invoices to payments below authorization thresholds.

IDEA can be used on a number of files: supplier master, purchase ledger, payments history or
purchase invoices. It depends on the system, the available data, and the nature of possible frauds as
to which test is best.
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Obtaining the Data The following data files will be used for this exercise:

e Accounts Payable History for the year Jan 1, 2015 - Dec 31, 2015

e  Supplier Master File

Note: When conducting fraud investigations it is important to obtain the data without alerting the
person(s) or departments under suspicion. Therefore, although our general advice is to always
request the data from the client and to avoid accessing the client’s computer system to obtain data,
it may be necessary to take a copy of the data files (or system) or to extract data yourself or with
the assistance of the software suppliers. Alternatively, if the data you wish to investigate is available
on a standard printout, arrange for the printout to be “printed” or spooled to file and use the
Report Reader module in IDEA to read the required data into IDEA for testing.

In this instance, the Accounts Payable system was an Oracle database system running under UNIX.
Assistance was available to determine what data was available and to write an SQL query to extract
the payments history in ASCII Delimited format, a simple format to import into IDEA.

The Authorized Suppliers information is available on a Microsoft Excel worksheet. Therefore, this is
also requested. The following data request was submitted:

Request for Data Files for Audit Purposes

Please supply the following data from the Accounts Payable system in ASCII Delimited format and
supplied on USB or CD using compression utilities, if necessary:

FIELD FORMAT

Supplier Number c8

Payee C20

Invoice Number c12
Invoice Date D YYYYMMDD

Amount N 8,2

Check Number N 8,2
Payment Date D YYYYMMDD

Payment Authorization Initials C5

Note: In the record definitions, C refers to Character, N to Numeric and D to Date. € 4 means a
character field of length 4. N 8,2 is an 8-digit number with 2 decimal places.
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Please supply the following Authorized Suppliers data as available in Microsoft Excel as
SUPPLIERS.XLS in electronic format:

FIELD FORMAT
Supplier Number c4
Supplier Name C30
Supplier Address 1 C25
Supplier Address 2 C25
Supplier Address 3 C25
Zip Code c8
Previous Year's Total Payments N 8,2

Data is required for the following period: Jan 1, 2015 - Dec 31, 2015.
Please supply a record layout for the ASCII Delimited file.
Please also supply the following control totals for reconciliation purposes:

e Total payments for the year 2015.
e Total discount for the year 2015.
e Number of payment transactions for the year 2015.

e Number of authorized suppliers.
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Audit Program From the available/possible tests, the audit manager decides on the appropriate tests and prepares
the following Audit Program for you to complete.

Audit Objective:

To identify payments which are suspicious or may be invalid.

AUDITING PROCEDURES ASSERTIONS WORK EXTENT OF
DONE BY TESTING
(INITIALS)
1 Obtain the data files from the client and load
onto the PC.

Load IDEA and create a Project for Accounts
Payable for Bright IDEAS Inc.

2 Import the data and agree the total of
Accounts Payable:

a) Import the Accounts Payable transactions,
b) Import the Authorized Suppliers details,

c) Compute field statistics to verify that the
data has been imported correctly, and

d) Select a control total field for each
database.

3 Analyze the profile of the number and value

of payments by numeric band to identify any

unusual trends and to determine high value
amounts for extractions.

4 Identify high and unusual amounts.

5 Identify further unusual payments as a result
of analyses including:

a) "CASH” in Payee name,
b) Round sum amounts,
¢) Payments authorized by HMV, and
d) Payments made on a Sunday.

6 Test for duplicate payments.

7 Test for completeness by testing for gaps in
the check number sequence.

8 Identify working days on which no payments
were processed.

9 Analyze payment terms and ensure that the
payment policy for Bright IDEAs Inc. has
been followed.

10 Test the validity of payments to authorized
suppliers.

11 Analyze payments by supplier to identify
significant changes from the previous year's
total.

Key to Assertions: Completeness, Existence, Ownership, Valuation, Presentation
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Investigation Set- Objective:
up To be able to load data, run IDEA and create a Project for the investigation audit within IDEA.
Exercise Description:

This exercise covers copying data into a folder, loading IDEA, creating a Project, and entering client
properties that will be printed on all reports.

IDEA Functionality Covered:

e Creating a Project

e  Entering Client Properties

The following data files have been provided on the CD supplied with this Workbook:

ACCPAY2015.TXT Accounts Payable History file

SUPPLIER.XLS Authorized Suppliers Microsoft Excel worksheet

Accessing IDEA
From the Windows Start screen, click the arrow in the bottom-left corner.

Alternatively, In the Apps view, scroll to the IDEA group and click IDEA.

Create a Project and Enter Project Information

To facilitate housekeeping, it is recommended that a separate Project be used for each audit/
investigation.

All information relating to the audit, including data files, equations, views/report definitions,
templates, etc. may be stored as part of the Project.

This exercise will explain how to create a Project and enter project information that will be printed
on all reports. Note that once a Project is set, it remains the active until changed.
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To create a Project, click the Home tab, and then from the Projects group click Create.

Home Data Analysis View Macros
Bk d R B

Project | Create pelect a;cpjye Properties Desktop |DEA
Overview [} - Server
Projects Import

File Ex <= n

Create a new project.

=

Create a Managed Project called Accounts Payable and then click OK:

Create Project

(®) Managed project
Project name: |ﬁccounts Payable]

() External project

Folder name: Help

&
‘i
o

Click OK. Accounts Payable becomes the active project, closing any previously active
projects.

From the Home tab, in the Projects group, click Properties to change the Project
properties.

Home Data Analysis View Macros
= B e R|EL

Project Create Select pipj,e Properties | Desktop [DEA
Chverview -
Projects l} Import

SJEMVET

Properties

File Explorer

View or change the properties

_._ for the current project
FREESE 8
—— |
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Import the
Accounts Payable
and Authorized
Suppliers Data Files

5. When the Project Properties dialog appears, enter the following:
e Report name: Accounts Payable Investigation

e Report period: Jan 1, 2015 - Dec 31, 2015
The project properties will be stored in a file called Client.inf in the Project Folder.
6. Copy the following data files that came with the Workbook:

e  ACCPAY2015.TXT - Accounts Payable History file
e SUPPLIER.XLS - Authorized Suppliers Microsoft Excel worksheet

to
C:\Users\[UserID]\My IDEA Documents\IDEA Projects\Accounts Payable\Source Files.ILB

This is the default location within a Project to store any source files.

Objective:

To import the data files for testing.

Exercise Description:

The Accounts Payable Transactions file, ACCPAY2015.TXT, is an ASCII Delimited format file that
must be defined and imported into IDEA. This can be carried out using the Import Assistant that

will determine the file type (if unknown).

The Authorized Suppliers data is provided as a Microsoft Excel worksheet. This will be imported
directly into IDEA.

IDEA Functionality Covered:

e Import an ASCII Delimited file

e Import a Microsoft Excel worksheet
Import the Accounts Payable Data

You have been provided with an ASCII Delimited file: ACCPAY2015.TXT
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Review the following record definition for ACCPAY2015.TXT.

FIELD NAME TYPE START LEN DEC DESCRIPTION
SUPPNO C 1 9 Supplier Number
PAYEE C 10 17 Payee
INVOICE C 27 12 Invoice Number
INV_DATE D 39 8 Invoice Date
AMOUNT N 47 15 2 Amount
CHECK N 71 6 0 Check Number
PAY_DATE D 77 8 Payment Date
AUTH C 85 7 Payment Authorization Initials

1. From the Home tab, in the Import group, click Desktop to access the Import Assistant.

Home Data Analysis View Macros SmartAnalyzer

Project Create Select ppchjye Properties | Desktop

Crwerview -
Projects [}lp-:rt Export
. Desktop
il
Fl |e E}{p | orer Convert data from a variety of
-~ — file formats and impart it into
EI?I |_¢B E__}: I m| the Desktop project.

Once loaded, the Import Assistant guides you through the process of importing the data.
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2.  Select Text and click the Browse button to navigate to and select the file
ACCPAY2015.TXT from the Source Files folder within the Project Folder.

Import Assistant

Select the format:

- Advanced Record Definition Editor
- AS400

- dBASE

- Microsoft Access

- Microsoft Excel

-~ QDBC

- Print Report and Adobe PDF
- SAP SmartExporter

- SAPAIS

- Text

- XML

Computer location: My Computer
File name: | EA Documents\IDEA Projects\Accounts Payable\Source Files.ILBY |...

Optional definition file:

Edit template

« Back Cancel Help

Note: When selecting a file, the Files of type box may need to be changed.
3. Click Open on the Select File dialog box.

4.  Click Next
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Once the data file has been selected, the Import Assistant will try to determine the data file
type. The following screen will be displayed. The Delimited format is correctly identified.
Click Next to proceed.

Import Assistant - File Type

The Import Assistant has examined the file and has determined that itis a delimited file.
If this is not correct, please select the correct file type.

(®) Delimited
() Fixed Length
(_)EBCDIC Fixed Length Options
......... 100 eateneeZ0ueetennndlenatoneadlenntene.500.u2... 60 A
1 W0O7Matt Cash Cod7 9-972015040983516. 7970121820150409 v
2  W007I M B Crookd7  2089.29J2015061114 432.1970139120150 &
3  M100M Cash IncUP-7 64092015100375000  70177420151008HMV
4  M100The Cash Co Inc 78456654220151101  59096.84701875201 5
5 W0OTF O R CRSHO97 3  EMP201511274580.6 870194520151127V S
& M100Crooks IncPITé £32015021021632.22 70104620150212H. M
7 [c202Matt CashS1726 201503066242.747 011172015030&HMV
8 M100CashonlyUY-937 1201504282792.72 70127020150501HV
9  WOOTCASH s COLD3S6 222015052225242.2  70134120150523HV
10 M100Cash IneCS - 7 17 -97201509157500 070172820150917V S
11 W007Crocks B Us97  2085.29J2015101771 409.7870182520151 0O
12 M100Co Cash IneT53 5220151019750007 0184920151022V.5.T
13 M025Luke Hair51493 20150210500&7.31 7010272015021 2HV <
£ >

< Back Cancel Help
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6.

The Import Assistant will try to determine the field separators and text encapsulators (if
any) for the file. Accept the defaults and click Next to proceed.

Import Assistant - Specify Field Separator and Text Encapsulator

Please inspect the file displayed in the preview and make changes, if required, in the options below.

Field Separator

Delimited files use a spedal character to separate fields. Please inspect the file below and, if
required, change the Field Separator selected.

() Comma

Text encapsulator: | © W

[IFirst vigible row is field names

LYu b N = IR T AR I

=
[ =]

woaov
Waa7
H100
M100
woaoT
H100

Pale]
el

K100
woao7
M100
woaoT

Matt Cash Co

I M A Crook

M Cash Inc

The Cash Co Inc
F O B CASH
Crooks Inc

2 Matt Cash

Cashonly
CASH & CO
Cash Inc
Croocks R Us

() Colon () Semicolon

(@ Tab () space

Header lines to ignore: | 0

879-97 20150409
97 2089.25%J 20150811
TE-T7640%5 20151003
784566542 20151101
97 3 FMP 20151127
BITGE3 20150210
5172 201503048
T¥-9371 20150428
LD35622 20150522

C5 - 717 -97 20150915
97 2085.29J 20151017

< Back

g8351a.
14432,
75000

59094,
4580.8
2143
a2d2.
2792,
20242,
75000

71409.

-
oo

r

]
P

|
[ I ST S L R s F I e )

=]
[KE)

Cance

() Other

701218
701351
701774
TO1E875
701945
701046
701117
TO01270
701341
701728

701825

[ T e T o T o T e T o}

[ T e T

L N T T T N T N S
(] ™

Help

£
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The Import Assistant - Field Details screen is used to define each field’s name and details
in turn, including identifying which fields or areas should not be included.

Import Assistant - Field Details

You can now spedify field details. Select a field by dicking on the column heading below, and then
modify its information below.

Field name: |CH.-5.R 1 Type: |Character )

Description:
[ ] oo not impart this field

Converted Example

| Woo7 »
CHAR] CHRRZ CHRER3 N4 HIOMS HUM& A

1 W007 Matt Cash Co 879-37 20150408 83516.79 7

2 WOO07 I M A Crook 97 208%.2%J 20150611 14432.19 7

3 M100M Cash Inc TE-76409 20151003 75000 7

i M100 The Cash Co Inc  T84566542 20151101 59096.84 7

5 WOO7 F O B CRASH 97 3 EMP 20151127 4580. 68 7

5 M100 Crooka Inc FITG83 20150210 21632.22 T

7 C202 Matt Cash 5172 201503048 6242.74 7

3 M100 Cashonly T¥-9371 20150425 27592.72 7

9 WO0O07T CASH & CO LD35622 20150522 25242.2 7
10 M104 Cash Inc C5 - 717 -97 20150815 75000 7 B

< >

< Back Cancel Help

FIELD NAME TYPE START LEN DEC DESCRIPTION
SUPPNO C 1 9 Supplier Number
PAYEE C 10 17 Payee
INVOICE C 27 12 Invoice Number
INV_DATE D 39 8 Invoice Date
AMOUNT N 47 15 2 Amount
CHECK N 71 6 0 Check Number
PAY_DATE D 77 8 Payment Date
AUTH C 85 7 Payment Authorization Initials

Note: In the above definition, € means Character, N means Numeric, and D means Date.
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8. Identify each field, checking your selections against the record layout as follows:
a. Select the field in the data area. The active column will be highlighted.

b. Define each Field name, Type, Number of decimals and optionally
Description, according to the record definition.

For the INV_DATE and PAY_DATE fields you must also supply a Date Mask.

The mask represents the actual format of the ASCII source data. You specify
the source data format using the letters Y, M, and D and type any spaces or
special characters to exactly mimic the source date format of YYYYMMDD.

c. For sixth field select the Do not import this field option.

Import Assistant - Field Details

You can now specify field details. Select a field by dicking on the column heading below, and then
modify its information below.

MUMS Murmeric
DO_MNOT_IMPORT 0
o notimport this fiel mplied decimals
[+] Do not impart this field Implied decimal

Converted Example

INVOICE INV_DATE| AMOUNT HUM& CHECK |PAY DRTE AUTH |~

1 379-97 20150409 §83516.79 701218 20150409V.5.T

2 97 2089.297 20150611 14432.19 701351 20150611 HV

3 UP-76409 20151003 73000 701774 20151008 HMV

= 724566542 20151101 59096.84 701875 20151101W.5.T

3 97 3 EMF 20151127 4380.4a8 701945 20151127 V3T

5] PIT76E3 20150210 21632.22 701048 20150212 H.M.V.

7 5172 20150306 6242.74 TO1117 20150306 HMV

8 TY-9371 20150428 27592.72 701270 20150501 HV

9 LD35622 20150522 25242.2 701341 20150523 HV

10 C5 - 717 -97 20150915 75000 701728 20150817 V5T R
£ >

< Back Cancel Help
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9.  Click Next to continue.

The Import Assistant - Create Fields dialog box will be displayed. Create Fields allows you
to add Virtual, Editable, or Multistate fields to the imported file. This can be done during
the import or at any time while using IDEA. For this exercise, no fields will be added.

Import Assistant - Create Fields

You can add one or more fields to the imported file by entering the field name, type, length,
parameter and description for the field(s) in the columns below.

Delete
Field Mame Type Len | Dec Parameter Descripl
N
2
£ >

< Back Cancel Help

10.  Click Next.

11.  The Import Assistant allows you to create an equation to specify the data that is imported.
For this exercise, click Next.

The final step is to specify the import options, save the record definition created using the
Import Assistant for re-use in future audits, and to specify the resultant file name.
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12.  Specify the import options:

Leave the option to Import the database (rather than linking to the database) as

a.
IDEA will run faster when a file is imported rather than linked.
b. Select Generate field statistics on import.
c. Save the record definition. Click the Browse button and accept the default
folder and definition name: C:\Documents and Settings\[UserID]\My
Documents\IDEA\Accounts Payable\Import Definitions.ILB\
ACCPAY2015.rdf.
3] Save As
T . <« Accounts Payable » Import Definitions.ILB v & Search Import Definitions.ILE @
Organize « MNew folder = - (7]
~ Name ’ Date modified Type 5i
18 This PC
& Desktop Mo items match your search,
| Documents
4 Downloads
o Music
= Pictures
& Videos
&, Local Disk (C:)
—a Data (E:)
€l Network v £ >
File name: | v
w

Save as type: | Record definition files (*.rdf)

= Hide Folders Cancel

d.

Click Save to continue (the definition will be saved with an .rdf file extension).
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13. Inthe Database name box, enter Accounts Payable, click Finish.
The data will be imported into the Project, opened, and displayed in the Database window.

Al [ S 2l s & CaseWare IDEA - Accounts PayableIMD - oIEW

Home Data Analysis View Macros SmartAnalyzer &2 )
Export=
@ 03 5 R E ; S

m Save As

Project Create Select picppe Properties  Desktop X i Select  Passport
Overview . = Send Using E-mail Server
Projects Impart Export IDEA Server CaseWare
. .
File Explorer ! SUPPNO PAYEE NWolcE_ | INDATE | AiounT | ~| " roperties !
G @ 1 | woo? Matt Cash Co | 879-97 4/9/2015 83,516.79 i w Database
8 S = 2 | Woo7 I M A Crook 972089.29) :6/11/2015 14,432.19
Desktop Project ER M Cash Inc UP-76409 0/3/205 75,000.00 + Data
Mame Records || 4 | M100 The Cash Co Inc  : 784566342 117172015 59,096.84 W History
@ Accounts Payable 999 Z WO0o7 F O R CASH a7 3PMP 11/27/2015 4,580.68 n Field Statistics
6 | M100 Crooks Inc PI7683 2/10/2015 21,632.22 #5 Control Total
Z c202 Matt Cash 51726 3/6/2015 6,242.74 &5 Criteria
2 | M100 Cashonly UY-9371 4/28/2015 2792.72
[ 9 | woo7 CASH & CO LD35622 5/22/2015 25,242.20 i v Results
(10 | M100 Cash Inc C5-T717-97 :9/15/2015 75,000.00
I WO0o7 Crooks R Us 972085.29)  :10/17/2015 71,400.78 fivilndices
12 | M100 Co Cash Inc T5352 10/19/2015 75,000.00
13 | Mo25 Luke Hair 51498 2/10/2015 50,067.31 ~ Moindex
[ 14 | caoz CASH INC 13597 2/16/2015 5,264.18 =
[ 15 | Woo7 Cash Inc AB3265M  3/19/2015 | 104,112.83 EiaCommenty
E WO007 The Matt Cash Co : 97/3972/U 8/7/2015 6,539.64 i Add comment
17 | C202 Only Cash BC 460004 W | 8/21/2013 5,885.73
[ 18 | woo7 Cash 'N' Co XQV 9712 9/28/2015 5,319.96
(19 | woo7 Mr Cash Co 23197 10/12/2015 75,000.00
20 | M100 Cash Back Inc CB3436 11/19/2015 2922.78
(21| ca02 FORCashOnly :MHY 1438 771872015 30,830.11
[ 22| cz02 P Crock JFM.1256 10/3/2015 78,794.00
(23 | m100 Matt Cash & Co  : In879-97 6/26/2015 190,071.38
[24 | ca02 Cash Co LD35610 10/5/2015 13,867.72
[25 | ca02 Cash FORUs Q0P 643 8/31/2015 49,033.14
[ 26 | PooE Nellie Dunn 000496CIW  : 1/10/2015 64,502.51
[ 27 | M014 Linda Hand GR13247 11172015 26,340.30
< > |28 |mza Maurice Mynah | IN-382817 171472015 11,649.19 ¢ o

Running Tasks Search Results

Managed Project: Accounts Payable Mot connected to IDEA Server Mumber of Records: 999 Disk Space: 828.67 GB

Differences Between Importing and Linking to a Data File

Each IDEA import or link results in an IDEA maser database, filename.imd, being created in the
Project Folder.

However, in both cases, a file (filename.imd) is created that stores all the information about the
database. Importing results in a copy of the data being included in the filename.imd file.

If the option to Link to the database is selected, the original data is not included in the
filename.imd file. The advantage of linking is that it can save disk space since the IMD file is smaller
than it would be if the source data had been copied. However, both the source data file and the
filename.imd file must be stored because IDEA must have access to the source data file to obtain
the data needed to perform analytical functions.

Testing will be faster on imported data files.

Housekeeping is simplified when a data is imported as there is only one file to
backup/restore/copy/move, and it is stored in the Project Folder.
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It is recommended that the Import option be used provided you have sufficient disk space.

Import the Authorized Suppliers Microsoft Excel Worksheet

The Authorized supplier’s information is provided as a Microsoft Excel worksheet: Supplier.xls.
IDEA will directly import a Microsoft Excel worksheet.

Note: IDEA imports multiple worksheets at one time, producing a separate IDEA database for each.

To import the Microsoft Excel file:

1. From the Home tab, in the Import group, click Desktop.

Home Data

Overview
Projects

File Explorer

& o o 1{

Project Create Select ppcpjye Properties

Analysis View Macros Srnart&nalyzer

-

[?l- + o Export~

T Em Save As
esktop
=% Send Using

I}, lmpgrt Export

Acg

K
2

FREESE M

Desktop

E-rail

Convert data from a variety of

IMWOHE

file formats and import it into 479-97

the Desktop project.

97 2089.4

2.  Select Microsoft Excel and click the Browse button to navigate to and select the file.
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3. Select C:\Users\[UserID]\Documents\My IDEA Documents\IDEA Projects\Accounts
Payable\Source Files.ILB\Supplier.xls. Click Open.

Select File

|
v O Search Source Files.ILB 2
= [ @

Date medified Type Si

5

T J <« Accounts Payable » Source Files.|LB

Organize » Mew folder

*  MName
& OneDrive A B ) _
6/9/2015 11:21 AM Microsoft Excel 97...

. Documents

B Supplierxls

. Pictures

1M This PC

m Desktop

| Documents

& Downloads

o Music

= Pictures

& Videos
iy Local Disk (C3)
o« Data (E:)

- v <

W | Microsoft Excel files (Fxlsx *xls w

File name: ||

4.  Click Next.

5. The Import Assistant will display a preview of the data and a list of any worksheets defined
within the file. Select the Address worksheet in the Select sheets to import box.
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6.

Select sheets to import:

Address

Microsoft Excel ®

First row is field names

Select the First row is field names option. In the Output file name box, delete the default
name and enter Authorized Supplier.

Input file name:

Qutput file name:

Click OK

[ ] tmport empty numeric cells as 0 EHEE s
Clear All
Cancel
Help
Preview:
SUPPMO SUPPMAME ADDRESST ADDRESS2 ADDRESE »
1 A28 hvan Aker 1491 AVE, OTTAWA ONTARIC
2 BOO& Denise Bent 43-191 67 AVE., : OTTAWA OMTARIC
3 BO1O Carter Bout 269 KEMSIGN.., : TORONTO OMTARIC
4 C202 Cash Inc 3124 TOWER. ... i OTTAWA OMTARIC
5 D014 Williarn Ditt 151 MAGMUS ... OTTAWA OMTARIC
B D025 Mellie Dunn G957 QUEEM 5T,  OTTAWA OMTARIC,,
£ >

ChUsershalisen.manningDocuments\ My IDEA Documents\IDEA Proje| ...

Authorized Supplier

Note: IDEA will name the new database with the prefix that has been supplied during the
import followed by the name of the worksheet. For this example, the new database will be
called Authorized Supplier- Address.
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The Authorized Supplier - Address database will be imported, opened, and selected as the
active database.

31 2 cis o & CaseWare IDEA - Authorized Supplier-AddressIMD - 0
Home Data Analysis View Macros SmartAnalyzrer & 1
L4 Export— =
&é % D'_I E‘\ [:- + |}" Sa:e As : r
Project Create Select ppcpjye Properties  Desktop n i i Select  Passport
Overview . Serve =% Send Using E-mail s Server
Projects Import Export IDEA Server CaseWare
. Accounts Payable.IMD X .
File Explorer ! SUPPNO | SUPPNAME ADDRESS1 ADDRESS2 | AL~ | Froperties !
] - 1 [A128 hvan Aker 149 1 AVE. OTTAWA Ok -
& s F m [ 2| Boo2 Denise Bent 43-191 67 AVE. OTTAWA O pote
_ B Carter Bout 869 KEMSIGNTON AVE. : TORONTO Ok ~ Data
MNarne Records | 4 | C202 Cash Inc 3124 TOWER ST. OTTAWA Oh W History
5§ Accounts Payable g E D014 William Ditt 151 MAGNUS AVE. OTTAWA Ol Field Statistics
Authorized Suppl... 43 | & | pozs Mellie Dunn 957 QUEEN ST. OTTAWA oh Control Total
7 | F123 Wanda Farr 599 23E AVE. OTTAWA  ON 5 Criteria
8 |F128 Fixes 533 DOMINIC ST. OTTAWA Ok
"9 [F130 Farmer 455 39 E AVE. OTTAWA Ok * Results
10| oo Polly Gunn 14158 ST. OTTAWA Ok
11| Go2o P Green 72-930 QUEEN ST, EDMONTON ALl | " w |ndices
12| HO14 Linda Hand 14011 AVE. OTTAWA Ok
13| Ho25 Luke Hair 19-956 MAIN ST. OTTAWA Ok ~ Mo index
14| Koot 0 Kay Yahs 635 50 AVE. OTTAWA oN | —
15| M4 Cary § Matic 6762 5 AVE. OTTAWA oh ||| Comments
E M020 Miles Long 556 24 5T. TORONTO Ok i Add comment
17 | MO25 A Meadow 73183 AVE. OTTAWA Ok
18| m1z3 1 Moore 336 KING ST. OTTAWA Ok
19| m128 Gus Main 45-333 12 5 AVE. OTTAWA Ok
20| m130 Maurice Mynah 332 RIVERSIDE DRIVE OTTAWA Ok
27| NDDT Moah Lott 26-216 89 AVE. OTTAWA Ok
22| NDDS K Nen 499 BASELINE RD. MONTREAL QU
23| P00 Phillippa Pail TT0 87 E AVE. OTTAWA Ok
24| po07 Mandy Pumps 605 FOUNTAIN ST. OTTAWA Ok
25| P00 Ern Payed 57-33 GARDEN RD. OTTAWA Ok
26| PODS Philip Upp Garages | 6-745 MAIN ST. TORONTO  Oh
27| P00 Ri Pent 13 -786 RIVERSIDE DRI | OTTAWA Ok
< > 28| rRo07 A Raid 17060 S AVE. OTTAWA Ol &
File Explorer L4

Running Tasks Search Results

Mot connected to IDEA Server

Managed ct: Accounts Payable
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Verify that the Data Objective:

Files Have Been
Correctly Imported Ensure that the data is complete and agrees to the supplied control totals.

Exercise Description:

View the Field Statistics for the numeric fields in the Accounts Payable and Authorized
Suppliers-Address databases.

The statistics will be used for:

e Agreeing totals
e  Getting a general understanding of the ranges of values in the database
e Testing the period of the file for completeness and cut-off

e Highlighting potential errors/areas of weakness to focus subsequent
investigations

IDEA Functionality Covered:

e  Field Statistics for both Numeric and Date fields

e Control Totals

Generate Field Statistics

1. Select the Accounts Payable database as the active database either by double-clicking on
the file name in the File Explorer or selecting the open file list from the drop-down icon on
the data sheet.

JLLIT AR ICR (el Authorized Supplier-Address.IMD X _ .
| SUPPNO |  SUPPNAME ADDRESS1 ADDRESS2 | ADL [ficcounts Payable.IMD

Ll Al28 Iwan Aker 149 1 AVE. OTTAWA ONT: 5 Authorized Supplier-Address.IMD

- Pan and e s

STTAArs T s
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2.  Click the Field Statistics link in the Properties window. Field Statistics will be displayed.
Note that the following totals are automatically provided for reconciliation purposes. Ensure
that your database totals agree.

Mumeric Statistics AMOUNT | CHECK

Nt Value m 700.797.628
Absolute Value 34.145,300.89 700,797 628
Hof Records 559 599
Hof Zero tems 2 0
Pogitive: Value 34,145 300.89 700,797 628
Megative Value 0.00 0
# of Positive Records 857 599
H of Megative Records 0 0
Hof Data Emors 0 0
# of Valid Values 339 339
Average Value 17548 701459513
Minimum Value 0.00 701,001

Mzzdmum Walue 193,487 22 702,001

Record # of Min 223 221

Record # of Max 386 655
Sample Std Dev 2520527 28830
Sample Varance 8h2 94783569 8311456
Pop 5td Dev 29,190.65 28815
Pop Varance 852 064 034.05 83.031.37
Pop Skewness 0.858581 0.002004
Pop Kurtosis 0616718 -1.478402
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3.  Click Date in the Field Type box and study the information. Note in particular the Earliest
Date and Latest Date statistics.

Date Statistics INY_DATE | FAY_DATE
b Hof Valid Values _ 999
Hof Zero tems 1] 0
# of Records 339 939
H of Data Emors 1] 0
Earliest Date 1/4/2015 11272015
Latest Date 12/6/2015 12/29/2015
Record # of Earliest 500 19
Record # of Latest 9332 655
Mast Common Day Friday Tuesday
Mast Common Morth Juby August
tems in January 100 2
ttems in Februany a7 10
ltems in March 76 52
ftems in April 83 74
ftems in May a7 a7
ttems in June 107 93
ftems in Juby 133 115
ftems in August 84 120
ftems in September 103 76
ftems in October 30 12
ftems in Movember 43 82
ltems in December 1 4
tems on Sunday 73 rr
ttems on Monday 233 91
ttems on Tuesday 132 252
ttems on Wednesday 25 G
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Field: AMOUNT
STATISTIC VALUE COMMENT
Net Value 34,145,300.89 Total payments
Average Value 34,179,48
Minimum Value 0.00
Maximum Value 193,487.22
# of Records 999
# of Zero Items 2 These are unexpected and should be
extracted and investigated.
# of Positive Records 997
# of Negative Records 0
Field: CHECK
STATISTIC VALUE COMMENT
# of Zero Items 0 No missing check numbers
Minimum Value 701,001 First check number in sequence
Maximum Value 702,001 Last check number in sequence
Field: INV_DATE
STATISTIC VALUE COMMENT
# of Zero Items 0 No missing invoice dates
Earliest Date 2015/01/04
Latest Date 2015/12/06

Field: PAY_DATE

STATISTIC VALUE COMMENT
# of Zero Items 0 No missing payment dates or
unpaid invoices in the
database
Earliest Date 2015/01/12
Latest Date 2015/12/29
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8.
9.

If your computer is attached to a printer, print the field statistics for the AMOUNT, CHECK,
INV_DATE, and PAY_DATE fields to keep for proof of reconciliation. Use the Print button
on the Field Statistics toolbar.

Click the Data link in the Properties window to return to viewing the data.

Select Authorized Suppliers-Address as the active database by double clicking on
Authorized Suppliers-Address in the File Explorer.

View the Field Statistics for the TOT_PREV_YR (previous year’s total) field in the Authorized
Suppliers-Address database. Note that the following totals have been provided with the
data file for reconciliation purposes. Ensure that your totals agree.

Field: TOT_PREV_YR

STATISTIC VALUE
Net Value 30,202,660.57
Average Value 629,222.10
Minimum Value 0.00
Maximum Value 1,397,587.06
# of Records 48
# of Zero Items 2
# of Positive Records 46
# of Negative Records 0

If you are attached to a printer, print the Field Statistics to keep for proof of reconciliation.

Click the Data view in the Properties window to return to viewing the data.
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Set the Control Amount for Each Data File

1. Ensure the Accounts Payable database is the active database and the Data property is
selected in the Properties window.

2.  Select the AMOUNT field as the control amount field for the database by clicking on the
Control Total link in the Properties window.

Properties i

i w Database

+* Data
History
Field Statistics
Control Total

Criteria

3. Select the AMOUNT field from the dialog box.
4. Click OK.

The control total amount of 34,145,300.89 should be displayed.

Properties *

i = Database

~ Data
History
Field Statistics

Control Total:
34,145,300.8% (AMOUNT)

Criteria

5. Select the Authorized Supplier-Address database as the active database.
6. Select the TOT_PREV_YR field as the control amount field.
7. Click OK.
A total of 30,202,660.57 should be displayed.
8.  Close the Authorized Supplier-Address database.
Conclusion

We have proved the footings for the client’s data files.
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Analyze the Profile Objective:

of Payments

Gain a profile of the number and value of payments by numeric bands to identify any unusual
trends and to determine the high-value amount for extractions.

Exercise Description:

In this exercise, you will stratify the payment amounts in suitable bands from the minimum to the
maximum payment amounts.

e Examine the resultant stratification report
e |dentify potential invoice and payment splitting below authorization levels
e  Chart the data and then print or save the chart

e Drilldown through any chart sector to display its composite payments

IDEA Functionality Covered:

e Plan for running a Stratification task

e  Enter the parameters for the Stratification task
e Chart the results view analysis

e Drilkdown on result and chart sectors

e  Print a chart

Stratify the Payment Amounts

1.

© N o o

Ensure Accounts Payable is the active database and the Data link is selected in the
Properties window.

View the Field Statistics for the AMOUNT field to determine the minimum and maximum
values of the population.

Click the Data link in the Properties window to return to viewing the data.

From the Analysis tab, in the Categorize group, click Stratification.

Home Data Analysis View Macros SmartAnalyzer

=1 Summarization 5 Aging

:\/) 2 Direct 2 Top Records = Gap Detection Cg Duplicate Key » 5 Join Ea Visual Connector
=1 Stratification 7 Pivot Table
Re-tun =s |ndexed = Key Value = Benford's Law [ Statistics ~ TChon Append Compare

Tasks Extract Explore Categorize Relate

In the Fields to stratify, select AMOUNT.
In the Fields to total on box, select AMOUNT.
Confirm the increment is set to $10,000 (this may be changed when required).

Click the first row of the spreadsheet area which will fill with 0 - 10000. Click and drag down
to row 10. The bands will automatically fill with the increment.



Section 3: Accounts Payable Audit and Fraud Investigation | 121

9.  Change the increment to $50,000 and complete the final 2 bands listed as below.

>= LOWER LIMIT < UPPER LIMIT COMMENTS

0 10,000

10,000 20,000

20,000 30,000

40,000 50,000

50,000 60,000

60,000 70,000

70,000 80,000

80,000 90,000

90,000 100,000

100,000 150,000 Note change to 50,000 bands

150,000 200,000
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10.

11.

Do not check the Create Database option.

Stratification
Group by: |don'tgroup v Increment: | 50,000.00 | III
Cut off
Field to stratify: == Lower Limit | < Upper Limit | ~
SUPPNO 1 000 10,000.00 =
PAYEE 2 |10,000.00 20,000.00 Insert
TNVOICE b i
INV_DATE 3 [20,000.00 30,000.00
15000000 100000
PAY_DATE 5 |40,000.00 50,000.00
AUTH 6 |50,000.00 60,000.00 help
7 | 60,000.00 70,000.00
Fields to total on: 8 |70,000.00 80,000.00
[w]amMouUNT 9 |(50,000.00 90,000.00
[JcHeck 10 |90,000.00 100,000.00
11 | 100,000.00 150,000.00
12 |150,000.00 200,000.00
13
14
15 W
Criteria: | |
[]create database Include stratum intervals
Create a virtual database Create result
File name: Stratification Result name: | Stratification

Click OK.
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12.  The results of the Stratification are displayed in a new Stratification Results output of the
Database window. Inspect the Stratification Results output for the AMOUNT field.

Accounts PayableMD X

(R S vERT
Totalled on: | AMOUNT v
St";it”m >= L Limit < U Limit # Records Hg’é{fds AMOUNT wgﬂm
1 0.00 10,000.00 280 | 23.03| 120065085 352
2 10,000.00 20,000.00 149 | 1491| 225716461 661
3 20,000.00 30,000.00 116 | 1161| 291238472 853
4 30,000.00 40,000.00 82| 821| 288102882 844
5 40,000.00 50,000.00 38 781| 352113778 103
6 50,000.00 60,000.00 2| 721| 391347947 1146
7 60.000.00 70,000.00 61  611| 392657942 1150
g 70,000.00 £0,000.00 84| 841| 636326083 1864
9 80.000.00 90,000.00 36 360| 306975559 899
10 90,000.00 100.000.00 38 3.80| 361221786 1058
1 100,000.00 150,000.00 1| 010 1411283 030
12 150,000.00 200,000.00 2| 020 33355860 112
Lower limit except... 0 0.00 0.00 0.00
Upper limit except... 0 0.00 0.00 0.00
Totals: 959 | 100.00 | 34.145300...| 100.00
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13.

To preview the Stratification report, click the Print Preview button on the Operations

toolbar. Close the Print Preview screen by clicking the Close button in the top right corner
to return to the Results output.

@

[y | |5 3[R Sk 100% - | =

Print Preview

@188

11

BOS @ (M=

]

‘Wednesday, January 20, 2016

CaseWare IDEA

Prepared by: Report nams: Accounts Payable Invesigalon
Inputfile name: Accounts Payable Period: Jan1, 2015-Dec 31,2015
Stratified on: AMOUNT Mumber of stratum: 12
Stratum # >=Lower Limit < Upper Limit #Records % AMOUNT %
1 0.00 10,000.00 280 28.03 1,200,650.88 3.52
2 10,000.00 20,000.00 143 14.91 2,257,164.81 6.61
3 20,000.00 30,000.00 118 11.81 2,912,35472 8.53
4 30,000.00 40,000.00 a2 g.21 2,881,028.82 .44
5 40,000.00 50,000.00 78 7.81 3,521,137.78 10.31
3 50,000.00 50,000.00 72 7.21 391347917  11.45
7 60,000.00 70,000.00 &1 a.11 382657942 1150
] 70,000.00 30,000.00 34 .41 5,363,250.83  13.54
9 30,000.00 90,000.00 36 3.80 3,089,755.59 3.99
10 50,000.00 100,000.00 38 3.80 361221768 10.58
11 100,000.00 150,000.00 1 0.10 104,112.83 0.30
12 150,000.00 200,000.00 2 0.20 383,558.60 1.12
Lower Limit Exceptions: 0 0.00 0.00 0.00
Upper Limit Exceptions: 0 0.00 0.00 0.00
Totals: 999 100.00 34,145,300.8%  100.00
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To see the Stratification results in a graphical format, click the View the result chart
button. You can use the graphing toolbar to adjust the graph properties including the type
of graph, the colors of the graph objects, as well as the graph labels and legends. The graph
can be displayed in 2-dimensions or 3-dimensions. Select 3D/2D to select the preferred view.
To return to the Results output, click the View the result chart button again.

(1] 5 E} -
Totalled on: | AMOUNT W
Y Awxis: | # Records W

DA E-FFod s EEDEA P

300

280 Ml strata

280 1; ==0.00 to = 10,000.00

240 2:==10,000.00 to = 20,000.00

220 3 »=20,000.00 to = 30,000.00

200 4: >=30,000.00 to < 40,000.00
o 180 5. == 40,000.00 to = 50,000.00
L 160
é . »=50,000.00 to < 60,000.00
£

140
7: == 60,000.00 to = 70,000.00

120
100 8: == 70,000.00 to = 50,000.00

w0 8: == 50,000.00 to = 50,000.00

a0 10: ==80,000.00 to < 100,000.00

4 11: == 100,000.00 to = 150,000.00

20 12: == 150,000.00 to < 200,000.00

ﬂ R —
LLE 1 2 3 4 5 5 7

Strata
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Field statistic information is available for each stratum in the result. To view the Field
Statistics for a particular strata, left-click on the strata to highlight it. Then select Display
Field Statistics.

BRI -F-De s PEEER

300
280
260
240
220
200
180

Extract Records
160

Display Records

140

# Records

Dizplay Field Statistics
120 -
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Numeric Statistics
P NetValue 281235472
Bbsolute Value 291235472
Numeric Fields # of Records 116 116
AMOUNT H of Zero tems 0 0
= Postive Value 291235472 81,373,955
Negative Value 0.00 0
# of Postive Records 16 16
# of Negative Records 0 0
# of Data Erors 0 0
# of Valid Values 16 16
Average Value 2510651 701.499 61
Minimum Value 20,110.83 701,013
Maimum Value 29,990.31 701,973
Record # of Min 27
Record # of Max 4
Sample Std Dev 297553
Sample Variance 8.853772.33
Pop Std Dev 2.962.68
Pop Variance 8.777.446.70
Pop Skewness 0048312
Pop Kurtosis 1248175
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You can also “drilldown” to see the detail records that comprise any Strata. Click any Strata
in the chart to highlight it, and then select Display Records.

L) Preview Database
SUPPMNO PAYEE INVOICE INV_DATE | AMOUNT | CHECK | PAY_DATE | AL~
1 [ MI00 Crooks Inc PI7083 271042015 21,3222 . 70046 : 271272015 H.I
2 | woo7 CASH & CO LD35622 5/22/2015 2524220 T341 : 572372015 HY
3 | mo1a Linda Hand GR13297 1/11/2015 26,340.30 701013 § 2/5/2015 HM
| 4 |Pooo P Green 566701T 11772015 29,990.31 701058 : 2/16/2015 BC
| 5 |Bo0s A Raid 3501050 1/29/2015 22,880.98 701103 : 2/28/2015 H.I
| 6 | D025 Denise Bent 81345 2/28/2015 21,668.00 ;. 701175 ; 3/24/2015 Vs
7 | Go2o Gus Main T5740VEB 2/28/2015 2727346 701193 : 3/24/2015 H.I
& | noot Mike Atsil AF3IST 3/13/2015 2320464 ¢ 701225 : 47772015 H.I
o |To10 Wanda Farr 10047 A 372172015 23,563.96 701232 : 4M16/2015 H
10 | To0S Ri Pent PPMN9EE12 3/30/2015 20,284.39 ¢ 701254 | 4/24/2015 HM
|11 | To03 Truckstop 97 2061.29) 6/5/2015 29,339,035 701442 : 673072015 Wl
12 | a128 A Meadow 117- 2358 6/22/2015 27,891.77 :  T01502 : 7/17/2015 Vi w
£ >
Print Done

Any of the above mentioned Results outputs can be printed by clicking the Print button in
the appropriate dialog box. Note that the results may also be saved as a new IDEA database.

Note: As we would expect there are a large number of low value payments, tapering off to
a small number of high value payments. However, there are an exceptionally high number
(and hence value) of payments in the $70,000 - $80,000 band.

As the Chief Financial Officer has informed you that the maximum payment value that can
be authorized without his approval is $80,000, this is likely to indicate that invoices and/or
payments are being split to circumvent this limit.

Payments in the $70,000 to $80,000 band will require further investigation, in addition to
the staff authorizing the purchases and payments.
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If you want to redo your Stratification task, perhaps to change some of the stratum ranges,
you do not have to start the Stratification task over again. As long as the Results output is
active and you have not done any other analysis on the database, you can re-run the last
result simply by clicking Re-Run Task on the Analysis tab. This will re-open the analysis
dialog box that created the current Results output. In this case, it will re-open the
Stratification dialog box with all of the previously used settings still in place.

Stratification
Group by: | don't group v Increment: | 50,000.00 QK
Field to stratify: *= Lower Limit < Upper Limit ~ —
SUPPNO 1 10,000.00 Fields
PAYEE oo
INVOICE 2 20,000.00 Insert
INV_DATE 3 30,000.00 T
4 40,000,00
CHECK Cancel
PAY_DATE 5 50,000.00
AUTH 6 60,000.00 Help
7 70,000.00
Fields to total on: 8 80,000.00
[]amounT 9 90,000.00
[Jcreck 10 100,000.00
11 150,000.00
12 200,000.00
13
14
15 ]
Criteria:
[]create database Indude stratum intervals
Create a virtual database Create result
File name: Stratification Result name: | Stratification1

14.  Return to the Results output by clicking the Cancel button.
Conclusion

There are a significant number of payments just below the $80,000 authorization level that require
investigation.
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Identify High and Objective:

Unusual Payments

e To identify all high value items for testing.

e To identify items which do not appear to match the profile for payments.

Exercise Description:

As a result of the Stratification analysis, we identified that there were an unusually high number of
payments between $70,000 - $80,000 and also that there were 3 payments greater than $100,000.
These will be extracted for investigation.

IDEA Functionality Covered:

e  Extract data with a specified criterion

e  Use the Equation Editor

Using the Accounts Payable database, extract all high and unusual payments as follows:

1.

Select the Accounts Payable database as the active database with the Data property
selected in the Properties window.

Select the Direct Extraction task by clicking on the relevant button on the Analysis tab.

Home Data Analysis View Macros SrartAnalyzer

-!v'j = Direct 2 Top Records = Gap Detection Ca Duplicate Key»  ° [ Summarization (] Aging
=1 Stratification .+ Pivot Table
Re-run  =: Indexed = Key Value = Benford's Law [2) Statistics | Chart

Tasks Extract Explore Categorize

The Direct Extraction dialog box appears.
In the File Name field, enter Unusual and High Payments.

Click the Equation Editor button.

The Equation Editor will appear and is used to enter the required equation:
AMOUNT >= 70000 .AND. AMOUNT < 80000 .OR. AMOUNT > 100000

Note:

e AMOUNT >= 70000 .AND. AMOUNT < 80000 will identify the unusually large
number of payments between $70,000 - $80,000.

e  AMOUNT > 100000 will identify high value payments.
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5. Once the equation has been entered, check the syntax by clicking the Validate button.

Equation
"L === r o2 2= »= o2 o+ - F 0 AND OR NOT  MOD EXP E

AMOUNT == 70000 AND, AMOUNT = 20000 .0R, AMOUMNT = 100000

6. Click the Validate and Exit button.

7. Inthe Records to extract area, accept the default selection for the All option to extract the
records from the whole database.

Direct Extraction
Records to extract: (@) Al Starting record #: 1
() Range Ending record #: 999 Create Fields
Create a virtual database Ficlds
Database order: | Mo index v Delete
File Name Criteria Cancel
1 Unusual and High Payments ﬁ |AMOUNT == 70000 AND. AMOUNT Help

2

8.  Click OK to run the extraction.
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Identify Exceptional
Transactions

There should be 87 records totaling $6,850,932.26.

Note: There are a number of large value, round sum payments to Supplier M100. Note the
different variants of the payee name, especially the occurrence of “Cash” within the name.

Many of the payments were authorized by HMV. However, on further investigation it is
determined that HMV may only authorize payments up to $20,000.

9.  Close the Unusual and High Payments database.

Objective:
To identify any unusual transactions.
Exercise Description:

As a result of the previous test, further investigation will be required and the following extractions
will be carried out:

e All payments with the PAYEE name containing “CASH"
e All round sum payments
e All payments authorized by HMV

e All payments made on a Sunday
In addition, a digital analysis of the amount field will be performed using the Benford’s Law task.
IDEA Functionality Covered:

e Performing multiple extractions with a single pass through the database
e Using a number of @Functions in equations

e  Finding help on the syntax of @Functions

e Using the Benford’s Law task

Payments with “CASH” in the Payee Name

1. Using the Accounts Payable database, from the Analysis tab, in the Extract group, click
Direct.

2. Change the file name to CASH in PAYEE name.

3. Click the Equation Editor button. @Functions may be accessed through the list of
@Functions. The required equation is built using the following @Functions:

@Isini(“text”, field) Used to search for text within a Character field. This
@Function is NOT case sensitive.

@Strip(field) Used to remove punctuation and spaces from the text
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4. The following equation will be used for the extraction:
@Isini(“CASH",@Strip(PAYEE)).
Note: This activity can also be done using the IDEA Search task.

When you select the required @Function, IDEA inserts the @Function name and brackets
(i.e., @Isini()) with the cursor inserted within the brackets.

5. Once you have entered the equation, check the syntax and exit the Equation Editor by
clicking the Validate and Exit button. Do not run the extraction yet.

Equation
") === or ow ez »z o=x o+ - 0 AND OR MNOT  MOD EXP E
Dlsini("CASH", @5trip(PAYEE))

Round Sum Payments

1. Click on the second extraction line in the Direct Extraction dialog box and note that a
default name is supplied for a second extraction.

2.  Change the file name to Round Sum Amounts.

3.  Click the Equation Editor button.

4.  Extract all round sum 1000s in the AMIOUNT field using the following equation:
AMOUNT % 1000 = 0.

Select the MOD button to insert the% symbol in the equation. This equation will result in
items where the remainder when dividing by 1000 is O (zero).

Note: % is used in IDEA, as with many other programming languages, as the modulus
symbol, not the percentage symbol.

5. Once the equation has been entered, check the syntax and exit by clicking the Validate and
Exit button. Again, do not run the extraction yet.
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Payments Authorized by Manager HMV

1.

5.

Click on the third extraction line in the dialog box and note that the default name is supplied
for a third extraction.

Change the file name to Authorized by HMV.

Click the Equation Editor button.

Extract all payments authorized by HMV using the following equation:
@Upper(@Strip(AUTH)) = “HMV".

Note:

e @Upper(field) converts the contents of a Character field to uppercase.

e  @Strip(field) removes spaces and punctuation from the field.

Once the equation has been entered, check the syntax and exit by clicking the Validate and
Exit button. Again, do not run the extractions yet.

Test for Payments Processed on a Sunday

1.

Click on the fourth extraction line in the dialog box and note that a default name is supplied
for a fourth extraction.

Change the file name to Sunday Payments.
Click the Equation Editor button.

Enter the equation using the Equation Editor. The following @Function will be used:

@Dow(date field) Used to return the day of the week where :
1 = Sunday

2 = Monday etc.
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The following equation will be used for the extraction: @Dow(PAY_DATE) = 1.

Once the equation has been entered, check the syntax and exit by clicking the Validate and

Exit button.

Direct Extraction

Records to extract: Starting record =:

[_'Range Ending record #:

Create a virtual database
Databasze order: Mo index

File Mame

1 | CASH in PAYEE name

ra

Round Sum Amounts

3 | Authorized by HMVY

=

Sunday Payments

:

999 Create Fields
Fields
W Delets
Criteria Cancel
@lsini{"CASH", @Strip(PAYEE)) Help

AMOUNT %2 1000 = 0

@Upper(@Strip(AUTH)) = "HMV"

@Dow(PAY_DATE) =1

Click OK to run all 4 extractions with a single pass through the database, potentially saving

considerable time on large databases.

View the resultant databases in turn, recording and checking your results against the

solution provided.
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Note that the CASH in PAYEE name database is the active database. Other databases must
be opened from the File Explorer.

Sis | CaseWare IDEA - CASH in PAYEE name.IMD - =
Home Data Analysis View Macros Smart&nalyzer = t
@ =% Direct =2 Top Records = Gap Detection Cg Duplicate Key = ST Summarization Aging it i
=1 Stratification [ Pivot Table
Re-run s |ndexed = Key Value [ Benford's Law [E) Statistics ~ Ll Chart Relate Sample Visualization
Tasks Extract Explore Categorize
. Accounts Payable IMD X R
File Explorer * SUPPNO PAYEE INVOICE | INV_DATE | AMounT [ o] | roperties "
0 F = F 0 [ 1| woo7 Matt Cash Co 279-97 4/9/2015 8351679 T01| i w Datshase
8 &> = 2 | mM100 M Cash Inc UP-76409 10432015 7500000 701
Deskiop Project (3 | M100 The Cash Colnc | 784566542 | 11/1/2015 59,096.84 1 01|+ Data
Hame Records [ 4 | w007 FORCASH 973 PMP 11/27/2015 458068 701 @& History
-7 Accounts Payable 99 || 5| caoz Matt Cash 51726 3/6/2015 624274 T01| i Field Statistics
57 Authorized b... 399 || 6| M100 Cashonly UY-9371 4/28/2015 279272: 701 G Control Total: 899,339.44
&7 (CASH in PAY... 20 | 7| woor CASH & CO LD33622 5/22/2015 25242200 701 (AMOUNT]
&3 Round Sum A... 7 8| m100 Cash Inc C5-T17-97 | 9/15/2015 7500000 TO| @ Criteria
57 Sunday Paym... 77 9| mi00 Co Cash Inc Ti352 10/19/2015 7500000 701| —
¥ Unusual and ... g7 [10]cao2 CASH INC 13597 2/16/2015 9264181 701| ! ¥ Results
-7 Authorized Suppl... ap || 11| woor Cash Inc AB3265M (37192015 | 10471283 701
12| woo? The Matt Cash Co | 97/3972/U | 8/7/2015 653064 T01| i ¥ Indices
13| c202 Only Cash BC 469904 W 8/21/2015 528573 701
14| woo7 Cash 'N' Co XQVoTi2 972872015 531906 701~ MNoindex
115 | woo7 Mr Cash Co 231497 10/12/2015 7500000 01|
— i w Comments
16| M100 Cash Back Inc CB3436 11/18/2015 292278 701
17| cone FORCash Only | MHY 1458 7/18/2015 0850011 01| % Add comment
18| M100 Matt Cash & Co | In879-97 6/26/2015 © 190,071.38 1 701
19| ca02 Cash Co LD33610 10452015 13,86772 1 701
< > |20 co2 Cash FORUs 00 P 643 8/31/2015 4903314 701

Running Tasks Search Results

Managed Project: Accounts Payable Mot connected to IDEA Server Number of Records: 20 Disk Space: £

EXTRACTION # OF AMOUNT COMMENT
RECORDS
CASH in PAYEE name 20 899,339.44 Many are authorized by
HMV and VST

Also note that the Payee
name is not consistent with
the Supplier Number

Round Sum Amounts 7 375,000.00 Includes zero-value checks

Authorized by HMV 399 13,826,403.35 Many greater than the
maximum authorization
limit of $20,000 for HMV

Sunday Payments 77 3,330,645.60 25 are authorized by HMV

7.  From the File tab click Close All Databases.
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Applying Benford’s Law to Identify Exceptional Items

What is Benford's Law?

Frank Benford was a physicist at GE Research Laboratories in the 1920's. He noted that the first
parts of the log table books were more worn than the back parts. The first pages contain logs of
numbers with low first digits. The first digit is the left-most digit in a number.

Benford collected data from 20 lists of numbers totaling 20,229 observations. He found that the
first digit of 1 occurred 31 percent of the time. Using integral calculus, he calculated the expected
digit frequencies that are now known as “Benford’s Law." It took Frank Benford six years to
perform his analysis and develop his law of expected digit frequencies.

The Benford’s Law task in IDEA can provide a valuable reasonableness test for large data sets.
IDEA only tests items with numbers over 10.00. Number sets with less than 4-digits tend to have
more skewed distributions and do not conform as well to Benford’s Law. Positive and negative
numbers are analyzed separately. This is due to the fact that abnormal behavior patterns for positive
numbers are very different from those for negative numbers.

To run a Benford’s Law analysis on the Accounts Payable database:

1. From the Analysis tab, in the Explore group, click Benford's Law.

Home Data Analysis View Macros SmartAnalyzer

-!v'i % Direct 2 Top Records = Gap Detection Ca Duplicate Key~  ~ L Summarization [ Aging
=1 Stratification . Pivot Table

| Chart

Tasks Extract Explare Categorize

Re-run =s ndexed = Key Value | Benford's Law |2 Statistics »
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2. Inthe Benford's Law dialog box, select the Amount field as the field to analyze. Accept the
other default options to Include Values that are positive, Show Boundaries, Mean
Absolute Distribution and perform all seven Analysis Types (First Digit, First Two Digits,
First Three Digits, Second Digit, Last Two Digits, Second Order and Summation). Uncheck the

Suspicious tick boxes.

Field to analyze:

Indude Values

(®) Positive

() Negative
Result
Create result

Analysis

AMOUNT

Options

Benford's Law

Show boundaries
Mean absolute deviation

Benford

Test:

Create database:

First digit:

Benford First Digit

Advanced...

Cancel

Help

First two digits:

First three digits:

Second digit:
Last two digits:

Second order:

Summation:

I
& & & E

W &

Benford First Two Digits
Benford First Three Digits
Benford Second Digit

Benford Last Two Digits

[ 5uspicious

|:| Suspicious

Benford Second Order

Benford Summation

Create a virtual database

3.  Click OK to perform the analyses.

[ suspicious
|:| Suspidous

The Benford results becomes active. Other databases must be opened from the File

Explorer window. Open the Benford First Digit.imd from the File Explorer.

4.  From the Analysis tab, in the Categorize group, click Chart to graph the data.

¥ field: |DIGITS

[ DIGITS

[ ] EXPECTED

|| LOWERBOUND
[ ] UPPERBOLIND
[v] acTuAL

¥ field(s):

[] DIFFERENCE
[] MAD_RESULT

¥ ands title: | Digit Sequence

¥ axis title: | Count

Result name: | Chart Data

Chart

Type:

Legend:

Chart title:

Criteria:

Bar

Do not show

3D chart

[ 5how arid lines

Mzke a snapshot of the data

:

W Cancel

Help

| AMOUNT - First Digit - Posiﬁve|
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In the Y field(s) list box, select ACTUAL.

In the X axis title field, enter Digit Sequence.

In the Y axis title field, enter Count.

In the Chart title field, enter AMOUNT - First Digit - Positive.

Click OK.
The Chart Data Results output becomes active.

The first digit graph shows a spike in the digit 7 results.

Filae T RN DR @ Benford First DigitIMD X

E,}'{v
2R @G- [Beds RETE] P

AMOUNT - First Digit - Positive[Snapshat)

200.00

180.00

160.00

140.00

120.00

100.00

Count

80.00

60.00

40.00

20.00

0.00

1.00 3.00 5.00 7.00 5.00
2.00 400 6.00 200
Digit Sequence
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Note: The First Digit test is the test of first digit proportions. The first digit of a number is
the left-most digit in the number. Zero can never be a first digit. This is a high level test.
Analysts will not usually spot anything unusual unless it is blatant. This is a test of goodness-
of-fit to see if the first digit actual proportions conform to Benford’s Law. The First Digit
test is an overall test of reasonableness. The upper and lower bounds are merely guidelines
for the auditor. The First Digit graph could show a high level of conformity but the data set
could still contain errors or biases.

10.  Click the Data link in the Properties window to return to the Benford's First Digit
database that was created as part of this analysis. The DIFFERENCE field shows the
difference between the expected occurrences of the digits and the actual occurrences of the
digits. When the DIFFERENCE field is indexed in descending order, the digit 7 results show
the largest positive difference (positive spike).

PN s LR S Eenford First Digit. MDD X

DIGITS | EXPECTED |LOWERBOUMD | UPPERBOUMD | ACTUAL |DIFFEREMCE -
1 i 57.82 43.48 6/.15 113 55.18
2] 3 78.94 63.19 89.70 106 27.06
3] -+ B6.75 56.78 76.71 90 23.25
4] 9 45.62 37.25 53.99 &1 15.38
5| 8 51.00 42,19 59.81 &3 12.00
6| 4 96.62 84.36 108.38 108 11.38
7| 3 12456 111.44 137.69 114 -10.56
8] 2 175.56 160.48 190.65 154 -21.56
E 1 300.13 282.00 318.25 188 -112.13

This result warrants further investigation as the Chief Financial Officer has indicated that any
items in excess of $80,000.00 require additional approval. This spike could be indicating an
abnormal level of items being processed just below the additional approval level.

11.  Close the Benford First Digit database.
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To view the Benford’s Law analysis result again, open the Accounts Payable database and select
Benford in the Results area of the Properties window. To view the First Two Digit graph, click on
the button on the Results toolbar. The 79, 76, and 75 two-digit combination spikes are clearly
visible in this graph.

Accounts PayableMD > RE=iislf«Nalea d T T 1) | D

1 123 |123 | 123 123 123 2-2 Z:.'z e ™

Mean Absolute Deviation: 0.00412 AMOUNT

Conclusion: Non-conformity First Two Digits - Positive Values

50

45

40

35

30

25

Count

20

1

o

1

(=]

[+]

1B A 273 ¥ 4 B BF 83 B9 75 A g7 831 99
Digit Sequence

= lpper Bound = Lower Bound = Expected Count . Actual Count

The First Two Digit test is a more focused test. The first two digit numbers are the left-most two
digits. There are 90 possible two-digit combinations ranging from 10 to 99. This test is performed to
find anomalies in the data that are not readily apparent from either the First Digit test or the
Second Digit test when viewed on their own. A spike occurs where the actual proportion exceeds
the expected proportion as predicted by Benford's Law. Positive spikes (above the Benford's curve)
represent excessive duplication. One of the objectives of this test is to look for spikes that conform
to internal thresholds, such as authorization limits.
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Look at the transactions that comprise the 79 two-digit combination by clicking on the graph and
selecting Display Records to drill down to the transactions. Notice the number of transactions just
under the $80,000 approval limit.

5 Preview Database
SUPPNO PAYEE INVOICE | INV_DATE | AMOUNT | CHECK | PAY_DATE | AUTH
1| caoz Cary S Matic 5 - 580 -07 | 3/24/2015 7921747 701241 | 4/18/2015 H.M.V,
|2 | mozs Luke Hair 51305 1/26/2015 79,500.00 ¢ 701073 | 2/19/2015 H.M.V.
3| F128 Ern Payed 22951 2/17/2015 78,826,530 T01148  3/15/2015  WIT
| 4| po07 Mellie Dunn 000511CIW § 2/28/2015 798872 : 701179 3/28/2015 i WIT
5 | Too4 Richmond INA1151/97 § 3/9/2015 79,839.54 701207 | 4/3/2015 WIT
6 | NoD1 Mike Atsil AZ3E2 4/24/2015 79,910.95 1 701346 | 5/19/2015 HY
' 7 | RoO7 Philip Upp Garage : 1421/21 7/3/2015 78,365.72 ¢ 701538  7/30/2015 HMY
& | M020 Linda Hand GRZ2397 7/6/2015 79,002.68 701572 | 81/2015 HMY
| 9 | RoDS Philip Upp Garage ;| 1464/21 10/18/2015 7973990 701910 11/14/2015  (BC
10| Ho25 lvan Aker WNZ28C | 1/4/2015 79,571.88 ¢ 701002 | 2/2/2015 BC
11| To0E Round Table BUR1335-G : 3/29/2015 79,830,85 ¢  T01260 | 4/27/2015 H.MV,
112 | Koo1 Jackie Tupp 917336 3/24/2015 79,990.86 0 701262 | 4/21/2015 H.M.V.
13| MODS Miles Long FR-102682  7/2/2015 78,306,510 701547  7/30/2015 HMY
14| mo14 Kurt N Upp 123513 7/18/2015 79,902,90 :  TO01628 | 815/2015 HMY
15| mo14 Kurt N Upp 123522 8/21/2015 79,765.18 1 701732 9A18/2015 L WIT
16 | BODS A Raid 3501101 8/9/2015 7,848.57 ¢ 701586 | 8/7/2015 WIT
117 | RO20 Polly Gunn L-1347/73  9/4/2015 7945830 0 701765 10/2/2015 WIT
118 | PoDg P Green 566698T 1/6/2015 79,237.49 0 701012 | 2/5/2015 BC
19| Zoo1 Miles Long FR-06039  :1/19/2015 79350 1 701084 | 2/17/2015 HMY
20| ToOS Ri Pent PPMOSE31T | 4/9/2015 79,086.25 ¢ 701300 | 5/8/2015 BC
21| ROO7 Peter Rabhbitt KG0385 9/18/2015 79,801.01 ¢ 701820 10/17/2015  BC
22| MoDS Miles Long FR-1073 140 : 10/27/2015 7096264 701943 11/27/2015  HMV
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Of the 22 transactions that make up the 79 two-digit combination, 17 are between 79,000 and
80,000. Each of the payables clerks authorized some of the 17 transactions, but HMV was
responsible for the bulk of these transactions having authorized 8 out of 17.

L Preview Database
SUPPMNO PAYEE INVOICE INV_DATE [AMOUNT - | CHECK | PAY_DATE | AUTH
1 | K001 Jackie Tupp 917356 3/24/2015 79,990.86 : 701262 : 4/21/2015 H.M.V.
| 2 | NoOT Mike Atsil A7 362 472472015 7991095 : 701346 : 5/19/2015 HV
R Kurt M Upp 123313 718,205 74,902.50 701628 | 8/15/2015 HMV
| 4 | ROO7 Peter Rabhitt KG0385 9/18/2015 79,901.01 701820 ; 10/17/2015 BC
| 5 | Toos Round Table BUR13535-G | 3/29/2015 74,8349.65 T01260 | 4/27/2015 H.M.V.
& | ToD4 Richmond INS1151/97  § 3/9/2015 79,839.54 1 T01207 : 4/3/2015 WIT
7| F122 Ern Payed 224951 2/17/2015 74,826.53 701148 § 3/15/2015 WIT
8 | M014 Kurt N Upp 123522 82172015 79,765.18 ¢ 701732 i 9/18/2015 WIT
9 | HoZ5 lwan Aker WMNZ28C 1/4/2015 79,571.88 707002 : 27272015 BC
10| Mo25 Luke Hair 51305 1/26/2015 79,500.00 : 701073 : 271972015 H.M.V.
11| Ro20 Pelly Gunn L-1347/73 94,2015 79,458.30 701765 { 10/2/2015 WIT
12| ROD7 Philip Upp Garage : 1421/21 732015 79,365.72 :  T01358 : 7/30/2015 HMV
13| NoDS Miles Long FR-1026 82 :7/2/2013 79,308.31 707547 | 7/30/2015 HMV
(14| Po0g P Green 566698T 1/6/2015 7923749 ¢ 701012 : 2/5/2015 BC
15| ca02 Cary 5 Matic C5- 589 -97 : 3/2472015 79,217.47 70241 : 4/18/2015 H.M.V.
16| ToDS Ri Pent PPM32831 4/9/2015 79,086.25 ¢ 701300 : 5/8/2015 BC
17| Mo20 Linda Hand GR223 97 7/6/2015 759,002.68 701572 : 8/1/2015 HMVY
(18| Po07 Mellie Dunn 000511CIW : 2/28/2015 7,.988.72 0 T01179 : 3/28/2015 WIT
19| RoDE Philip Upp Garage : 1464/21 10/18/2015 797399 701910 : 11/14/2015 BC
20| NODS Miles Long FR-1073 140 : 10/27/2015 796264 1 701943 1172772015 HMV
21| BODS A Raid 3501101 8/9,/2015 7.948.57 701586 : 8/7/2015 WIT
22| Zoo1 Miles Long FR-969 39 1/19/2015 795.59 ¢ 701064 : 2/17/2015 HMV

Of the 16 transactions that make up the 76 two-digit combination, 10 are between 76,000 and
77,000. Of these 10 transactions, HMV authorized 7 transactions.

Of the 15 transactions in the 75 two-digit combination, 13 are between 75,000 and 76,000. Like
before HMV authorized 6 of the 13 transactions. In addition, there are 5 transactions for exactly
75,000. Out of these 5 transactions, 4 were payments to companies with “Cash” in the payee
name. Each of these 4 transactions was paid within a few days of their invoice date, clearly a
violation of company policy.
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Open the Benford First Two Digits database that was created as part of the analysis. Index the
DIFFERENCE field in descending order. Notice the large positive differences (positive spikes) in the
first two digit combinations of 79, 76, and 75. These were the underlying cause of the spike in digit
7 results in the First Digit graph.

Accounts PayableMD X
DIGITS | EXPECTED | LOWERBOUND | UPPERBOUND | ACTUAL |DIFFEREMNCE +
1 70 5.45 2.37 8.53 22 16.35
2 76 5.66 2.52 4.80 16 10.34
3 75 5.74 2.58 4.80 13 9.26
4 60 7.6 3.66 10.66 14 6.84
5 50 8.57 477 12.38 13 6.43
6 36 11.86 743 16.30 18 6.14
7 47 912 5.20 13.04 13 5.88
8 51 241 4.63 12,18 14 5.59
g9 57 7.53 3.95 11.11 13 5.47
10 94 4.58 1.74 7.42 10 5.42
11 29 14.68 9.77 19.59 20 5.32
12 62 6.93 3.48 10.37 12 5.07
13 43 8.93 5.05 12.81 14 5.07
14 78 5.52 2.42 8.61 10 4.48
15 43 9.95 5.87 14.04 14 4.05
16 53 4.00 4.39 11.80 12 3.01
17 70 6.14 2.88 9.40 10 3.86
18 67 6.41 3.00 9.74 10 3.59
1, a7 4.44 1.64 7.24 8 3.56
20 49 4.75 4.90 12.59 12 3.25
21 74 5.81 2.64 4.99 9 3.19
22 29 4.84 1.92 1.75 8 3.16
23 as 4.89 1.96 7.82 8 in
24 ar 4.95 2.00 7.80 8 3.05
25 26 501 2.04 797 8 2.99
26 52 8.25 4.51 11.99 11 2.75
27 66 £.51 3.16 9.86 9 2.49

Because of the size of this data set, a number of transactions were identified for further
investigation using just the First Digit and First Two Digit analysis. In larger data sets, a finer filter
of transactions is necessary.



Section 3: Accounts Payable Audit and Fraud Investigation | 145

Note: Where there are 90 possible two-digit combinations, there are 900 possible three-digit
combinations from 100 to 999. The First Three Digits test is a highly focused test that will give the
analyst relatively smaller sections due to abnormal duplication and allow for a more narrowly
focused analysis. This test is also valuable to look for spikes just below internal and psychological
thresholds such as authorization limits. To make the most effective use of this test, the source data
set should normally exceed 10,000 records.

Open the Benford First Three Digits database that was created as part of the analysis. Index the
DIFFERENCE field in descending order.

Accounts PayablelMD =
DIGITS | EXPECTED LOWERBOUND UFPERBOUMD | ACTUAL |DIFFEREMNCE -
1 750 0.58 0.00 1.72 B 542
2 anr 0.54 0.00 1.64 5 4.46
3 TG 0.56 0.00 1.69 5 4.44
4 511 0.85 0.00 218 5 415
5 187 231 0.23 4359 G 3.69
i 962 0.45 0.00 1.48 4 3.55
T T 0.54 0.00 1.65 4 3.46
g 793 0.54 0.00 1.65 4 3.46
g 333 0.21 0.00 213 4 319
10 442 0.38 0.00 2.24 4 312
1 469 0492 0.00 2.31 4 3.08
12 37T 1.15 0.00 267 4 2.85
13 186 232 0.24 440 5 2,68
14 299 145 0.00 313 4 2.55
15 940 0.46 0.00 1.50 3 2.54
16 206 1.46 0.00 315 4 2.54
17 922 047 0.00 1.52 3 2.53
18 295 147 0.00 316 4 2.53
149 299 0.48 0.00 1.54 3 2.52
20 &N 0.51 0.00 1.60 3 249
21 795 0.54 0.00 1.66 3 2.46
22 278 1.55 0.00 3.30 4 245
23 TR 0.57 0.00 1.70 3 243
24 275 1.57 0.00 3.32 4 243
25 749 0.58 0.00 1.72 3 242
26 FEL 0.59 0.00 1.73 3 241
27 660 0.66 0.00 1.86 3 2.34

The 750 digit combination has the largest negative difference (positive spike).

From the File tab, click Close All Databases.
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Data-based
Conditions for
Benford’s Law

Geometrical Series

The mathematical pre-condition for the examination of a data supply based on Benford’s Law is that
the data supply is based on a geometrical series (thus, that it is presented as Benford Set). In reality
this condition is rarely met. Experience shows however, that data must only partially meet this
condition, i.e., the constant increase, percentage-wise of an element compared to the predecessor
must only be met partially. Otherwise, this would mean that no number may occur twice which is
quite improbable in the case of business data supplies, however, the pre-condition is that there is at
least a ‘geometrical tendency.’

Description of the Same Object
The data must describe the same phenomenon. Examples are:

e  The population of cities

e The surface of lakes

e The height of mountains

e The market value of companies quoted on the New York Stock Exchange

e  The daily sales volume of companies quoted on the New York Stock Exchange

e  The sales figures of companies
Unlimited Data Space (Non-Existence of Minima and Maxima)

The data must not be limited by artificial minima and maxima. A limitation to exclusively positive
numbers (excluding 0) is permissible as long as the figures to be analyzed do not move within a
certain, limited range. This applies, for example, to price data (e.g., the price of a case of beer will
generally always range between 15 and 20 dollars) or fluctuations in temperature between night
and day.

No Systematic Data Structure

The data must not consist of numbers following a pre-defined system, such as account numbers,
telephone numbers and social security numbers. Such numbers show numerical patterns that refer
to the intentions of the producer of the number system rather than to the actual object size,
represented by the number (e.g., a telephone number starting with a 9 does not mean that this
person possesses a bigger telephone).

Basically, data complies best with Benford’s Law if it meets the rules mentioned above, namely that
the data consists of large numbers with up to 4 digits and the analysis is based on a sufficiently
large data supply. A large data supply is necessary in order to come as close to the expected
numerical frequencies as possible. For example, the expected frequency of the digit 9 in any data
supply is 0.0457. If the data supply consists of only 100 numbers, the numbers which have a 9 as
their first digit may be 5% of the data supply. Thus, in the case of a small data supply, there may be
an over-proportional deviation from Benford’s Law. In large data supplies, the numerical distribution
is increasingly closer to the expected frequencies.

If the data supply has, or just roughly has, the characteristics mentioned above it can be
analyzed based on Benford’s Law. However, the results of the Benford analyses are not
interpretable on the basis of Benford's Law. As stated before, the expected frequencies
according to Benford's Law often represent, in the practical use, nothing more than a type of
benchmark for the observed frequencies. Since the observed frequencies will only be compared
with the legality discovered by Benford, not interpreted accordingly, it is not necessary that all
conditions mentioned above be met.
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In fact, the analysis results will help the auditor interpret the personal expectation of the auditor,
without including the reference value according to Benford in the argumentation. If, for example,
the personal expectation of the user is that the starting digit 4 must occur twice as often in the
analyzed data than the starting digit 2, the results of the analyzed values must not be compared
with the expected frequencies according to Benford but with the individual expectation of the user.

The application of Digital Analysis and the Benford Module is also permissible in the framework of
Data Mining when certain distinctive facts in a data supply are measured against the personal
expectations of the user and interpreted according to them. In this case it is not necessary for the
data that is to be analyzed, to create a Benford Set in a strict sense. In fact, it is permissible under
these circumstances to analyze the numerical distribution of the leading digits of each data quantity
and to interpret it independent of Benford's Law.

Test for Duplicate Objective:

Payments To test for duplicate payments.

Exercise Description:

The Chief Financial Officer, Mr. Cuthbert is concerned that there are many more payments to
certain suppliers compared to previous years. He is concerned that certain suppliers may be
paid more than once for invoices, or that invoices are being resubmitted. He has asked you to
test for duplicate payments.

IDEA Functionality Covered:

o  Select fields to test for duplicates
e Specify a key (or sequence order)
e  Test for duplicates

e Use Duplicate Key Detection task to check for supplier numbers with multiple
payee names

To test for duplicate transactions:
1. Open the Accounts Payable database.

2. From the Analysis tab, click Duplicate Key and then Detection.

Home Data Analysis View Macros SmartAnalyzer

@ 2 Direct 2 Top Records = Gap Detection [ Duplicate Key»  ~ L Summarization £ Aging
. = Stratification .+ Pivot Table
Re-run  =s |ndexed = Key Value # Benford's Law = Detection Lal
=) Exclusion Chart
Tasks Extract Exp Categorize

3. There are two options for duplicate testing: Output duplicate records or Output records
without duplicates. For this test, select Output duplicate records to get a database
containing any records that are duplicated.
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4.  Consider which field or fields should be tested for duplication (a maximum of 8 fields may be
selected). In this case, duplicate payments are likely to be identified by payments of the same
amount to the same supplier; therefore these fields will be specified in the key. Click the Key
button and select the following fields:

e  SUPPNO — Ascending
e  AMOUNT — Descending

Define Key

Base index on:

MEW IMDEX W
Field Direction
SUPPMO Ascending =
Cancel
Help

5.  Click OK in the Define Key dialog box.
6. Do not specify a criteria (i.e., only payments for a specified range of dates) for the test.

7. Enter the resultant File name as Duplicate Payments.

Duplicate Key Detection
(®) Output duplicate records
(") Output records without duplicates Key
Criteria: Fields
File name: | Duplicate Payments| Cancel
Create a virtual database Help

8.  Click OK in the Duplicate Key Detection dialog box to run the test.

9.  View the resultant database of duplicates payments.
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There are 5 duplicate records shown, including:
e 3 payments of $75,000 to supplier M100
e 2 payments of $145.50 to supplier PO07

Note: Although the supplier number and amount are the same, other information in the
record is different. These will all require follow-up to determine whether or not they are
genuine duplicates.

In particular, note the different invoice number patterns and that all payments to supplier
M100 are made within a few days of the invoice date.

Other possible tests include testing for:

e Duplicate supplier invoice numbers (i.e., test for the same supplier number and
invoice number)

e Duplicate purchase order numbers (unless this is validated in the system)
10.  Close the Duplicate Payments database.
To test for supplier numbers with multiple payee names:
1. 1. Open the Accounts Payable database.

2. 2. From the Analysis tab, click Duplicate Key and then Exclusion.

Home Data Analysis View Macros SmartAnalyzer

@ 2 Direct 2 Top Records = Gap Detection ey - I Summarization [ Aging
. =1 Stratification .7 Pivot Table
Re-run | 2 |ndexed = Key Value 7 Benford's Law | = Detection L
& Exclusion Chart
Tasks Extract Exgp I} Categorize

M| Fuzzy
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3. Inthe Duplicate Key Exclusion dialog box, enter the following settings:
e  Fields to match: SUPPNO
e Field that must be different: PAYEE

e  File name: Suppno Multiple Payees

Duplicate Key Exclusion

Fields to match:

[¥]5UPPNO
[ |PAYEE Fields
[ ]MvoIcE
[JINV_DATE s
[ ]AMOUNT
[ ]CHECK Help
[ |PaY_DATE
[ JAUTH

Field that must be different:
PAYEE v

Criteria:

File name: | Suppno Multiple Payees| |

Create a virtual database

4.  Click OK to perform the test.
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There are 120 records where the same supplier number has different payee names. These
records total $4,524,529.75.

5 (=5 =T CaseWare IDEA - Suppno Multiple Payees.IMD - B
Home Data Analysis View Macros SmartAnalyzer & U
O =% Direct =2 Top Records = Gap Detection g Duplicate Key ~ >t Summarization [E] Aging fi) =5
S1 Stratification (7 Pivot Table
Re-run = jndexed = Key Value [ Benford's Law [ Statistics - atl Chart Relate Sample Visualization
Tasks Extract Explore Categorize
. Accounts PayableMD X .
File Explorer # SUPPNO PAYEE INVOICE | INv_DATE | aMouNT [oreck ~ | [ roperties *
Ish. B! | 1 |Booe A Meadow N7-2413 1 11/13/2015 1981688 701990 | i w Dotabase
G Nwm L ows  Ame ]
aid 3501050 1/28/2015 20,8809 1 701103
Desktop Project [ 3 |come CASH INC 13597 2/16/2015 926481 701071 " Data
Hame [ 4 |canz Cary § Matic C5-583-97 |3/24/2015 79217471 71241 i History
557 Accounts Payable | 5 | cae Cash Co LD35610 10/5/2015 13,867.72 1 01792 i Field Statistics
7 Authorized by HMV | 6 | caoe CashFORUs 00PE43 83172015 4903394 1 70170 i Control Total
Benford First Digit | 7 | caoe FORCashOnly i MHY 1458 7/18/2015 30850111 T70152¢ 4,524,529.75 (AMOUNT)
Benford First Three Digits | 8 |cao2 Matt Cash 51726 3/6/2015 6242741 01T i Criteria
Benford First Two Digits 9 | cone Only Cash BC 469904 W | 8/21/2015 588573 TOIESC |-
Benford Last Two Digits 10 | caoe P Crook JRMI256  10/3/2015 | 7879409 701801 | 1Y Results
Benford Second Digit |11 | D014 Cary 5 Matic CS-T05-97 110/26/2015 @ 7000738 701947
Benford Second Order 12 | D014 Chimps Teaparty | 147865CTR 1/17/2015 3009705 TOIME | ¥ Indices
Benford Summation |13 | Dozs Chimps Teaparty : 147938CTR  © 10/18/2015  29,41530 . 70192:
CASH in PAYEE name | 14 | D025 Denise Bent 81344 2/10/2015 696.60 0 70112 " Noindex
Duplicate Payments |15 | F1z3 Denise Bent 81381 10/27/2015 | 43738700 70195 i SUPPNO/A + PAYEE/A
Round Sum Ameunts 16 |F123 Dick Tate 35214DUF 141772015 13,041.42 0 70103¢ |
Sunday Payments (17 |F123 Edward Zoff 99799ABC 1 1/17/2015 271316 Tor0s; | T Comments
Suppno Multiple Payees 18 | F128 Edward Zoff 998424BC [ 10/22/2015 | 4013553} 701932 4 Add comment
57 Unusual and High Payments | 19 |F128 Em Payed 821191 5/12/2015 62232 0137
57 Authorized Supplier-Address [ 20 | F130 1 Moore INB46OOT 5772015 28468 70120
21 |F130 A Meadow 1M7-2287 1 1/10/2015 34250551 70101
|22 |F130 Em Payed 821851 9/18/2015 5537570 70180
23 |F130 Farmer 14641 4/17/2015 13,206.82 1 01310
| 24 | Goto Farmer 14688 8/12/2015 1460093 TOITIE
| 25 | Go1o Fixes STI4T2BUZ  © 1/26/2015 673230 0113
| 26 | Go2o Fixes STIS62BUZ 117142015 90,287.15 1 T0195¢
a > [ 27| Go0 Gus Main T5727VE 1/26/2015 524115 701067,

Running Tasks Search Results

This task indicates that there is a weakness in the company’s internal controls involving the
maintenance of supplier information.

Close the Suppno Multiple Payees database.
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Searching for Gaps Objective:
in the Check

Test for completeness.
Number Sequence P

Exercise Description:

An auditor looking at the Bank Reconciliation is concerned that not all the checks have been
recorded on the system. Test for missing check numbers in the sequence.

The Gap Detection task is used to test for missing items in a numeric list.
IDEA Functionality Covered:

e Rules for testing for missing items
e Gap Detection task
e Where to view the results

e How to export or print results

1. Ensure the Accounts Payable database is the active database and the Data property is
selected in the Properties window.

The field CHECK contains the check number.

2. Itis possible to test for gaps in Numeric or Date fields or in a numeric sequence within a
Character field. To view the format of the database, double-click over the Database
window to display the Field Manipulation dialog box.

3. View the format of the CHECK field and note that its type is Numeric. Close the Field
Manipulation dialog box by clicking Cancel.

4.  From the Operations toolbar, click the Gap Detection button.

Home Data Analysis View Macros SmartAnalyzer

@ 2 Direct =2 Top Records | = Gap Detection |Ca Duplicate Key~  ° £ Summarization £ Aging
=1 Stratification .7 Pivot Table
Re-run = Indexed = Key Value - Benford's Law [ Statistics ~ | Chart

Tasks Extract Explore Categorize
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From the Field to use drop-down list, select CHECK to test for gaps.

Gap Detection
Field to use: | CHECK w|  Criteria:
Cancel

Murneric

— . = Help

(o) Al Starting key value: | 701,001 |

(_)Range Ending key value: | 702,001 |

Gap increment: | 1 |

Output
[]create database Create result
File name: Gap Detection Result name: | Gap Detection

Note that it is possible, but do not specify a Criteria for the test (i.e., only checks issued for
a date range).

Test the whole range of check numbers by accepting the default selection of the All option.

Note: The value in the Starting key value and Ending key value boxes are provided from the
minimum and maximum values held in the Field Statistics.

Accept the Gap Increment of 1 but note that this could be changed if required.

Click OK.
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9.

10.

The Gap Detection Results output of the Database window becomes active and displays
the results. To view missing checks, click on the + sign located on the left side of the check

sequence.
= bk~
From: CHECK To: CHECK Number

= | 701,805 701,805 1
701,805

— | 701,997 702,000 4
701,557
701,558
701,955
702,000

Total number of tems detected |5

Tatal number of gaps detected |2

There are 2 gaps in the sequence. However there are 5 missing checks as can be seen from
the inclusive ranges, i.e., 701805, 701997, 701998, 701999, 702000.

The results are saved with the database in its .IMD file.

The results may be printed by clicking on the Print button on the Operations toolbar (or
through the Print Preview task) or exported to a specified destination and format.
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From the Operations toolbar, click the Print Preview button to view the report.

@ Print Preview - B
& B aaw: -SEBEE- @B v BO® S0 E
Wednesday, January 20, 2016 CaseWare IDEA
Prepared by: Reportname: Accounts Payable Invesigalon
Inputfile name: Accounts Payable Period: Jan 1, 2015- Dec 31,2015
Figld nams: CHECK Field description:  Check Mumber
From To Missing Number
701,508 701,508 1
701,805
701,997 702,000 4
701,887
701,898
701,999
702,000
Number of Missing ltems: 5
Number of Gaps: 2
v
< >

Close the Print Preview window by clicking the “X" in the top right corner.
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13.  Click the Export button. Notice the numerous format options and destinations available.

Name the result Accounts Payable and save it as a Microsoft Excel file in the Project

Folder (C:\Users\[UserID]\Documents\My IDEA Documents\IDEA Projects\Accounts

Payable\Results.ILB)

) Export ...
T  « Accounts Payable » ResultsILB ) Search Results.ILB 2
Organize » Mew folder SEEl (7]
~ MName Date modified Type Si
1M This PC
m Desktop No items match your search.
| Documents
&4 Downloads
J Music
= Pictures
g Videos
& Lecal Disk (C)
ca Data (E)
G‘ﬂ Network v < >
File name: v
Save as type: | Adebe Acrobat (*.PDF) v

4 Hide Folders Cancel

14.  Return to viewing the database by clicking the Data link in the Properties window.



Searching for Gaps
in the Check Date
Sequence

Objective:
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Test for days on which there have been no payments.

Exercise Description:

The auditors have been informed that a check payment run is processed each day. Therefore, a test
should be performed to identify days on which no payments are made.

The Gap Detection task is used to test for missing items in a date range.

IDEA Functionality Covered:

Gap Detection task

Entering holiday dates for exclusion

Where to view the results

How to export or print results

1. Ensure the Accounts Payable database is the active database and the Data property is
selected in the Properties window.

The field PAY_DATE contains the check payment date.

2. From the Operations toolbar, click the Gap Detection button.

9

Re-run

Tasks

Data Analysis View Macros SrartAnalyzer
. . . = izati B i
2 Direct 2 Top Records | = Gap Detection| Ca Duplicate Key = Summarization Aging
= Stratification [ Pivot Table
= Indexed = Key Value = Benford's Law [ Statistics ~ | Chart
Extract Explore Categorize

3. Select the PAY_DATE field to test for gaps.

4.  Select the Ignore weekends option.
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5.  Select the Ignore Holidays option.

Gap Detection
Field to use: | PAY_DATE v|  Criteria:
Cancel

Date

Pa—_— Hel
() All Starting date value: | 2015/01/12 Ignore weekends =
(_JRange Ending date value: | 2015/12/29 Ignore holidays Set Holidays...

Qutput
[ ] create database Create result
File name: Gap Detection Result name: | Gap Detectionl

6.  Set the holiday dates to be ignored by clicking the Set Holidays button.

Set Holidays
X T+ OK
01/01
12/25 Cancel
Help

7. Toadd a new date, click the New button on the toolbar followed by the Browse button to
access the calendar control. Navigate to and select the required holiday dates to add to the
list.

The following dates are suggested:
e January 1, 2015
e December 25, 2015

However, please enter additional dates or modify these dates if preferred.

8.  Click OK to return to the Gap Detection dialog box.
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9.  In the Result name box, enter Pay Date Gaps.

Gap Detection
Field to use: | PAY_DATE v|  Criteria:
Cancel
Date
Help
() Al Ignore weekends
(_)Range Ending date value: | 2015/12/25 Ignore holidays Set Holidays...
Qutput
[]create database Create result
File name: Gap Detection Result name: | Pay Date Gaps|

10.  Note that it is possible, but do not specify Criteria for the test (i.e., only checks issued for a
date range).

11.  Test the whole range of check payment dates by accepting the default All.

Note: The values in the Starting date value and Ending date value boxes are provided
from the Earliest date and Latest date held in the field statistics.
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12.  Click OK.
The Gap Detection Results output of the Database window becomes active and displays
the results.
Accounts PayablelMD X
=R AR
Fram: PAY_DATE To: PAY_DATE Mumber "
+ 1132015 11472015 2
+ 1M6/2015 13002015 1
+ | 20412015 21472015 1
+ 21172015 21112015 1
+ | 2132015 2/13/2015 1
+ | 2M812015 21182015 1
+ | 212002015 212012015 1
+ | 212572015 21252015 1
+ 212712015 212712015 1
+ | 322015 3212015 1
+ | 3412015 3472015 1
+ | 31172015 31172015 1
+ | 3162015 3162015 1
+ | 31812015 3M&R2015 1
+ | 33072015 31302015 1
+ 4172015 41172015 1
+ 4132015 41132015 1
+ 41572015 41152015 1
+ | 42002015 4720/2015 1
+ 42212015 472212015 1
+ | 412912015 41292015 1
+ 5412015 51472015 1
+ 562015 5/6/2015 1
+ 1 5M172015 5M172015 1
+ | 5M32015 5M32015 1
+ | 5M82015 SM8R”0M5 1
+ | 52012015 52012015 1 o
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13.  Save the result as a .PDF file by clicking the Export button and name the file Date Gap.

Export ...

3]
T | « Accounts Payable » ResultsILB v & Search Results.ILB »
Organize » Mew folder 1= -
2 Name Date modified Type 5i
1% This PC
jm Desktop No items match your search,
| Documents
& Downloads
W Music
= Pictures
& Videos
i, Local Disk (C:)
cw Data (E)
€ Network v < >
File name: v|
Save as type: |Adobe Acrobat (*.PDF) v |
{~ Hide Folders Save | | Cancel |
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14.
15.

The Date Gap.PDF file can be viewed, printed, or e-mailed. The Date Gap.PDF file can be
opened through the Windows File Explorer and looks like the following example.

. Date Gap.pdf - Adobe Acrobat Reader DC = =
File Edit View Window Help
Home Tools Date Gap.pdf @ E Sign In
® B8 HEQ ® A M O® e - R BEAT S
a
Wednesday, January 20,2016 CaseWare IDEA
Pay Date Gaps
Prepared by Report name Accounts Payable Investigation
Input file name: Accounts Payable Period: Jan 1, 2015 - Dec 31, 2015
Field name PAY_DATE Field description: Paymert Date
From To Missing Number
11w2ms 1142015 2
112015 143072015 11
20425 2042015 1
4 21102015 201172015 1 1
21w204 21325 1
21e20s 21872015 1
22002015 22002015 1
w2004 2257215 1
227205 A5 1
IAWIMA A5 1
I4zM5 34215 1
AR} ANI2015 1
AME205 362015 1
Itwms 382015 1
el prni B} 307215 1
4Mizm s 41715 1
4132015 4132015 1 b

Note that there are 62 gaps in the sequence. However there are 85 days on which no
payments have been made.

The results are saved with the database in its .IMD file.

The results may be printed either by clicking the Print button on the Operations toolbar or
through the Print Preview option.

Click the Print Preview button on the Operations toolbar and view the report.

Close the Print Preview window and return to the database by clicking the Data link in the
Properties window.
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Days to Identify
Favorable Terms

to Suppliers
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Objective:

To analyze payment terms and ensure that Bright IDEAs Inc.’s policy on payment is being strictly
adhered to.

Exercise Description:

It is suspected that certain suppliers are rewarding staff for prompt payment of invoices. The
number of days between payment and invoice will be calculated and then analyzed.

IDEA Functionality Covered:

e Appending a Virtual (or Calculated) field:
e Using the @Age function to calculate the number of days between dates
e Using the @Between function to test for a number between a range

e Indexing a database

Calculate the Number of Days for Payment

1. Ensure the Accounts Payable database is the active database and the Data property is
selected in the Properties window.

2. Doublelick over the Database window to load the Field Manipulation dialog box.

3. Click the Append button to add the following Virtual field:
e Field Name: PAY_DAYS
e Field Type: Virtual Numeric
e Field Length: Do not enter
e Decimals: 0

e Description: Number of days to pay invoice

4. Click in the Parameter cell to load the Equation Editor and enter the following equation:
@Age(PAY_DATE , INV_DATE).
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Note: @Age(Date1,Date2) calculates the number of days between the specified dates
(fields or date constants). Enter the later date first to report a positive number of days as a
difference.

Equation
e . I::] = == » < == == => + - * / AND OFR MWOT MOD EXP E
Dhge(PAY_DATE, INV_DATE)

? ||@Age(<date> Date, <date> Date)

5.  Click the Validate and Exit button, returning to the Field Manipulation dialog box.

Field Manipulation

Field Name Type Len | Dec Parameter Description A

2 |PAYEE Character 7 Payee

- Append
3 | INVOICE Character 12 Invoice Number
4 |INV_DATE Date 8 YYYMMDD Invoice Date Delete
5 AMOUNT MNumeric 8 2 Amount Print
6 | CHECK MNumeric 8 0 Check Number
7 |PAY_DATE Date 8 YYYYMMDD Payment Date Copy
8 AUTH Character 6 Payment Authorization Initials Cancel
9 | PAY DAYS Virtual Mumeric ] @Age(PAY DATE, INV D..J Mumber of days to pay invoice =

elp

6. Click OK to append the Virtual field.
7.  Click Yes to continue.

8.  View the results in the new PAY_DAYS field. It will be the rightmost column in the
database.

Note the color of this field (Teal if the defaults have not been changed) indicates that the
field is a calculated field and not an original imported field.
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9.  Click the Field Statistics link in the Properties window to view the statistics for the
PAY_DAYS field. When prompted, calculate the statistics for all fields.

CaseWare IDEA

Statistics are not available for all fields, Do you wish to create statistics
for all fields without statistics?

Note: The Company'’s policy is to pay all suppliers within 25 - 35 days of receipt of the
invoice.
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e The minimum number of days is -6, and there are 6 negative records, i.e.,
payments made before the stated invoice date!

e There are 6 payments with value 0, i.e., orders being paid on the invoice date.
e The maximum is 59 days, well over the standard terms.

e The average is 27 days showing most invoices are paid within policy.

Accounts PayableMD X

el Do S |0 ® BEG

Field Type Numeric Statistics PAY_DAYS

Numeric F MNet Value

Date

Time Absolute Value 27.004

Numeric Fields # of Records 995

] AMOUNT #of Zero tems &

Fostve VeLe S
Megative Value -19
# of Posttive Records 987
# of Megative Reconds 6
# of Data Emors
#of Walid Values 995
Average Value 2659
Minimum Value £
Mazdmum Value 59
Record # of Min 115
Record # of Max 845
Sample Std Dev 5593
Sample Varance 35.14
Fop Std Dev 592
Pop Varance 35.10
Pop Skewness -2.030312
Pop Kurtosis 14.674867

10.  Return to the database by clicking the Data link in the Properties window.



Section 3: Accounts Payable Audit and Fraud Investigation | 167

Extract all Payments Outside the Policy Range

Extract all payments made outside the company’s stated policy of 25 - 35 days.

1. From the Analysis tab, in the Extract group, click Direct.

Home Data Analysis View Macras SmartAnalyzer

-!v'} % Direct 2 Top Records = Gap Detection Ca Duplicate Key»  ~ [ Summarization [ Aging

=1 Stratification 7 Pivot Table
Re-run =i Indexed = Key Value ] Benford's Law [ Statistics ~ | Chart
Tasks Extract Explore Categorize

2. In the File name field, enter Payment days outside policy range.

3.  Click the Equation Editor button.

The Equation Editor appears and is used to enter the required equation.

4.  Enter the expression .NOT. @Between(PAY_DAYS,25,35).
Note:

o @Between(VALUE,MIN,MAX) - tests for VALUE between (and including) MIN
and MAX.

e .NOT. - reverses an expression, items where VALUE is not between MIN and
MAX.

5. Once the equation has been entered, check the syntax and exit the Equation Editor by
clicking the Validate and Exit button.

6. Inthe Records to extract area, accept the default selection of the All option to extract the
records from the whole database.

7.  Click OK to run the extraction.
8.  Doublelick on the PAY_DAYS field name to sequence in ascending order. Double-click

again to index in descending order. The index order will be displayed in the Indices area on
the Properties window. Alternatively, from the Data tab, in the Order group, click Index.

Home Data Analysis View Macros SrnartAnalyzer

=
! I 8 o © q Tm Y & B
Copy Index | Sort Describe Append Modify Remove  fng Define Find Find Go  Search
Sorted Order - Action Field - Next  To

Clipboard Crder Fields Pl Search
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9.  Specify the index order as PAY_DAYS /Descending.

Index

Create Indices | Delete Indices] Re-Index Indices]

Base index on:

MEW INDEX W
Field Direction oK
PAY_DAYS | Descending w|
Cancel
Delete Key
Help

e  There are 85 payments totaling $3,010,687.40.
e There are 68 payments made before 25 days.

e There are 17 payments delayed more than 35 days.
10.  Close the Payment days outside policy range database.

Conclusion

A number of early payments have been authorized by HMV and VST to suppliers M100, C202 and
WO007. The relationship between authorizers HMV and VST and these suppliers should be

investigated. Late payments may also be investigated.



Payments to
Unauthorized
Suppliers

Section 3: Accounts Payable Audit and Fraud Investiga

Objective:

To test the validity of payments to authorized suppliers.

Exercise Description:

It is suspected that there are payments to unauthorized suppliers.

The transactions will be matched to the Authorized Supplier-Address database using the Join
Databases task in IDEA. The History log will specify the number of unmatched records (i.e., a
payment for which there is no match in the supplier’s database).

IDEA Functionality Covered:

e  Matching databases using the Join Databases task
e  Selecting the correct primary database for joining
e Determining the number of matched or unmatched transactions

e Using the @IsBlank() function

The common key by which the databases are to be joined is the SUPPNO field in each database.
Verify that the field is the same type in each database.

Verify a Common Key

1. Ensure the Accounts Payable database is the active database and the Data property is
selected in the Properties window.

2. Doubleclick over the Database window to open the Field Manipulation dialog box and to
display the field layout.

Field Manipulation

tion | 169

Field Mame Type Len | Dec Parameter Description ~

1 Character 4 Supplier Number

_ Append
2 |PAYEE Character 17 Payee
3 |INVOICE Character 12 Inveice Mumber Delete
4 | INV_DATE Date 8 YYYYMMDD Invoice Date Print
5 | AMOUNT Mumeric 8 2 Amount
§ |CHECK Murneric 8 0 Check Number il
7 |PAY_DATE Date 8 YYYYRMMDD Payment Date Cancel
8 AUTH Character 6 Payment Authorization Initials
9 |PAY DAYS Virtual Numeric 0 @Age(PAY DATE, INV D... Number of days to pay invoice hd i

Note that the field SUPPNO is a Character field.
3.  Click Cancel.

4. Open the Authorized Supplier-Address database.
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5. Doubleclick over the Database window to open the Field Manipulation dialog and to
display the field layout.

Field Manipulation

Field Name Type len | Dec Parameter Description
1 |SUPPNO Character 7
Append
2 |SUPPMNAME Character 18
3 |ADDRESS1 Character 21 Delete
4 | ADDRESSZ Character 9 Print
5 |ADDRESS3 Character 7
Copy
6 |ZIP_CODE Character 8
7 |TOT_PREV_YR Mumeric 8 2 Cancel
Help

Note that the field SUPPNO is a Character field.
6. Click Cancel.
Join the Databases
1. Make the Accounts Payable database the active database.

2.  From the Analysis tab, in the Relate group, click Join.

“ Home Data Analysis View Macros SmartAnalyzer
2y 2 - . . =T Summarization (1 Aging . —
~ Direct Top Records = Gap Detection Cg Duplicate Key = & Join = Visual Connector
7 Pivot Table

=1 Stratification

Re-run  =: |ndexed = Key Value ‘1 Benford's Law [ Statistics = v Append Compare

| Chart

Tasks Extract Explore Categorize Relate
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The Join Databases dialog box appears with the details of the Primary database in the top
section.

Join Databases
0K
Primary database: Accounts Payable Fields
Mumber of records: 999 Cancel
Criteria: Help
Secondary database:
Mumber of records: Ficlde
File name: | Join Databases Match
(@) Matches only {1 all records in primary file
i) Records with no secondary match () All records in both files

(") Records with no primary match
Create a virtual database

Note: It is possible to enter Criteria for the Primary database (i.e., only a range of
suppliers), if required. Do not enter criteria for this test.

Specify the Secondary database as follows: click Select. The Select Database dialog box
appears. Select the Authorized Suppliers-Address database and then click OK.

Select Database

Desktop Project oK
Mame Records Size Modified Cr..
- Cancel
+-0f Accounts Payable 999 288 12002016, 1/.
L.0§ Authorized Suppl. 48 25 12002016 .. /.

Change the File name in the lower section of the Join databases dialog box to Supplier
Verification.

Specify the common match key by clicking on Match to display the Match Key Fields dialog
box.
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9.

Click the Primary text box and select SUPPNO from the list of fields. Note the Order text
box and accept the default, Ascending. Click the Secondary text box and select SUPPNO
from the list of fields. Click OK.

There are 5 join options at the bottom of the screen. Select the option: All records in
primary file.

Note: All records in Primary file is selected as:

e There are multiple payments for each supplier.

e The risk is that payments are to unauthorized suppliers so we are not interested in
suppliers with no payments (the All records in both files option).

The Join Databases dialog box should appear as in the screen below.

Join Databases
Primary database: Accounts Payable Fields
Mumber of records: 999 Cancel
Criteria: Help
Secondary database: Authorized Supplier-Address Select
Mumber of records: 43 Ficlds
File name: | Supplier Verification Match
(") Matches only (®) all records in primary file
() Records with no secondary match () All records in both files

() Records with no primary match

Create a virtual database

Click the OK button to join the selected databases. View the resultant database.
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11.
12.
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Click the History link in the Properties window, and then locate and expand the section for
the Join Databases task.

Accounts PayableMD X Authorized Supplier-Address.IMD X

Supplier Verification.[MD >

File name

& Export to E Z E- Z: Filter

Database Date User
Control Total Field Changed  2/8/2016 12:05:32 PM [T Ottawa
B Join Databases

2/8/2016 12:05:32 PM [T Ottawa

Chlsersi|T OttawatDocumentsiMy IDEA Documents\IDEA
Projects\Accounts Payable\Supplier Verification.IMD

Mumber of records: 999

Control field: AMOUNT
Control total: 34.145,300.89
Unrnatched primary recs: 8

Join primary file:

Chilsers\IT Ottawa'\Documents\ My IDEA DocumentshIDEA
Projects\Accounts Payable\Accounts PayableMD

Mumber of records:

999

Join secondary file:

ChUsershIT Ottawa'\Documentsi Wy IDEA Docurmentsh|DEA
Projects\Accounts Payable\Authorized Supplier-Address.IMD

Mumber of records:

48

Type of join:

All records in prirmary file

Key used:

SUPPMO/A - SUPPNO/A

Creating a virtual databa...

Mo

IDEASCript code:

Set db = Client.OpenDatabase("Accounts PayableMD'")

Note that there are 999 records in the file and that there are 8 Unmatched Primary records -
these are payments to unauthorized suppliers.

Reconcile the control totals for AMOUNT and TOT_PREV_YR. For the AMOUNT field, we
have already reconciled based on the above history. However, to perform this reconciliation
for the TOT_PREV_YR we will have to summarize on SUPPNO.

From the Analysis tab, in the Categorize group, click Summarization.

Select SUPPNO on Fields to summarize.
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13. Do not select any fields under Numeric field to total. Click Fields and select TOT_PREV_YR
as a field to be included. Name the database Supplier Analysis - Control Total and then

click OK to run the task.
Fields

Fields to indude:

AUTH A
PAY_DAYS Include Al
SUPPNO1
SUPPNAME Clear Al
ADDRESS1
ADDRESS2
ADDRESS3
ZIP_CODE

TOT PREV YR W Help

Cancel

The control total is 29,720,396.11. This does not reconcile to the original control total of
30,202,660.57. The difference between the two is 482,264.46. Analysis is required to
determine why we have this difference.

14. Make the Authorized Supplier - Address database the active database.

15.  From the Analysis tab, in the Explore group, click Duplicate Key and then Detection.

16.  Accept the default selection of the Output Duplicate Records option and enter the file
name Authorized Supplier Duplicate Key.

Duplicate Key Detection
(®) Output duplicate recaords
(") Output records without duplicates Key
Criteria: Fields
File name: | Authorized Supplier Duplicate Key | Cancel

Create a virtual database Help
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17.  Click Key and use the SUPPNO field, as this was the field used during the Join Databases
task. Click OK.

Define Key

Base index on:

MEW IMDEX W
Field Direction
SUPPMO v | Ascending
Delete Key
Cancel
Help

18.  Click OK to run the Duplicate Key Detection task.

Two suppliers have been assigned the Supplier Number of W007; the SUPPNO was not a
unigue key. One of these suppliers has an amount of 482,264.46, which reconciles to the
difference identified above. As the key was not unique, IDEA dropped this supplier during
the join. Inquiries should be submitted to the management of Bright IDEAs as to which
supplier is the correct one. We should communicate this weakness in managing supplier
numbers to the client; as the supplier number should be unique.

PN Ll 2o RN T TS L == Ve  Authorized Supplier Duplicate Key.... X

| SUPPNO | SUPPNAME |  ADDRESST ADDRESS2 | ADDRESS3 | ZIP,
1| Woo7 - The Matt Cash Co 1596 1 N AVE. ' OTTAWA  ONTARIO  N&W
2|W007 Witch Products 543 28 5T. ' OTTAWA  ONTARIO | L3W

The client has informed the audit team that the Witch Products supplier had a balance in
previous years, but in the current year they do not have a balance, as they are no longer in
business. Therefore, the Witch Products account should be ignored for this and other
analyses. However, the auditor will need follow-up to corroborate the client’s explanation.

19.  From the File tab, click Close All Databases.
20.  Open the Supplier Verification database.

21.  Extract all unmatched records using methods explained in earlier exercises and using the
following equation: @IsBlank(SUPPNO1).
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22. Name the extraction database file, Payments to Unauthorized Suppliers.

S A WL LR NV Payments to Unauthorized Supplie.. X

| SUPPNO | PAYEE INVOICE | INV_DATE | AMOUNT | CHECK | PAY_DATE |AUTH | PAY_DAYS

} SUPPNO1 |

MI00 M Cash Inc UP-76209  :10/3/2015  75000.00 10/3/2015 L HMY
MI00 TheCashColnc : 784366542  11/1/2015  59,096.84 15 VST
MIOD Craoks Inc PI7683 271072015 21,632.22 2/12/2015 HMV. |
MIOD Cashonly UY-03T1 42872015 279272 70 512005 HV
1100 Cash Inc CS-T17-97 19/15/2015 | 75000.00 9/17/2015 VST

oo~ o] ;| f|w|ral =

N B BT I~ T

MI00  CoCashinc  T5352 10/19/2015 | 75,000.00 10222015 VST
MIOD CashBackinc | CB3436 192015 | 292278 71202015 HMY.
MIOD | MattCash & Co | In879-97  6/26/2015 | 190,071.38 (6/30/2015  (HMV |

All such payments are to supplier M100 and total $501,515.94.

23.  Close the Payments to Unauthorized Suppliers database.

Analyze the Opjective:
Payments by
Supplier

To analyze payments by supplier to identify large movements.

Exercise Description:

Using the Supplier Verification database, summarize (or total) the AMOUNT field for each
Supplier (i.e., SUPPNO). Then identify suppliers where the total payments have either increased or
decreased by over 25% in the past year. Create Editable fields to mark items for investigation and to
add comments.

IDEA Functionality Covered:

e Summarizing data
e Using the @Abs() function
e Adding and using editable fields

1. Ensure the Supplier Verification is the active database and the Data property is selected in
the Properties window.

2.  From the Analysis tab, in the Categorize group, click Summarization

3. Consider whether Quick Summarization should be used.

The Use Quick Summarization option can be used as there is only one field in the key (i.e.,
SUPPNO). For this exercise we will not use this option.

4. In the Fields to summarize area, select the SUPPNO field.

5. In the Numeric fields to total box, select the AMOUNT field. Do not select the
TOT_PREV_YR field to total; this will be selected as additional information.

6.  Click Fields and select the following additional fields to be included: PAYEE, SUPPNAME,
TOT_PREV_YR.

7. Click OK on the Fields dialog box.

8.  Accept the option to Create database, but do not check Create result (i.e., report). Note,
do not enter any Criteria for the test.
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Enter the File name for the output database as Payments by Supplier and then click OK.

View the resultant database and note the NO_OF_RECS field (i.e., number of payments per
supplier).

Sequence the database in descending AMOUNT_SUM order. Increase the column width if
necessary by dragging the column title delimiter.

Supplier Verification.IMD X

SUPPNO NO_OF_RECS EAMDUNT_SUM - PAYEE SUPPNAME TOT_PREV_YR
1 | MO25 52 2,134, 298,41 | Luke Hair A Meadow 1,217,309.35
2 |F130 41 1,264,972.82 : Farmer Farmer 704 603.56
3 | K001 253 1,192,028.35 | Joyce Tick O Kay Yahs 998,678.23
4 [ M014 25 1,074, 984.65 : Linda Hand Cary 5 Matic 695,843.17
5 | MO020 26 1,005,562.50 ;| Luke Hair Miles Long 718,320.63
6  TOO5 32 1,004, 562.97 | Read I.M. Honor Toze 455,140.82
T | Woo7 24 956,356.92 | Matt Cash Co The Matt Cash Co 1,397,587.06
& | POO7 30 955,858.59 : Nellie Dunn Mandy Purmnps 2800,765.76
8 | RO0E 32 940,403.26 | Phillippa Pail It Right 473,958.65
10| PO10 19 920,543.59 ;| Penny Cillin Ri Pent 913,856.71
1| C202 27 914,605.16 : Matt Cash Cash Inc 4926,888.28
12 | W05 17 878,038.02 : Will Scarlet Williams Inc 0.00
13 | G020 25 874,293,828 | Gus Main P Green 719,875.68
14| PO0O9 21 844.789.61 | P Green Philip Upp Garages 834,789.32
15 | 2001 29 805,689.67 : Miles Long Edward Zoff 900,000.00
16 | F123 24 761,424.36 ; Dick Tate Wanda Farr 234,102.71
17 | TOO4 16 749.361.58 | Richmond Dick Tate 878,625.59
13 | M128 21 742,304.15 | Maurice Mynah Gus Main 800,678.87
19| HO25 25 735,018.63 | lvan Aker Luke Hair 644, 588.82
20| F128 25 721,287.68 | Ern Payed Fines 690, 799,29
21 [ PODE 22 714,223.63 | Moah Lott Ern Payed M,171.15
22 | RD20 16 708,994.82 : Polly Gunn Round Table 689,593.63
23| D25 24 £98,893.36 | Denise Bent Mellie Dunn 674,002.45
24| GO0 25 670,697.82 | Fies Polly Gunn 0.00
25 HO14 25 £59,862.17 : Honor Toze Linda Hand 609,855.94
26| RO11 16 628,125.43 : Pole Tacks Richmond 587,962.78
27 | TODG 16 604,842,171  Round Table Pole Tacks 506,912,359
28 ( M130 1% 602,187.22 : Microcomputers | Maurice Mynah 992 725.50

There should be 48 records totaling $34,145,300.89
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12.

13.

14.

Extract all suppliers where the total payments have increased or decreased by over 25%
during the past year. Select the Direct Extractions task and change the file name to Large
Movements. Use the following extraction equation: @ Abs(AMOUNT_SUM -
TOT_PREV_YR) * 100 / TOT_PREV_YR > 25.

Equation

) =
DAbs(AMOUNT_SUM - TOT_PREV_YR) * 100 f TOT_PREV_YR = 25

== » < <= »= <> + - * / AND OR MOT MOD EXP E

2 ||

Click the Validate and Exit button.

Note: @Abs() ignores the negative sign. Therefore, @ Abs(expression) > 25 will identify
both increase and decrease greater than 25%.

When testing items, it is often useful to manually mark items as correct/incorrect or to add
comments to the database. Although the original data cannot be modified, it is possible to
append Editable fields to the database.

In the Direct Extraction dialog box, click Create Fields. Add the following fields:

NAME TYPE LEN DEC PARAMETER | DESCRIPTION
TEST Multistate 1 -1 Yes, No, N/A
COMMENT Editable 100 Additional
character Comments
Create Fields
Field Mame Type Len | Dec Parameter Description
1 |TEST Multistate 1 -1 Yes, Mo, N/A Delete
2 COMMENT Editable Charac,.. 100 Additional Comments

3
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15.  Click OK in the Create Fields dialog box. Click OK in the Direct Extraction dialog box.

Supplier VerificationIMD X Payments by SupplierMD X
SUPPNO NO_OF_RECS AMOUNT_SUM PAYEE SUPPNAME TOT_PREV_YR TEST COMMENT

1|F123 24 761,424.36 | Dick Tate Wanda Farr 23410271
2 | F130 41 1,264,972.82 : Farmer Farmer T04,603.56
3| M014 25 1,074,984.65 | Linda Hand Cary S Matic 695,843.17
|4 | M020 26 1,005,562.50 : Luke Hair Miles Long 718,320.63
|5 | MD25 52 2,134,298.41 | Luke Hair A Meadow 1,217,309.35
|6 | M13D 17 602,187.22 | Microcomputers : Maurice Mynah 992,725.50
B 17 488,891.02 ; Mike Atsil Moah Lott 898,954.20
& | RO0Z 32 940,403.86 : Phillippa Pail IM Right 473,958.65
9 | RO1D 16 583,172,77 | Phillippa Pail Ronnie Biggs 451,188.84
10 | RO25 16 586,829.24 | Ray Ray 823,889.61
11| TO0S 32 1,004,562.91 : Read .M. Honer Toze 455,140.82
12| To10 16 443,156.54 : Wanda Farr Truckstop 758,325.88
13| woo7 24 956,356.92 | Matt Cash Co The Matt Cash Co 1,397,587.06
[ 14| w020 12 283,957.46 | Witch Products | Wite Wash 603,677.11

e  There should be 14 suppliers totaling $12,130,760.68 whose turnover is more
than 25% different to the previous year.

e Note that the TEST and COMMENT fields are empty. However, these are
Editable fields.

e  Further to investigation, it is discovered that the following suppliers may need
investigation: F123 and F130.

The following do not require further investigation: M025, R025, and W007.

16.  Click in the TEST field for each of these suppliers and note how the entry changes from

empty, to a check mark to an "x” to finally a question mark.
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17.  For suppliers F123 and F130, enter Investigate reason for large increase in payments as
a comment.
Supplier VerificationIMD X Payments by Supplier.MD X
SUPPNO NO_OF_RECS AMOUNT_SUM PAYEE SUPPNAME TOT_PREV_YR TEST COMMENT
F123 24 761,424.36 : Dick Tate Wanda Farr 23410271 Investigate
reason for
®  ilarge
increases in
payments
F130 4 1,264,972.82 : Farmer Farmer T04,603.56 Investigate
reason for
* .
large increase
in payments
MO14 25 1,074,984.65 : Linda Hand Cary 5 Matic 685,843.17
M020 26 1,0053,562.530 ; Luke Hair Miles Long 718,320.63
M025 52 2,134,288.41 | Luke Hair A Meadow 1,217,309.35
M130 17 602,187.22 | Microcomputers ;| Maurice Mynah 492 725.50
NOO1 17 488.891.02 : Mike Atsil Meah Lott 808,954.20
ROO2 32 940,403.86 : Phillippa Pail IM Right 473,958.65
RO10 16 583,172.77 : Phillippa Pail Ronnie Biggs 451,188.84
R0O25 16 586,829.24 : Ray Ray 823,889.61
TOO0S 32 1,004,562.91 : Read LM, Honor Toze 453,140.82
TO10 16 443,156.34 : Wanda Farr Truckstop 758,325.88
W07 24 956,356.92 : Matt Cash Co The Matt Cash Co 1,397,587.06
Wo020 12 283,957.46 : Witch Products | Wite Wash 603,677.11
18.  View the History log and note that all modifications are recorded.

19.

Close all databases.
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Audit Findings The following audit findings should be reported to the client.

The analysis of payment values showed a significant number of items just below the $80,000
authorization level. Further investigation found:

e 20 payments with CASH in the name
e 5 round sum payments of $75,000, with 3 being potential duplicates
e  Zero-value payments

e 399 payments authorized by HMV, many above the $20,000 limit applicable in
this case

e 77 payments were made on a Sunday and again are mainly authorized by HMV
e There are 5 missing checks: 701805, 701997, 701998, 701999, and 702000.
e There are 85 days on which no payments were processed:

e 63 payments were made within 25 days of the invoice date, which is quicker than
the company policy

e 17 payments were delayed more than 35 days
e 6 payments were made before the invoices were entered on the system
e  Payments were made to a supplier not on the authorized supplier list.

e  Supplier numbers should be managed to ensure proper referential integrity.






Section 4

Inventory Analysis

Introduction What are the risks associated with Inventory that could be addressed by computer assisted audit
procedures? And what tests can help address those risks? This section summarizes the business and
audit risks that arise in the context of Inventory and the potential tests that can be used to address
those risks.
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Potential Risks

The following table identifies the key risks, explains the business and audit implication of each risk
and the audit objectives that could be addressed by audit tests.

RISK

IMPLICATIONS

AUDIT OBJECTIVES

Inventory is not
correctly recorded.

Management will not have accurate
information to manage inventory (i.e.,
ordering) effectively.

Inventory could be materially misstated
on the financial statements

Accuracy, Existence,
Validity

Inventory Management may identify issues, but Existence,
management reports  may not be able to “drill down” and Validity,
have inadequate identify the root cause of issues. This, Vv ;
. . ; e aluation
supporting in turn, hampers management’s ability
information. to make effective decisions.
Quantity of inventory  If too much inventory is maintained Valuation
is not maintained then there is an increased risk of
within the specified obsolescence and additional storage
range. costs (i.e., for keeping the inventory). If
too little inventory is maintained, then
the company will not be able to meet
the customer demand.
Obsolete inventory Management will not be able to make  Valuation

items are not
identified

proper decisions on getting rid of
obsolete items.

From an audit point of view, obsolete
items may need to be revalued if the
market price is less than their cost.

Differences between
the physical inventory
and the inventory on
the system are not
identified.

Management will not have reliable
information to make inventory
management decisions. Also, it may
have a problem in terms of identifying
shrinkage.

From an audit perspective, the
inventory could be materially misstated
on the financial statements.

Existence, Validity

[tems are not
recorded in the
correct period.

Financial statements, i.e., inventory and
cost of goods sold, could be materially
misstated.

Cut-off

Gaps in sequentially
numbered documents
are not accounted
for.

Inventory tags, transaction numbers
and other information may be missing
and not accounted for. This would
undermine the control that is provided
by inventory tags.

Completeness
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Potential Tests

The following tests are suggested when analyzing an inventory system. However the exact tests
carried out for a particular client will depend upon the system used and the data available. Common
tests include:

Mechanical Accuracy and Valuation

e Total the file, providing sub-totals of the categories of inventory.

e Re-perform any calculations involved in arriving at the final stock quantities and
values.

e Re-perform material and labor cost calculations on assembled items.
Analysis
e Age inventory by date of receipt.

e Compute the number of months each inventory item is held based on either sales
or purchases. Produce a summary of this information.

e  Stratify balances by value bands.
e  Analyze gross profit.

e Analyze price adjustment transactions.
Exception Tests - Existence and Valuation

e Identify and total inventory held in excess of maximum and minimum inventory
levels.

e Identify and total obsolete or damaged inventory (identified as such in the
database).

e Identify balances in excess of a reasonable usage period that are probably
obsolete.

e Identify items past their shelf life (if a sell by date or bought date is present on the
system).

e Identify any items with excessive or negligible selling or cost prices.
e |dentify differences arising from physical stock counts.

e  Test for movements with dates or reference numbers not in the correct period
(cut-off).

e Identify balances that include unusual items (i.e., adjustments).
e Identify work in progress that has been open for an unreasonable period.

e |dentify inventory acquired from group companies.
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Case Scenario:
Inventory

Gaps and Duplicates

e  Test for missing inventory ticket numbers.
e  Test for missing transaction numbers.

e Identify duplicate inventory items.
Matching and Comparison Tests

e  Compare files at two dates to identify new or deleted inventory lines or to identify
significant fluctuations in cost or selling price.

e Compare cost and selling price and identify items where cost exceeds net
realizable value.

e Compare holdings and inventory turnover per product between stores.

The Chief Financial Officer of Bright IDEAs Inc. has called to say he has identified some problems
with the inventory system and would like you to help analyze the extent of these problems. In
particular, although only 36 items are identified as obsolete on the system, he thinks there are
considerably more obsolete lines that need clearing out. They are also suffering from frequent
stockouts and he is convinced that their margin analysis is not accurate and that re-order levels are
incorrect.

He supplies you with the following information:

e There are 767 product lines in the database.
e Bright IDEAs Inc. has three depots based in Ottawa, Toronto and Quebec.
e The file is as of December 31, 2015.

You agree on the following:

e To check the system calculation of the obsolescence provision, to prepare an
analysis of inventory and usage, and to suggest an appropriate provision.

e To identify items with apparent incorrect re-order levels.

e To perform an analysis of profit margins on different lines.

Note: There is normally a master or balances file that contains details of inventory holdings at a
particular date. Costs may be held in a separate file. The transaction history can be particularly
useful although file sizes are often quite large. Selling prices normally have to be picked up from a
separate file.

Retailers often have point-of-sale systems that may collect large volumes of useful data that IDEA
can analyze.
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Obtaining the Data The data file used for this exercise will be: Inventory on hand at December 31, 2015.
Explanation of the ASCII Delimited File Format
ASCII delimited files are a common format of variable length file where each field is only long
enough to contain the data stored within it. This is an advantage with text fields such as names,
addresses, narratives, etc.
In order for software to use such data files, there is a separator (a special character) at the end of
each field within the record. Additionally text fields may be enclosed (encapsulated) with another
character, typically quotation marks (" ).
The separator is often a comma (,) and such files are known as comma separated value (CSV).
However, the separator could be another ASCII character, for example a colon (:) or a semi-colon (;).
These files are referred to as ASCII Delimited (comma separated files are also often referred to as
ASCII Delimited).

There must also be a record delimiter at the end of each record, typically the carriage return (<CR>)
and line feed (<LF>) characters, or sometimes only the line feed character.

When this type of file is imported, a fixed length database is created within IDEA.
Example of an ASCII Delimited - CSV:
"'6776",1865,1,190,"04-02-2006" <CR><LF>
'6714",1865,1,97,"04-02-2006"<CR><LF>
"11905",2366,10,9,"25-02-2006"<CR><LF>
"7555",4352,1,79,"03-03-2006"<CR><LF>
"4547",4815,5,17,"03-03-2006"<CR><LF>
"6344",4815,1,7,"03-03-2006"<CR><LF>
"151",2366,1,3,"29-03-2006"<CR><LF>
"145",2366,1,1,"05-08-2006"<CR><LF>
"206",2366,1,2,"29-03-2006"<CR><LF>

'207",2366,1,3,"29-03-2006"<CR><LF>
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Request for Data Files for Analysis Purposes

Please supply the following data from the Inventory system in ASCII Delimited format:

FIELD NAME TYPE DEC DESCRIPTION
PRODCODE N 0 Product Code
DEPOT C Depot name
QTY N 0 Quantity on hand
AV_COST N 3 Average cost for item
TOTALCOST N 3 QTY*AV_COST
OBSOLETE C Obsolete = "Y"
MAX N 0 Maximum inventory level on hand
MIN N 0 Minimum inventory level on hand
DELQTY N 0 Last delivery quantity
ORDERNO N 0 Last delivery order number
DELDATED D Date of last delivery YYYYMMDD
CURSELLPRI N 2 Current selling price
CUREFFDATE D Date selling price effective YYYYMMDD
PREVSELPRI N 2 Previous selling price
USAGE N 0 Sales quantity in current year
PREVCOST N 3 Unit cost of last purchase

Data is required for the following period: December 31, 2015

Please also supply the following control totals for reconciliation purposes:

e Total cost of inventory on hand at December 31, 2015.

e Number of transactions supplied, i.e., product lines.

e Record definition to support the data file provided.
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Work Plan From the available/possible tests the audit manager decides on the appropriate tests and prepares
the following Work Plan for you to complete.

Objective:

To check the system calculation of obsolesce provision, to prepare an analysis of inventory and
usage, and to suggest an appropriate provision.

AUDIT PROCEDURES WORK EXTENT
DONE BY | OF
(INITIALS) | TESTING

1 Obtain the data files from the client and load into the PC.

Load IDEA and set a Working Folder for the Inventory Audit
for Bright IDEASs Inc.

2 Agree the total value of inventory:
a) Import the inventory data;

b) Check the total,

C

d

) Compute field statistics; and
)

Reconcile control totals.

3 Consider the adequacy and accuracy of inventory provisions:
a) Test the accuracy of the provisioning report;

b) Compute the usage figures and ratios for all stock lines and
calculate an alternative provision; and

) Analyze the provision by depot.

4 Consider the accuracy of the re-ordering system and test for
items that are not being ordered frequently enough.

5 Analyze profit margins and pricing by sales bands and identify
items with inappropriate or questionable pricing:

a) Items with no selling price; and

b) Major pricing movements.
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Project Setup Objective:

To be able to start an assignment including loading data, running IDEA and creating a Project for
the client within IDEA.

Exercise Description:

This exercise covers copying data into a folder, loading IDEA and creating a new Project for the
client.

IDEA Functionality Covered:

e C(Creating a Project

e Entering project properties
The following data files have been provided on the CD supplied with this Workbook:
e Inventory 2015.ASC - Inventory on hand at December 31, 2015
Accessing IDEA
From the Windows Start menu, select Programs > IDEA > IDEA.
Alternatively, click the IDEA shortcut icon on the desktop, if available. IDEA will load.
Create a Project and Enter Project Information

To facilitate housekeeping, it is recommended that a separate Project be used for each audit,
investigation or analysis.

All information relating to this analysis, including data files, equations, views or report definitions,
import definitions, etc. may be stored in the Project.

This exercise will explain how to create a Project and enter project information that will be printed
on all reports.

Note that once a Project is set, it remains the active folder until changed.
1. To create a new Project, from the Home tab, in the Projects group, click Create.
The Create Project dialog box appears.

2. Select Managed Project and enter Inventory Audit as the directory name, this will create
a new folder:

C:\Users\[UserID]\Documents\My IDEA Documents\IDEA Projects\Inventory Audit
3. Click OK.

Inventory Audit will become the Project, closing the previously active Project.
4.  From the Home tab, in the Projects group, click Properties.

The Project Properties dialog box appears.
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5.  Enter the following:
e Report name: Inventory Audit

e Report period: Jan 1, 2015 to Dec 31, 2015
The project properties will be stored in a file called Client.inf in the Project Folder.
6. The following data files have been provided on the CD supplied with this Workbook:
e Inventory 2015.ASC - Inventory on hand at December 31, 2015
7. Copy the above data file into the folder using Window File Explorer. The folder is:

C:\Users\[UserID]\Documents\My IDEA Documents\IDEA Projects\Inventory Audit\Source
Files.ILB

Import the Opjective:
Inventory File _ _ ,
To import the data file for testing.
Exercise Description:

The year-end inventory file has been provided in a format known as ASCII Delimited.

In order to load this file it is necessary to define its format to IDEA. The Import Assistant will guide
you through the steps to define and import the file for testing.

IDEA Functionality Covered:
o  Access the Import Assistant
e  Build a record definition for an ASCII Delimited file
e  Save the definition
e Import the database into IDEA

e  Select a numeric control amount field for the database
You have been provided with an ASCII Delimited file:
e Inventory 2015.asc - the Inventory file as at December 31, 2015.
1. From the Home tab, in the Import group, click Desktop.
2.  Select Text from the list. Click the Browse button and the Select File dialog box will be

displayed. Navigate to and select the Inventory 2015.asc file from the Project Import
Folder. Click Open and then click Next.
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3.

4.
5,

The Import Assistant - File Type screen will be displayed. Ensure Delimited is selected as

the correct file type.

Import Assistant - File Type

The Import Assistant has examined the file and has determined that it is a delimited file.

If this is not correct, please select the correct file type.

(®) Delimited

("I Fixed Length

{_) EBCDIC Fixed Length

......... B T e

1 110211059QUEBEC3Z 4.368139.7761002
2 1112011030TTARALZS 3.3511438.875300
3 111601902QUERBECET0 0.69462.3900200
4 111807059QUEBECAE4 0.591404.244750
3 111307558QUEBECE] 1.877114.4573001
& 111213056TORCNTOSS 00.548542.523000
i 111815558QUEBEC140 0.57179.9450010
g8 1113216030TTAWASGE0 0.482173.52388

9 111821703QUEBEC3E0 0.401152.384041
10 [1113218039TORONTOZ 00.46115250100

11  111824705QUEBEC320 0.652208.6844311
12 113219101QUEBECA3 .29929.691Y7412
13 113401101TORONTC&3 0.8553.5512563

< Back

51876094820151204
10070760474201511
54076084820151203
100432760945920151
00487609502015120
5009007609512015

01507605162015111
259400760849201512
272007680851201512
15076085220151203
68200760853201512
TEO0386201510187.5
60760952201512042

Cance

View the data and determine the field separator and the record delimiter.

Click Next.

Help
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The Import Assistant will try to determine the Field Separators and Text Encapsulators
(if any) for the file. Accept the defaults and click Next to proceed.

Import Assistant - Specify Field Separator and Text Encapsulator

Please inspect the file displayed in the preview and make changes, if required, in the options below.

Field Separator

Delimited files use a spedal character to separate fields. Please inspect the file below and, if

required, change the Field Separator selected.

() Comma () Colon () Semicolon (®) Tab (") Space () other | |
Text encapsulator: | © W Header lines to ignore: | 0 :
[]First visible row is field names
1 110211059 QUEBEC 2 4.368 139.77& 100 2 g Te0948 20151 A
2 111201103 OTTAWA 125 3.511 438.875 300 100 70 760474 20151
3 1116015902 QUEBEC &70 0.68% 462.3 900 200 540 780848 20151
5 111807059 QUEBEC 684 0.591 404.244 750 100 432 7609459 20151
5 111807558 QUEBEC &1 1.877 114.497 300 100 48 760950 20151
B 111813056 TORONTIO 9390 0.548 542.52 3000 500 900 T7e0851 20151
7 111815558 QUEBEC 140 0.571 79.94 500 100 150 Te051le 20151
8 111821608 OTIAWR 360 0.482 173.52 E8 169 400 760849 20151
9 111821703 QUEBEC 380 0.401 152.38 404 127 200 Te0B51 20151
10 1115218059 TORONTO 250 0.4& 115 250 100 150 780852 20151
11 111824705 QUEBEC 320 0.652 208.64 431 166 200 760853 20151 ¥
£ >
< Back Cancel Help

Note: Some (but not this) ASCII Delimited files have field names as the first row of the file.
To use these as field names, select the First visible row is field names option.

The Import Assistant - Field Details step will be displayed.
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7.  Click on each field heading in turn and using the record definition, define the field details.

FIELD NAME TYPE DEC DESCRIPTION
PRODCODE N 0 Product Code
DEPOT C Depot name
QTY N 0 Quantity on hand
AV_COST N 3 Average cost for item
TOTALCOST N 3 QTY*AV_COST
OBSOLETE C Obsolete = "Y"
MAX N 0 Maximum inventory level on hand
MIN N 0 Minimum inventory level on hand
DELQTY N 0 Last delivery quantity
ORDERNO N 0 Last delivery order number
DELDATED D Date of last delivery YYYYMMDD
CURSELLPRI N 2 Current selling price
CUREFFDATE D Date selling price effective YYYYMMDD
PREVSELPRI N 2 Previous selling price
USAGE N 0 Sales quantity in current year
PREVCOST N 3 Unit cost of last purchase

8.  Enter the correct field name in the Field name box. The Import Assistant suggests the file
type for that field in the Type box. If this is incorrect then change it to the file type specified
in the record definition.

9.  Enter the description of the field in the Description box.

10.  If the field is a Numeric field with decimals, it is necessary to specify whether or not the
decimals are implied. However, in this database if there are decimals, the decimal place is
stored in the number, therefore the Implied decimals box must not be selected. Specify the
number of decimals in the Number of decimals box.
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11.  Define the Date fields as type Date, i.e., change the Character to Date in the Type box. A
mask must be defined for the Date fields. Click the Date Mask box and enter the
appropriate date format i.e., YYYYMMDD.

Import Assistant - Field Details

You can now specify field details. Select a field by dicking on the column heading below, and then

modify its information below.

Field name: | PREVCOST

Description: | :cost of last purchase| |

[ ] Do not import this field

Converted Example

CEDERNO DELDATEDTRSELLPRTUREFFDATREVSELLPE USARGE |PREVCOST

Type: | Numeric

Mumber of decimals:

[ ] 1mplied decimals

4,020

1
1 7609458 20151204 9.15
2 Ta0474 20151108 8.75
3 760848 20151203 1.49
4 Ta094% 201512041.0%9
5 760950 20151204 3.95
=] 780951 201512041.15
ri Ta051le 201511141.1%9
8 TaO249 20151203 1.35
9 Te0E51 201512031.15
10 TaOB52 201512031.2%9

<

12.  Click Next.

20150513 8.
20150812 7.
20151202 1.
20150413 0.
20101105 3.
2015100&1.
201503191.
201504301.
20150606 1.
20150221 1.

435
a5
35
95
55
a5
]
29
0s
13

3

535
794
2488
21568
1
4593
101
1011
37568
100

Cancel

4.02
3.694
0.638
0.55
1.732
0.504
0.525
0.493
0.4
0.474

Help



196 | IDEA Version Ten Workbook

13.  The Import Assistant — Create Fields dialog box appears. Create Fields allows you to add
fields in the imported file. This can be done during the import or at any time while using
IDEA. For this exercise, no fields will be added.

Import Assistant - Create Fields

You can add one or mare fields to the impaorted file by entering the field name, type, length,
parameter and description for the field(s) in the columns below.

Delete
Field Name Type Len | Dec Parameter Descripd
N
2
£ >

< Back Cancel Help
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14.  Click Next.

The Import Assistant - Import Criteria screen appears. We will not be entering criteria for
this example.

Import Assistant - Import Criteria

You can enter an equation to limit the data that is imported. Click the Equation Editor button to enter
the equation.

< Back Cancel Help

15.  Click Next.

16.  The definition will automatically be saved in the Project Import Definitions.ILB. IDEA will
give the definition the same name as the source file. Click the Browse button adjacent to
the Save record definition as box if you want to change the name to something other
than Inventory2015.rdf.

17.  Select the Generate field statistics option and enter Inventory at Dec 31 2015 in the
Database name box.

18.  Click Finish to import the file into IDEA.
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19.  Click the Control Total link in the Properties window and select the TOTALCOST field and
then click OK.

The control total of 626,963.915 will appear beside the Control Total link in the Properties
window.

There are 767 records as can be seen on the status bar at the bottom of the screen.

You are now ready to verify that the data has been imported correctly and to commence
testing.

Verify that the opjective:
Database Has Been

Correctly Imported To prove that data has been imported correctly and that the inventory report is correctly footed.
Exercise Description:
View the Field Statistics for the Numeric fields in the Inventory at Dec 31 2015 database.
The numeric statistics will be used for:
e Agreeing totals
e  Getting a general understanding of the ranges of values in the database

e Highlighting potential errors/areas of weakness for focusing on subsequent
investigations

IDEA Functionality Covered:
e Viewing Field Statistics
e  Printing Field Statistics
1. Click the Field Statistics link in the Properties window.
Field Statistics are displayed for the Numeric fields in the database.
Note: The Field Statistics are available instantly as they were generated when the database

was imported. Field Statistics are also available for Date fields. These will be reviewed in the
following exercise.
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Study the Field Statistics for all Numeric fields, but especially, the QTY and TOTALCOST
fields. Notice in particular the Net Value, Minimum Value, Maximum Value, # of Zero
Items and # of Negative Records field statistics.

Please check your results against the figures below.

Field: QTY
STATISTIC VALUE COMMENT
Net Value 214,954
Absolute Value 214,984
# of Records 767
# of Zero Items 68
Positive Value 214,969
Negative Value -15
# of Positive Records 696
# of Negative Records 3 These should be identified
# of Data Errors 0
# of Valid Values 767
Average Value 280.25
Minimum Value -8 Should not be any negative quantities
Maximum Value 10,800
Record # of Min 202
Record # of Max 576
Sample Std Dev 653.53
Sample Variance 427,098.71
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Field : TOTALCOST

STATISTIC VALUE COMMENT
Net Value 626,963.915
Absolute Value 627,159.615
# of Records 767
# of Zero Items 69 Different number for zero-quantity
Positive Value 627,061.765
Negative Value -97.850
# of Positive Records 695
# of Negative Records 3
# of Data Errors 0
# of Valid Values 767
Average Value 817.424
Minimum Value -67.000
Maximum Value 70,555.641
Record # of Min 90
Record # of Max 384
Sample Std Dev 3,863.12
Sample Variance 14,923,698.38

3. If your computer is attached to a printer, print the Field Statistics for the QTY and
TOTALCOST fields by clicking the Print button on the Field Statistics toolbar and selecting

each field.

4. The Field Statistics reports should be filed with the audit documentation as proof of
reconciliation.

5. Return to viewing the database by clicking the Data link in the Properties window.

Conclusion

The file has been imported correctly and the client’s reports reconcile correctly. However there are
some negative items and we should identify these and report them to the client.
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Objective:

e To check the client’s calculation of the obsolescence report.
e To identify obsolete inventory and calculate potential provisions.

e To identify any items with negative quantities or costs.
Exercise Description:

Note that there are obsolete inventory items on the database, denoted by a “Y" in the OBSOLETE
field.

e View the Date Field Statistics for the last delivery date to determine the age of
inventory items.

e  Confirm the client’s calculation of obsolete items by reference to the items
marked as obsolete. At the same time identify the negative value and quantity
items.

e  Extract items with inventory on hand and perform a calculation of usage.
e Analyze the inventory by usage and then calculate a provision based on this.
e Analyze the provision by depot.

e |dentify any major items for detailed investigation.

IDEA Functionality Covered:

e View and analyze Date Field Statistics

e  Perform calculations by appending Virtual fields

e  Perform multiple extractions

o  Copy, paste, and edit similar extraction equations

e  Perform summarizations
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The first test is to view the Field Statistics for the DELDATED (date of last delivery) field to determine
the age of the oldest stock items.

1.
2.

N o o b

10.

Click the Field Statistics link in the Properties window.
In the Field Type box, select Date.

Notice the Earliest Date, Latest Date, and # of Zero Items (i.e., missing dates) statistics for
DELDATED.

Please check your results against the figures below.

Field: DELDATED

STATISTIC VALUE COMMENT
# OF Zero Items 0 Items with no delivery date
Earliest Date 9/21/2001 Old indentory items to be investigated
Latest Date 12/18/2015

The next test to carry out is to prove the client’s obsolescence provision report.

Return to viewing the database by clicking on the Data link in the Properties window.
From the Analysis tab, in the Extract group, click Direct.

Change the file name to Obsolete Inventory Items.

To enter the equation, click the Equation Editor button. The Equation Editor appears and
is used to enter the required equation to identify items flagged as obsolete.

Enter the expression: OBSOLETE = “Y" as follows:
e Insert OBSOLETE into the equation by double-clicking the field name
e  (Click the = button
e  Click the " button

e TypeinY (note the upper case) within the quotes as below

Once the equation has been entered, check the syntax by clicking the Validate button. If a
syntax error occurs in your equation, correct the expression and recheck the syntax. The
equation should be as in the above screen. Click the Validate and Exit button but do not
run the extraction yet.

Multiple extractions (up to 50) can be carried out with a single pass through the database.
We will use this feature to report the negative items. Click on the next row in the
spreadsheet area of the Direct Extraction dialog box. Enter the File name: Negative
Quantities.

Click the Equation Editor button and enter the following equation: QTY < 0.
e Insert QTY into the equation by double-licking the field name.
e Typein<.
e TypeinO.

e  (Click the Validate and Exit button but do not run the extractions yet.
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Note: If equations are similar, they can be copied, pasted and edited to save time.

e Double<click to select QTY < 0 from the Direct Extraction box.
e  Press CTRL + C (to copy to the clipboard).

e  Click on the Equation text box for the third equation.

e Press CTRL + V (to paste from the clipboard).

e Click on the Equation Editor button to edit the equation.

e  Replace the QTY field with TOTALCOST.

e C(lick the Validate Equation button to check the syntax (if a syntax error occurs
in your equation, correct the equation and recheck the syntax).

e C(lick the Validate and Exit button.

e  Change the file name to Negative Cost Items.

Direct Extraction
Records to extract: (@) Al Starting record #: 1
(D) Range Ending record #: 757 Create Fields
Create a virtual database Ficlds
Database order: |Mo index v Delete
File Name Criteria Cancel
1 | Obsolete Inventory ltems OBSOLETE= "Y" Help
2 | Megative Quantities Ty =0
3 Megative Cost [temis TOTALCOST < 0

4

11.  Click OK to run all 3 extractions with a single pass through the database.

e The resultant databases will be created and the Obsolete Inventory Items
database will be displayed.

e There should be 34 items totaling $7,644.270 that you note agrees to the client’s
report.

e  Open the Negative Cost Items database from the File Explorer. It should
contain 3 items totaling $-97.850.

e  Open and inspect the Negative Quantities database. There should be 3 items
totaling $-30.850.
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Calculate Usage
Ratios and Suggest
Obsolescence
Provision

12.  Close all databases by clicking the File tab and then Close All Databases.

Conclusion

The client’s report is mathematically accurate in footing those items flagged as obsolete. Whether
other items should be flagged as obsolete will be tested next. The negative items have now been
identified and can be given to the client for correction.

Objectives:

To analyze inventory usage and calculate provision.

Exercise Description:

Calculate the month’s worth of inventory on hand, based on the usage over the
past 12 months using a Virtual (Calculated) field.

View the Field Statistics of the calculated fields.
Analyze the inventory into bands of six months using Stratification.

Produce a report, including a chart of the Stratification results and optionally
email results to the Chief Financial Officer.

IDEA Functionality Covered:

Add a Virtual field to calculate the number of months of inventory
Use the following @Functions:
e @Age
o @If
Save an equation
View Field Statistics
Perform a Stratification, including creating a detailed stratification database
View an extraction preview of exceptions
Create a report, including a graph of the Stratification results

Export the results to a file or send via e-mail
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Calculate Months of Inventory

1. Open Inventory at Dec 31 2015 as the active database.

Performing a calculation and storing the result in a new column is called Append a Virtual
Field and is carried out through the Field Manipulation task.

2. Double<lick over the Database window to open the Field Manipulation dialog.

3. On the Field Manipulation dialog box, click Append and enter the following details:
e Field Name: MONTHS
e Field Type: Virtual numeric
e Field Length: Do not enter
e Decimals: 2

e Description: Months of inventory on hand

4. Click in the Parameter cell to load the Equation Editor and enter the following equation:
@If(USAGE = 0, @Age(“20151231",DELDATED)/30, QTY/(USAGE/12))

e In the @Functions area, expand the Conditional category. This displays the two
conditional @Functions, @Compif and @If.

o (Click @If and read the help and example in the information area.

e Double<click to select @If, inserting it into the Equation area, or click Insert
Function.

e Select the field USAGE by double-clicking the field name.

e  Continue selecting and typing the relevant items to build the equation. Ensure
parentheses are in the correct position.

e The equation should appear as in the screen below.
Equation
"t === 2 2 == »= o2x o+ - % 0 AND OR NOT MOD EXP E
DIFUSAGE = 0, @Age( "20151231", DELDATED)/30, OTY / (USAGE2))
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The following @Functions are used in this equation:

e  @Age: This computes the number of days between two dates, in this case, the
number of days between the delivery date and the year-end. An assumption has
been made that there are 30 days to a month to give an approximate number of
months figure.

e  @If: This performs a test, in this case whether there is any usage. If the equation
USAGE = 0 is true then the value after the first comma is used, otherwise the
value after the second comma is used.

For more help on the @Functions, review the associated information for the specific @Function in
the Equation Editor.

In the above equation:

e If inventory usage is O (i.e., the true condition in @If), the number of months of
inventory is calculated as the number of months since the last delivery date, i.e.,
@Age ("20151231",DELDATED)/30.

o If there has been usage (i.e., USAGE <> 0), the months of inventory on hand is
calculated as a ratio of the quantity on hand to the monthly usage, i.e.,
QTY/(USAGE/12).

As this is a complex equation that may be used again or may require editing, it should be saved.
Equations may be saved in any folder however it is recommended that all files relating to the
Inventory Audit are stored in the Project Folder under the Equations.ILB folder.
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5.  Click the Save Equation button on the Equation Editor toolbar. When the Save As dialog box
appears, enter the File name: Months of Inventory on Hand.

Jl Save As
1T ;2 |nventory Audit + Equations.ILB v O Search Equations.ILE pe
Organize New folder SRR (7]

~ Name : Date modified Type Si

- Favorites
B Desktop
4 Downloads

Mo items match your search.

2| Recent places

f& OneDrive
. Documents
. Pictures
1M This PC
Deskt:
L] HE5 op _ e >
N EL AR onths of Inventory on Hand)| w
Save as type: | Equation files (*.eqx) w

“+ Hide Folders Cancel

Click Save. All equations are save with the .eqx file name extension.
Click the Validate and Exit button, returning to the Field Manipulation dialog box.

Click OK and then Yes to append the field to the database.

© © N o

View the resultant field by scrolling to the right of the display. The new field is added to the
end (last field) of the database. Note the teal color of this field indicating that it is a
calculated field and not an original imported field.

In discussion with the client, it becomes apparent that the shelf life of most Bright IDEA's
products is only a few months and anything in excess of six months’ use is likely to be obsolete
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10.  To view equations that have been saved IDEA keeps all the information in a library. You can
access the library by clicking the Library tab at the bottom of the File Explorer

File Explorer i

e M@ O
pestoproed

S

Mame Records
=8¢ Inventory at Dec 31 ... 767
.57 Megative Cost It... 3

5§ Megative Quanti... 3

LB Obsolete Invent.., 34
€ >

File Explorer EIe0Y ‘




11.

12.
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The Library tab contains a list of all the directories in which IDEA stores different type of
information, such as equations, macros, exported documents, record definitions, custom
functions, import definitions and source files. When the equation was saved it was saved
automatically to the Equations folder under the Current Project Library:

Library *
T
F_s ng
File Mame:
4 Local Library
# Customn Functions
& Equations
o Exports
o Import Definitions
4 Macros
o Other
o Source Files
o Visualization

4 W)} Current Project Library
& Custom Functions

[

 Equations

=| Menths of Inventory on Han...
Exports

Import Definitions

=| Inventory 2015.RDF

4 Macros

s Other
o

o

1Y
&= i

Results

Source Files

|| Inventory 2015.asc
o Visualization

< >

File Explorer

If you wish to have any item in the Current Project Library available to all projects you can
right click on the item and select Copy to the Local Library. You can also copy the item to
another project in the same manner by copying to Another Project.
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Generate Field Statistics

To produce the Field Statistics for the MONTHS field:

1.

4.

Click on the Field Statistics link in the Properties window.

A message dialog box appears that asks whether you want to create statistics for all fields
without statistics.

Click Yes.

Field Statistics will be recalculated for all invalid or new fields. View the statistics for the
MONTHS field.

Notice the Average Value, Minimum Value, and Maximum Value.

STATISTIC VALUE COMMENT
Average Value 9.13
Minimum Value -1.55 Negative Items
Maximum Value 737.14

Note: The average may be misleading as it may be skewed by a few very high values of
usage. Hence, it is often better to perform the Stratification task to profile the data. This is
carried out in the next exercise.

Return to viewing the database by clicking on the Data link in the Properties window.

Stratify the Inventory into Bands

1.

o o A

Ensure Inventory at Dec 31 2015 is the active database and the Data link is selected in the
Properties window.

From the Analysis tab, in the Categorize group, click Stratification.

The Stratification dialog box appears.

Select MONTHS in both the Field to stratify and Fields to total on list boxes.
e  (Click on the Increment text box and enter 6 (6.00 will be displayed).

e  Click on the first row of the spreadsheet area - the Lower Limit box will
automatically fill with the lowest value in the field to be stratified.

e Double<lick on the Lower Limit box in the first row; the value will be highlighted
SO you can type over it to change it. Change the value to 0 (0.00 will be
displayed).

e  Click in the Upper Limit box on the first row of the spreadsheet area which will
fill in your first increment.

e Highlight the next 5 rows of the spreadsheet area and note how they fill with the
increment, this should take the range up to 36.

Select the Create database option.
Select the Include stratum intervals option.

Change the File name to Inventory Usage Aging.
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7. Click Fields and select only PRODCODE, DEPOT, TOTALCOST, and MONTHS.
To select or deselect a field, click the field name.

8. Click OK in the Fields dialog box.

9. Click OK in the Stratification dialog box.

10.  Note the number of records in each stratum and also that there are Upper limit
exceptions, i.e., items with greater than or equal to 36 months inventory in hand.

11.  View the items with greater than or equal to 36 months inventory in hand by double-clicking
over the Upper limit exceptions results and selecting Display Records.

Note that these items may be viewed, saved to a database, or printed. Once you have
inspected the records, click Done to return to the Results output.

12.  Create and print a report of the Stratification Results, including a graph.

13.  On the Stratification Results output toolbar, click the Chart Data icon on the Results
toolbar. Select 3D/2D button on the chart toolbar.

14.  If your computer is attached to a printer, click Print on the Results toolbar.

15.  Return to viewing the Stratification analysis by clicking the Chart Data icon on the Results
toolbar.

16.  Return to viewing the database by clicking on the Data link of the Properties window.

17.  Open the Inventory Usage Aging database created as part of this exercise. View this
database and note the three additional fields added to the database (i.e., STRATUM,
STRAT_LOW, STRAT_HIGH).

The last two fields were added as a result of checking Include stratum intervals on the
Stratification dialog box.

18.  Close all databases by clicking the File tab and then Close All Databases.
Conclusion

There are 611 (or 79.66) of the product lines that have less than 6 months usage. However, 4.43%
(34 lines) have more than 3 years usage and these are a cause for concern.

There are also 3 items with negative usage, these should be identified and investigated.
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Calculate the Total Objective:
Provisions for

e To provide an analysis of the total cost of the obsolete inventory.
Inventory by Depot P y y

e To identify old items for checking.
e To analyze the data by depot.

Exercise Description:

Total the value of obsolete inventory by depot. The Summarization task is used to provide totals of
specified Numeric fields.

Additionally, this test will identify the number of obsolete inventory products as well as the total
cost by depot.

IDEA Functionality Covered:
e How to summarize (i.e., total) data by a key
e The differences between the Summarization options

Discussion with the Chief Financial Officer on the results of the Stratification task indicate that items
should have an obsolescence provision calculated on the following basis:

e  6-12 months: 50%
e Over 12 months usage in stock: 100%

The whole value of an item should be used for the provision calculation, not just the surplus over 6
or 12 months usage.

The following tests have been requested:
e Include the percentage provision for each age band

e Calculate the provision cost for each band for each depot

e  Summarize to calculate the total provision for each depot

Include Provision in Database

1. Open and ensure that Inventory Usage Aging is selected as the active database.
2. Doublelick over the Database window to load the Field Manipulation dialog box.

3. Click Append to add the following Virtual field:
e Field Name: PROV_RATE
e  Field Type: Virtual numeric
e Field Length: Do not enter
e Decimals: 2

e Description: Rate at which provision is to be calculated

4. Click in the Parameter box to load the Equation Editor and enter the following equation:
@If(STRATUM <= 1, 0, @If( STRATUM = 2, 50, 100 ))

Note: STRATUM 0 is lower limit exceptions. STRATUM 1 is less than 6 months. STRATUM 2
is 6 to 12 months.
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5.  Click the Validate and Exit button, returning to the Field Manipulation dialog box.

6. Do not click OK on the Field Manipulation dialog box, as a further calculated field will be
added in the next step.

Calculate the Provision (Value) by Product
1. Click Append to add the following Virtual field:
e Field Name: PROV_AMT
e  Field Type: Virtual numeric
e Field Length: Do not enter

e Decimals: 2
e Description: Provision Amount
2.  Click in the Parameter cell to load the Equation Editor and enter the following equation:
TOTALCOST * PROV_RATE / 100.
3. Click the Validate and Exit button, returning to the Field Manipulation dialog box.
4. Click OK and then Yes to append the two fields to the database.
5. View the resultant fields by scrolling to the right of the display. The new fields are added to
the end (last fields) of the database. Note that the data in both these fields is displayed in
teal to distinguish them from original imported fields.

Calculate the Total Provision (Value) by Depot

Note: To summarize the database on more than one field in the key (i.e., by STRATUM within
DEPOT) it is necessary to use the Summarization option.

1. Ensure Inventory Usage Aging is selected as the active database and the Data property is
selected in the Properties window.

2. From the Analysis tab, in the Categorize group, click Summarization.

3. In the Fields to summarize area, select DEPOT and STRATUM.

e

Note that no fields are selected in the Numeric fields to total area. Select the TOTALCOST
and PROV_AMT fields to total these amounts in the summarized file.

Select the Create database option, but do not select the Create result option.
Leave the Criteria box empty.

In the File name field, enter Proposed Provision by Depot.

© N o o

Click OK.
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9.

View the resultant database and note the following fields:
e Depot: List of depots
e  Stratum: Age band (months)
e  No_of_RECS: Number of records band
e TOTALCOST_SUM: Cost of inventory per depot/age band
e PROV_AMT_SUM: Total provision per depot/age band

Notice that the NO_OF_RECS field is blue and underlined. This denotes an Action Field. Click the
blue values to see the underlying records.

There are 4 depots listed in this database. London is not an approved depot. These records should
be investigated.

10.

11.

12.

13.

14.

15.

Flag this database to indicate that it contains significant findings. Currently, it is situated two
levels down in the tree view. To flag a file, highlight the database name to be flagged in
the File Explorer and click the Flag File button on the File Explorer toolbar. The File
Explorer may need to be resized in order to access the button. Alternatively, you can
right-click on the database name in the File Explorer and select Flag file.

After the database is flagged, it will have a new icon and will be moved up in the tree
hierarchy.

To remove the flag from a file, highlight the database name in the File Explorer window
and click on the Flag File button again. Alternatively, you can right-click on the database
name in the File Explorer and select Flag file again.

A report of the proposed obsolescence provision should now be created. Produce a report of
the results with subtotals for each depot.

From the File tab, click Print and then Create Report. The Report Assistant will be
displayed. Accept all options on the first step dialog box to create a horizontal report.
Click Next.

The Report Assistant - Headings step.

i. Modify the following field names by highlighting the field name in the list box on
the left and typing your changes in the Text box on the bottom right.

il. TOTALCOST_SUM modify to TOTAL COST.
iii. PROV_AMT_SUM modify to PROVISION AMOUNT
iv. Click Next.

Report Assistant — Define Breaks step.
i. Enter the report breaks index as shown below:
= DEPOT: Ascending
=  STRATUM: Ascending
i, Click Next.
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16. Report Assistant - Report Breaks step.
i. Enter or select the following options:
e Break Key field: DEPOT
e Fields to Total: NO_OF_RECS, TOTALCOST_SUM, PROV_AMT_SUM
i, Specify a break spacing of 3 lines.
ii. Click Next.

17. Report Assistant — Grand Totals step.
i. In the Fields to Total list box, select the following fields:
e NO_OF_RECS
e TOTALCOST_SUM
e PROV_AMT_SUM
i. Click Next.
18. Report Assistant - Header/Footer step.
i Do not print a cover page.
i, Click Finish. When prompted, preview the report created.

ii. Click Yes. Zoom and navigate through the report.
19.  Print the report by clicking on the Print button on the Preview Window.
20.  Click OK to print the report.
21.  Close all databases by clicking the File tab and then Close All Databases.

Note: Summarization is often used to produce a list of expected unique items for verification (e.g.,
depots in this exercise), as well as producing totals for selected Numeric fields.

Another way to display the proposed provisions by depot is to create a Pivot Table. Pivot Tables
have been used in spreadsheet software for a long time. Pivot Tables can be created easily in IDEA.
The created Pivot Table becomes a Results Output in the source database.

Create a Pivot Table to summarize provision and total cost amounts by depot.
1. Open the Inventory Usage Aging database.
2. From the Analysis tab, in the Categorize group, click Pivot Table.

3. A prompt will require labeling the Pivot Table results. Enter Inventory Usage Pivot Table
and then click OK.

An empty Pivot Table framework appears.

4.  From the Pivot Table Field List dialog box, highlight the DEPOT field name and drag it to
the Drop Column Fields Here area.

5. Highlight the STRATUM field name from the Pivot Table Field List dialog box and drag it
to the Drop Row Fields Here area.

6. Highlight the PROV_AMT field from the Pivot Table Field List dialog box and drag it to the
Drop Data Items Here area
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Test the Accuracy
of the Automatic
Reordering System

7. Highlight the TOTALCOST field name and drag it to the Drop Data Items Here area to
finish the Pivot Table.

8.  Close the Pivot Table Field List.

9.  Print the Pivot Table by clicking the Print button on the Pivot Table toolbar.

Note: This exercise illustrates the interactive mode of using IDEA, i.e., the results of one test
highlights problems and leads to further tests being carried out.

Conclusion
The client’s provision for obsolete items of $9,360 is clearly inadequate as the Chief Financial Officer
suspected. A figure of approximately $150,000 is more appropriate. In addition, the client may

want to take action to dispose of excess inventories. Additional reports of high value items, or
particularly old items by depot, may be useful to the client but are not part of this tutorial.

Objective:
To test the accuracy of the ordering system.
Exercise Description:

A new automatic re-ordering system has been implemented. However, it has been noted that orders
are being lost due to unavailability of the required inventory.

The automatic re-ordering system has maximum and minimum ordering levels. However, these limits
can be manually over-ridden. The level of obsolete inventory and unavailability of inventory point to
the fact that either the limits require review or ordering levels are being incorrectly altered.

IDEA Functionality Covered:

e Use the @Between function

e Index a Database
1. Open and ensure the Inventory at Dec 31 2015 database is selected as the active database.
From the Analysis tab, in the Extract group, click Direct.

Change the file name to Re-Order Level Errors.

A w0 b

To enter the equation, click the Equation Editor button. The Equation Editor will appear
and is used to enter the required equation.
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5.  Enter the expression: .NOT. @Between(QTY , MIN , MAX) as follows:
e  (Click the NOT button.
e In the Functions box, expand the Matching category.
e locate and double-click the function name @Between.

e Doubleclick the QTY field from the lower portion of the Equation Editor dialog
box.

e Type a comma.

e  Double<lick the MIN field from the lower portion of the Equation Editor dialog
box.

e Type a comma.

e Doubleclick the MAX field from the lower portion of the Equation Editor dialog
box.

Note: The @Between() function will be used to test for quantities outside the minimum and
maximum order limits.

The @Between function has three parameters. The first is the field being tested. The second
is a low limit for that field and the third is a high limit. @Between selects those items that
are between the two limits. It is quite common to use @Between preceded with .NOT. to
identify items that are outside the set limits.

Equation
e . I::I = == »* & €= >z =k + - * _.'r AMND OFR MOT MOD EXP E
MOT, @Between(OTY, MIMN, MAX)
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6. Once the equation has been entered, check the syntax by clicking the Validate button. If a
syntax error occurs in your equation, correct the expression and recheck the syntax. The
equation should be as in the above screen. Click the Validate and Exit button.

Direct Extraction
Records to extract: (@) All Startingrecord #: 1
(C) Range Ending record #: 757 Create Fields
Create a virtual database Ficlds
Database order: | Mo index v Delete
File Name Criteria Cancel
1 |Re-Order Level Errors MOT. @Between(OTY, MIM, MAX) Help

2

7. Click OK to run the extraction.

The resultant database will be created and the Re-Order Level Errors database will be
displayed. It should contain 314 items with a total cost of $378,182.783.

This level of items outside the re-order levels confirms serious problems. There are too many
items to investigate so we will prioritize by indexing.
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8.  Sequence the data into the most suitable order for follow-up.
9.  From the Data tab, in the Order group, click Index.

10.  Choose the following sequence:
e QTY: Ascending
e  MIN: Descending

Index

Create Indices | Delete Indices | Re-Index Indices ]

Base index on:

MEW INDEX W
Field Direction oK
amy Ascending
MM |De5cending vl Cancel
Delete Key
Help

11.  Click OK to create the index.

The data is sequenced with the lowest quantity items with the highest minimum re-order
level at the top for investigation.

Briefly inspect the report. This will be given to the client for them to investigate.

12.  Click Close by right<clicking on the Re-Order Level Errors database tab.
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Analyze Selling Objectives:

Prices and Margins

To identify items with inappropriate profit margins.

Exercise Description:

e |dentify items where no current selling price has been entered

e  Analyze the variance in selling price over the year and identify unusually large or
small changes

e Analyze profit margins and extract negative or small margins

IDEA Functionality Covered:

e  Utilize the Criteria option rather than Direct Extraction to identify items
o @If

e Stratification

Identify Items Where No Selling Price Has Been Entered

1.

Open the Inventory at Dec 31 2015 database.

In this exercise, the Criteria property in the Properties window will be used instead of
performing a Direct Extraction to identify the items.

This option is similar to the Direct Extraction option. It is used to identify records satisfying
a given equation but it does not create a database.

Click the Criteria link in the Properties window to load the Equation Editor.

Enter the following equation to identify a missing current selling price:
CURSELLPRI = 0.

Click the Validate and Exit button in the Equation Editor to complete the equation.

The Equation Editor is closed returning to the database with the criterion applied.

Inventory at Dec 31 2015.IMD X

PRODCODE | DEPOT | QTY | ALCOST | TOTALGOST | OBSOLETE | MAX | MIN | DELQTY | ORDERNO | DE Properties
T 421143307 TORONTO 1 24102 24102 Y CH) 2 T60327 O/TE| f = Datsbase

~ Data
History
Field Statistics
Control Total:

24,102
(TOTALCOST)

Criteria:
CURSELLPRI = 0

Note the number of records selected (i.e., 1/767) on the bottom right of the screen. This
indicates that there is one item with no selling price in a database of 767 items.

Note also that this item has a quantity in inventory. The cost of this item is $24.102 as can
be seen near the Control Total link in the Properties window.

Right-click the Criteria link and select Clear to remove the criterion.
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Analyze Selling Price Movements

We decide to test whether prices are being increased or decreased and look for trends. We first
calculate the percentage price movement and then perform an analysis.

1. Ensure Inventory at Dec 31 2015 is selected as the active database and the Data property
is selected in the Properties window.

2. Doublelick over the Database window to load the Field Manipulation dialog box.

3. Click Append to add the following Virtual field:
e Field Name: PRICE_MOQV
e  Field Type: Virtual numeric
e Field Length: Do not enter
e Decimals: 2
e Description: Price Movement
4. Click in the Parameter text box to load the Equation Editor and enter the following
equation:
@If (PREVSELLPRI = 0, 100, (CURSELLPRI - PREVSELLPRI)*100 / PREVSELLPRI)
5.  Click the Validate and Exit button, returning to the Field Manipulation dialog.
6. Click OK and then Yes to append the PRICE_MOV field to the database.

7. Click the Field Statistics link in the Properties window.



222 | IDEA Version Ten Workbook

Calculate the statistics when prompted.

Inventory at Dec 31 2015.MD X

o O @ik W | O ® W WLk~

Field Type Mumeric: Statistics PRICE_MOV

Numeric Met Value 34.351.30

Date

Time Absolute Value 36,524 84

Mumeric: Fields # of Records 767

[ ] PRODCODE Hof Zero tems 0

[lary o

] &v_COST Positive Value 35,658.07

[ ] TOTALCOST Megative Value -1,268.77

E i # of Posiive Records 698

[]DELOTY # of Negative Records 69

(] ORDERNO # of Data Emors 0

[ ] CURSELLFRI

[ ] PREVSELLFRI H of Valid Values 767

[ ] USAGE Awverage Value 44 84

[] PREWCOST

[ ] MOMTHS Minimum Yalue -53.00

PRICE_MOY Maximum Value 11,375.00
Record # of Min 210
Record # of Max 147
Sample 5td Dev 41173
Sample Varance 165,522 55
Pop 5td Dev 411 46
Pop Varance 165,.301.53
Pop Skewness 27 ENTEE
Pop Kurtosis 746 552635
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11.
12.
13.
14.
15.

16.
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Record the Minimum, Maximum and Average values for the PRICE_MOV field.

STATISTIC VALUE COMMENT

Minimum -53.00 At least one item has had major price cuts
Maximum 11,375.00 This is likely to be the correction for an error
Average 44.84 Client feels this is rather high

Again the average figure is skewed so we should prepare a profile.

Return to the database by clicking on the Data link in the Properties window.

Stratify the PRICE_MOV into bands as follows:

From the Analysis tab, in the Categorize group, click Stratification.

In the Field to stratify list box, select PRICE_MOV.

In the Fields to total on, select PRICE_MOV.

In the Increment box, delete the default value and enter 10.

Enter the following stratification bands:

>=LOWER LIMIT < UPPER LIMIT
(50.00) (40.00)
(40.00) (30.00)
(30.00) (20.00)
(20.00) (10.00)
(10.00) 0.00
0.00 10.00
10.00 20.00
20.00 30.00
30.00 40.00
40.00 50.00

Do not select the Create Database box.
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17.

18.

In the Result name box, enter Price Move Stratification.

File name: = Stratification

Stratification
Group by: |don'tgroup W Increment: | 10,00 |
Cut off
Field to stratify: == Lower Limit | < Upper Limit [~
ORDERNO ~ 1 1 |(50.00 {40.00) Fields
DELDATED
CURSELLPRI 2 (40.00) (30.00)
CUREFFDATE 3 |(@0.00) (20.00)
EE.E\&SEE.LPRI 4 (20.00) (10.00)
CevcosT 5 | (1000) 000 oot
MONTHS
PRICE_MOV 6 |0.00 10.00
7 (1000 20.00
Fields to total on: 4 |2000 30.00
[CJoELgTY - 9 |30.00 40,00
[ JORDERNO 10 [40.00 50.00
DCURSELLPR_I
11
DPRE\-'SELLPRI
[ Jusace 12
[ ]PREVCOST 13
[ MONTHS 14
[W]PRICE_MOV 5 - y
Criteria: | |
[]create database Include stratum intervals
Create a virtual database Create result

Result name: | Price Move Stratification

Click OK to perform the Stratification.
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19.  View the Price Move Stratification Results output.

Inventory at Dec 31 2015.IMD X

1 (5 vhe ™
Totalled on: | PRICE_MOV v
Stratum # 5= Limit < U Limt # Records B PRICE_MOV PRICEMOV
1 -50.00 -40.00 4 0.52 -195.21 057
2 -40.00 -30.00 2 0.26 £6.83 018
3 -30.00 -20.00 & 078 -137.05 -0.40
4 -20.00 -10.00 23 3.00 -300.28 087
5 -10.00 0.00 26 339 -162.18 047
& 0.00 10.00 233 3116 1,551.20 451
7 10.00 2000 236 30.77 2592028 245
8 2000 30.00 23 300 8577 150
9 30.00 40.00 5 0.65 159.55 0.46
10 40.00 50.00 2 0.26 230 024
Lower limit exceptions: & 1.04 405 22 -1.18
Upper limit exceptions: 153 2516 30,428 26 8348
Totals: TET 100.00 34.351.30 100.00

The majority of items have had price increases in the range 0 - 20%.

The 193 items in excess of 50% (i.e., the Upper limit exceptions) and those below 50%,
require further investigation.

20. Return to the Data link of the Inventory at Dec 31 2015 database.

21.  Extract any high variances, excluding new items into a database named Major Price
Movements. Enter the following extraction equation using the Equation Editor:

@Abs(PRICE_MOV) > 50 .AND. PREVSELLPRI <> 0
22.  Run the extraction.

Note: @Abs(PRICE_MOV) > 50 identifies increases and decreases > 50%. PREVSELLPRI <>
0 excludes new items.

There should be 15 items of which 7 have usage.
23.  Close the Major Price Movements database.
Conclusion

Most items have had modest price increases. Items should be referred to the client to ensure the
prices are correct.
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Analyze Profit Margins

1.

©® N o o

10.
11.
12.
13.
14.

15.

Ensure Inventory at Dec 31 2015 is selected as the active database and the Data property
is selected in the Properties window.

Double-click over the Database window to load the Field Manipulation dialog box.

Click Append to add the following Virtual field:
e  Field Name: PROFIT
e Field Type: Virtual numeric
e Field Length: Do not enter
e Decimals: 2

e Description: % Profit

Click in the Parameter cell to load the Equation Editor and enter the following equation:
@If (CURSELLPRI =0, 0, (CURSELLPRI - AV_COST)*100 / CURSELLPRI) to calculate profit
as a percentage of price.

Click the Validate and Exit button, returning to the Field Manipulation dialog box.

Click OK on the Field Manipulation dialog to append the PROFIT field to the database.

Click the Field Statistics link in the Properties window.

When prompted, click Yes to create statistics.

Field: PROFIT
STATISTIC VALUE COMMENT
Minimum -28.33 Loss leaders
Maximum 100.00
Average 56.27 Client considers this correct

The average is meaningful here. However items with negative margins should be extracted.
It is often expected that low volume items should have a high margin and high volume items
should have a lower margin.

Return to the Data property of the Inventory at Dec 31 2015 database.

From the Analysis tab, in the Extract group, click Direct.

Enter File Name: Negative Profit Items.

Click the Equation Editor button and enter the equation: PROFIT < 0.

Click the Validate and Exit button on the Equation Editor.

Click OK to extract the items satisfying the equation.

Notice that the three items identified have no quantity or usage so they have not caused the
client any problems, but the client should still be informed.

Close the Negative Profit Items database.
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In order to analyze profit margins by the volume of sales we need the sales information. This is not
available on the file but taking the annual usage figure and multiplying by the current selling price
can make an approximation.

1. Ensure Inventory at Dec 31 2015 is the active database and the Data property is selected
in the Properties window.

2. Doublelick over the database to load the Field Manipulation dialog and click the Append
button to add the following Virtual field:

e  Field Name: SALES
e Field Type: Virtual numeric
e Field Length: Do not enter
e Decimals: 0
e Description: Estimate of Sales
3. Click in the Parameter cell to load the Equation Editor and enter the formula:
USAGE * CURSELLPRI
4.  Click the Validate and Exit button to accept the equation.

5. Click OK then Yes to append the Virtual field.

6.  Analyze the items in turnover bands by clicking Stratification from the Categorize group
on the Analysis tab.

7. In Field to stratify list box, select SALES.
8. In the Fields to total on list box, select SALES.

9.  Enter the following stratification bands:

>= LOWER LIMIT < UPPER LIMIT
0 10,000
10,000 100,000
100,000 1,000,000

10.  Select the Create Database option and enter the File name: Inventory with Turnover
Band.

11.  Click OK to perform the Stratification.

12.  Analyze the items in turnover bands by clicking Stratification from the Categorize group
on the Analysis tab.

13.  Inthe Group by drop-down list, select STRATUM.
14. In the Field to stratify list box, select PROFIT.

15. In the Fields to total on list box, select PROFIT.
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16.

17.
18.
19.

20.

21.

Enter the following stratification bands:

>= LOWER LIMIT < UPPER LIMIT
(50,00) 0.00
0.00 10.00
10.00 20.00
20.00 30.00
30.00 40.00
40.00 50.00
50.00 75.00
75.00 100.00

In the Result name box, enter Profit Stratification.
Click the OK button to perform the Stratification.

View the stratification report for the first key (i.e., Stratum 1) in the Profit Stratification
output of the Database window.

In the STRATUMS= list box, select each stratum in turn and view the Stratification Reports to
view a separate stratification of profitability for each strata of turnover.

Close all databases by clicking the File tab and then Close All Databases.

Audit Findings The following findings should be reported to the client:

e About 13% of the product lines have excessive quantities on stock and a provision
of about $150,000 is suggested.

e The re-ordering system is not working correctly and items have been identified for
investigation.

e  Price increases and profit margins are, on the whole, reasonable but exceptional
items have been identified for follow-up



Section 5

Common Options

Introduction This section of the Workbook provides instructions for options common to all audits, including:

Changing the view of the data and designing reports
Printing (including using the Print Preview option)
Re-running a task

Housekeeping

Reviewing and documenting audits

Managing the use of IDEA

Designing a Report The view of the data may be changed for displaying on the screen and printing.

Options include specifying:

The fields to view and in what order

The display format of the fields including font, color, and data type specific
parameters

The width of the fields

How to stack fields vertically, (i.e., addresses) if required
Hiding Fields not required

Freezing columns on the screen when scrolling

The sequence of records

Criteria (e.g., AMOUNT > 1000) as a filter on which records are displayed

Views can be changed, saved, and retrieved through the View menu as required. Views can also be
applied to other databases of the same format, which is useful for organizational testing on a

regular basis.
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Further options are defined using the Report Assistant, including:

e Horizontal or vertical print

e Show record numbers on the report
e Display field headings and alignment
e  Control breaks

e Sub-totals and totals

e  QOption to print a cover page for the report

All changes/settings will be stored with the last view and will remain current unless changed by
opening a different view or resetting the view settings.

This exercise will show you how to change the view of your database for viewing on the screen and
for printing. Instructions are given for the Accounts Payable database. However, the procedure
may be applied to any database.

Modify the View of the Database

1.

Open the Accounts Payable project by clicking the Home tab and then from the Projects
group, clicking Select.

Note: The project may be selected from the Recent Projects list where a list of the eight
most recently accessed projects is available.

Open the Accounts Payable database and then select to display the fields in the following
order:

SUPPNO, PAYEE, PAY_DATE, CHECK, AMOUNT, AUTH.

The order of fields may be changed by clicking on the field heading to highlight the entire
column, release, then click and drag it to the required position. The field will drop to the
right of the red line.

To hide fields, from the View tab, select the required fields, and then from the Display
group, click Hide Fields.

Heme Data Analysis View Macros SmartAnalyzer

& Open {3 Refresh

- Field Statistics
= =y

=
# *t=
L Highlight Spaces

Hide Freeze Group

o, Zoom Fields Columns  Records
iews Format ] Alignment T pioy Group

o Save Reset
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Modify the column settings for each field as outlined below. To select a field to modify, right
click over a field header and then select Column Settings.

Alternatively, from the View tab, in the Format group, click the Column Settings button.

Home Data Analysis View Macros SmartAnalyzer

{4y Open 3 Refresh

[ Field Statistics
L. Highlight Spaces
@ Zoom

g Save 55 Reset

il
i

Views Format IT.I} Alignment

Column Settings

Change the format of individual  ICE M
columns. 479

File Explorer "
3 [c © M @

Modify the settings for the SUPPNO and PAYEE fields as follows:

SUPI
Woo7

aennT EROY " TR Annn ana T

e Alignment: Left
e Font: Bold
e Text Color: Blue

e Background Color: Light Grey

Holding down the Ctrl key will allow you to select more than one field in the Column Settings
dialog box.

Column Settings
Gereral | printer
Filter on Alignment
(@) all fields i) Left () Center (JRight
Character fields
= Style
[_)Date fields t
() Mumeric fields Use currency symbaol
Time fields |Uze thousands separator
Wrap character fields
SUPPNO [JHide field(s)
PAYEE
INVOICE Megative format:;  -1.00
INV_DATE
AMOUNT . | 1995/12/03
CHECK Date format: 512,
PAY_DATE Width (pixels): | 105
ALITH
PAY_DAYS Font:
Text color: | | NN ~
Background color: || |+ |

QK Help
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6.  Next, modify the PAY_DATE field as follows:
e Alignment: Left
e Font: Regular

e Date Format: Select an appropriate format for your country

Column Settings

General | printer

Filter on Alignment
(®) Al fields (@) Left () Center (_JRight

() Character fields
= Styl
() Date fields tye

() Mumeric fields Use currency symbal

Time fields |Jze thousands separator

Wrap character fields

SUPFNO [T Hide field{=)
PAYEE

INVOICE Megative format:  -1.00
INV_DATE
AMOUNT . v
plebinied Date format: | December 3, 1996

Width (pixels): | g1

ALUTH
PAY_DAYS

Font:

Text color: | N ~

Background color: || |-

7. Modify the AMOUNT field as follows:
e Alignment: Right
e  Use Currency Symbol
e Use Thousands Separator
e Negative Format: (1.00) in red
e Text Color: Red

8.  When all column settings are changed, click OK. Adjust each column width to allow for the
full text of the field names and data.
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Saving the View
1. From the View tab, in the Views group, click Save.

2.  Save the view as Accounts Payable in the Other.ILB Folder. Note that the file will have the
file name extension .vw2.

9] Save As
T J <« Accounts Payable » OtherlLE v & Search Other.ILB 0
QOrganize « Mew folder e I@l
-~ Name : Date modified Type Si

. Favorites
B Desictop Mo items match your search,
4 Downloads

=] Recent places

#& OneDrive
. Documents
. Pictures
1M This PC
Deskt
'Hes op . ol .
File name: v

Save as type: | View Files (*.vw2)

= Hide Folders Cancel
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3. Click Save to save the settings and return to the Database window.

SUPPMNO PAYEE INVOICE INV_DATE | AMOUNT | CHECK
1 | WO0O7 a879-97 4/9/2015 583,516,779 ; 701218
2 | Woo7 972089.29) :6/11/2015 51443219 70139
3 | M100 UP-T6409 10/3/2015 §75,000,00: 701774
4 | M100 784566542 11/1/2015 §59,096.84 : 701875
5 | WoO7 973 PMP 11/27/2015 5458088 ¢ 701945
6 [M100 PI7ad3 2/10/2015 52163222 ¢ 701046
7| C202 51726 3/6/2015 S624274 ¢ TONIT
8 | M100 FLY-9371 4/28/2015 §2792.72 ¢ 70270
9 |Woo7 | LD35622 5/22/2015 525242200 701341

10 | M100 C5-717-97 : 9/15/2015 §75,000.00 : 701728
11 | WooT7 97 2085.29) 1017720015 ¢ 57140978 ¢ 701825
12 | M100 T5352 10/19/2015 : §75,000.00 : 701849
13 | M025 51498 2/10/2015 §50,067.31 ; 701027
14 | C202 13597 2/16/2015 §9.264.18 ¢ 700N
15 | WOOT7 AB 3265 M 3/19/2015 51041283 701166
16 | WOOT7 97/3972/U 8772015 §6,539.64 | T01600
17 | C202 BC 460004 W : 8/21/2015 5588573 ¢ 701650
18 | WoO7 AOV 9712 9/28/2015 §5319.96 ¢ 701764
19 | WOOT7 223197 10/12/2015 | 575,000.00 : 701803
20 [M100 CB3456 11/19/2015 §2922.73 : TN9Z7

Resetting the View
The view settings will remain current until changed, even if the database is closed and re-opened.

To reset the view to the defaults (as when imported), from the View tab, in the Views group, click
Reset.

Opening a View

Apply the saved view by clicking Open from the Views group on the View tab. Navigate to (if
necessary) and select the required view (Accounts Payable.vw2).
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Page Setup

1. From the File tab, click Print and then Page Setup to specify the page setup including
orientation and margins.

2.  Specify Portrait orientation.
3. Adjust or accept the margins.

4.  Click OK.

Note: The current page setup is applied to all database views and reports. The setup is not
saved in the view of the database.

Creating a Report

1. From the File tab, click Print and then Create Report to create a report using the view
settings.

Data Analysis View Macros SmartAnalyzer

Passport . .
° Print Options
Database
Print
Recent @ Print data properties and reports.
Print
Print n
Export
Print Preview
Help ﬁf—‘ View the report before printing.

Options

Print Preview

Exit

Create Report

|E : Use the Report Assistant to design a custom report of the active
i database,

Create Report

The Report Assistant appears.
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2.

Accept all defaults and click Next.

Report Assistant

What type of report would you like to build?
(®) Horizontal
i) Vertical

[ tome  smer o pme | One record per page

(@) Use existing report
I_JCreate new repart

[ ] allow headings to span multiple lines
Show record numbers
Indude database name in repaort

< Back Finish Cancel

IDEA allows you to specify the font, alignment and name for each heading.

Help
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Modify the report headings as follows:

FIELD NAME HEADING
SUPPNO SUPPLIER NUMBER
PAYEE PAYEE
PAY_DATE PAYMENT DATE
CHECK CHECK NUMBER
AMOUNT PAYMENT AMOUNT
AUTH AUTHORIZED BY
Report Assistant - Headings

Define the names and alignment for each of the field's headings

SUPPNO Headings font:

PAYEE

INVOICE Alignment

INI'“‘—DATE — — — —

AMOUNT ®Left (JRight () Center () Justified

CHECK

PAY DATE

ALTH Text

PAY_DAYS

ALUTHCORIZED BY|
< Back Finish Cancel Help

Click Next.

The following step is used for defining if and where control breaks (required for sub-totals in

reports) are required.

There can be up to eight fields in an index/ sort order; therefore, up to eight break

levels can be defined.
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5. Sequence the database records in the following order:
e  SUPPNO: Ascending
e PAY_DATE: Descending

Report Assistant - Define Breaks

Select what fields you would like the report to break on
Baze break on:

SUPPNO/A + PAYEE/A W

Field Direction Delete Key
SUPPMO Ascending

PAY_DATE

< Back Finish Cancel Help

6.  Click Next.
Note: The records will be displayed in the order of the index.

The index description will be displayed in the Available Indices box in the center of the
Database toolbar.

The following step is only provided if at least one field was selected in the previous Define
Breaks step.
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7. Create a break and total the AMOUNT field for each supplier number. Complete the options
as in the dialog box below. Click Next.

Report Assistant - Report Breaks

Break Keys Fields to Total
Count records in break [W] AMOUNT
PAY_DATE Show break line [«f]cHECK

Show leading break PAY_DAYS

Break spacing: |3 Lines v
Break an this field [] show shading
[]5how shading [ ]use currency symbol

Text: [~ Text: [~
Background: |[L.. ] Background: |[L.. ]~
Faont Fant

< Back Finish Cancel Help

8.  Create grand totals for the AMOUNT field and set the font to bold. Click Next.

Report Assistant - Grand Totals
Select the fields to total:
AMOUNT Show shading
[ JCHECK Use currency symbaol
[ |PAY_DAYS Text: [~
Background: |[... |~
Font

< Back Finish Cancel Help

Grand totals can be included whether or not break totals were requested or not. Note that
you can alter the appearance of the totals and include currency symbols.
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9.  Select the Print cover page option and enter appropriate headings.
e Title: Accounts Payable Report
e Comments: Ordered by Supplier Number and Payment Date
e Prepared by: Enter your initials (or accept the default user name)
e Header: Enter your organization’s name

o Date/Time: Leave defaults unless you have particular preferences

Report Assistant - Header/Footer

Print cover page

Title: | Accounts Payable Report
Comments: | Ordered by Supplier Mumber and Payment Date

Prepared by:| IDEA Cover Page Font

Header: | Dynamic Accountants| | Date: | pper left W

Footer: Time: || jnper right W

Header Footer Font

< Back Mext = Cancel Help

10.  Click Finish.

Note: You will not see any changes on the screen. The options you have selected/changed
affect how the view will be printed.
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Print Preview and Print Preview

Print the Report _ ] _
1. Once the report has been created using the Report Assistant, you will be prompted to

preview the report created. Click Yes.

CaseWare IDEA “

e Do you want to preview the report you just created?

Alternatively, click No and click Print Preview from the File tab.

Home Data Analysis View Macros SmartAnalyzer

Passport

Print Options
Database
Print
— . .
Recent E‘ Print data properties and reports,
Print

Print

Export

Print Preview
Help ﬁﬂ View the report before printing.

Options Print Preview

Exat
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If prompted, reduce the font size to fit to page.
View the report, toggling between a single page and two pages.

Zoom in to view the report in detail.

o &~ w0 DN

Check that all settings, including field widths, are correct. Adjust any settings, if necessary.

Note: If you wish to print the view, click the Print button on the Print Preview window.
6.  Close the Print Preview Window.

7. From the View tab, in the Views group, click Save to save the view of the database. Select
and save the view as Accounts Payable.vw2.

Note: If column widths in the database report are too narrow, the field contents are
displayed as follows:

e Character field: Text is truncated from the right
e Numeric field: Contents displayed as ##########

o Date field: Dates are truncated from the right

Field widths can be adjusted in the Data property before printing, if necessary.
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Within IDEA, the data and the following reports can be printed and used for testing, reviewing,
audit reports, or for audit working paper documentation.

Database Window

Database View — the data in the current format.

History View — the History log (for review and documentation).

Field Statistics View — the statistics for each Numeric and Date field in the
database.

Results Views — which holds the reports for the following tests:

Stratification
Summarization (optional)
Aging

Gap Detection

Sampling

Chart Data

Benford’s Law

Pivot Table

Correlation

Trend Analysis

Time Series

Macro Window

IDEAScripts - the source code for any scripts.

IDEA uses standard Windows print routines and will recognize all printers and fonts installed
through Microsoft Windows.

Many reports and views may also be printed through the Print Preview option, either through the
File tab, Report Assistant, or if a Print Preview button is available on the view's toolbar.

Before selecting the print option, ensure the printer options have been correctly set through Print

Setup.

Select the required Database, History, or Results output to be printed then click the Print button
on the Operations toolbar, or select File toolbar and the Print button.

The Print dialog box will be displayed. Specify the print options required.

It is important when printing a report, to also print the History and attach it to the database report

for review.
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Re-Run a Task The Re-run Task is used to re-run the last task (i.e., Extraction, Stratification, Summarization,

Housekeeping

etc.) with different parameters. This is particularly useful for correcting errors or for "what-if ?"
scenarios.

When running a task in IDEA, the dialog box settings are saved. When Re-run Task is selected, the
dialog box is populated with the saved settings. A numeric suffix is added to the result or database
names. Any or all parameters may then be modified as required to re-run the test.

A task may also be re-run from the IDEAScript code stored in the History log of the database.

To re-run a task, ensure the resultant (child) database created from the task is the active database
then re-run the task on any parent database using the following steps:

From the Analysis tab, in the Tasks group, click Re-run Task.

The task dialog box with the parameters for the last test will be displayed. Modify any or all of the
parameters as required and then click OK to re-run the task.

The Re-Run Task can also be used to re-do an import.

IDEA creates databases from most tasks with the consequence that the list of databases builds up
quickly. Therefore, housekeeping routines {(including backing up data and deleting unwanted files)
are important when working with IDEA.

Housekeeping functions such as deleting and renaming databases are carried out from within IDEA.
However, functions such as backing up and restoring databases are carried out through the
Windows File Explorer.

Managing Folders and Project Properties

All the files relating to one project/audit should be kept in a separate project folder. This makes it
easier to locate and manage the files and reports relating to an audit and reduces the risk of
overwriting files. It is also easier to back up all the files pertaining to each audit once it is complete.

The folder can be created using Microsoft Windows File Explorer or through the File Explorer
window in IDEA. Also IDEA will automatically create a folder when the Managed Projects is
selected

It is not necessary to store the original databases/files to be imported in this folder, but it is
recommended that the files be stored under the Source Files.ILB folder. Any databases generated
by IDEA will be stored in this Project Folder.

Once the Project has been created, it is necessary to enter project information within IDEA. This
information will then be printed on all reports.
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Creating a Project Folder and Enter Project Properties
Create the Project, as done in previous exercises of the Workbook.

Create the required project and enter the appropriate project information in the Properties dialog
box.

Home Data Analysis View Macros

Project | Create | Select ppcpjve Properties  Desktop
Overviey -
Projects Import

Change the Project Properties

To change the Project Properties, from the Home tab, in the Projects group, click Properties.
Make any necessary changes and click OK.

Home Data Analysis View Macros

Project Create Select pppje|Properties] Deskbop
Owenview -
Projects Import

Change the Project

To change the Project, from the Home tab, in the Projects group, click Select. If any databases are
open in the current folder, you will be asked if you wish to close these before opening the new
project.

Home Data Analysis View Macros
z Rl R BE

Project Create| Select |a e Properties  Desktop
Overview -
Projects Import

Note: Once Project Folder is set, it remains the active folder until changed.
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Create a New Project Folder or Sub-folder

You can create a new folder to organize displayed databases in the File Explorer by clicking the
File Management button.

File Explorer
ahle < o I
Create Folder
Open
Rename
Append

Join

Copy to Managed Project...

To create a new sub-folder within the current Project Folder:

1. Click the File Management button on the File Explorer toolbar, and then select Create
Folder.

The Create New folder window appears.
2.  Enter a name for the new sub-folder, and then click OK

3.  Drag databases displayed in the File Explorer into the new folder.

IDEA displays the moved databases as sub-directories of the folder in both flat and tree
views.
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Backup/Restore Data Files

You may wish to backup files for a variety of reasons (i.e., to transfer files to another computer, to
backup files according to risk/criticality of data, or because of disk space restrictions).

IDEA uses a single compound file with the filename extension .IMD to store all the information
associated with a file, including the data, the schema, the History log, notes, indices, and test
reports.

Each of these files will be stored in its Project Folder as specified from the File menu. However, the
view files, equation files, definition files, and any text files created are not stored within the
compound file. Files are stored as follows:

FILE FOLDER NAME
Data and related files Project Folder Filename.imd
Views Other.ILB folder Viewname.vw?2
Equations Equations.ILB folder Equationname.egx
Record definitions Import Definitions.ILB folder Filename.rdf
Print Report templates Results.ILB folder Filename.jpm
Project information Project Folder Client.inf
IDEAScript source code Macros.ILB folder Scriptname.iss

Use File Explorer or any other backup facility to backup the required files.

Note: Use compression utilities such as WinZip or PKZip to compress the file before backing
it up to reduce the file size.

Deleting Data Files
If a database is no longer required, it can be deleted, provided that it is an active database.
To delete the active database, from the File tab click Delete Database. Confirm the deletion.
To delete all or selected databases:

1. Ensure all databases are closed.

2 Expand out all nodes on the File Explorer window to display all databases.
3. Select the databases to be deleted.
4

Click the Delete button on the File Explorer toolbar.

0 1 |W007 | Matt Cash
) 2 |wWo07 [ IMA Crool
ih Inc

Delete
Delete the selected database(s) andjor folder(s).

|

sh
ASH
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5. Confirm the deletion. If you wish to use the Recycle Bin when deleting files, ensure the
option is selected in the Options dialog box selected from the File tab.

IDEA Options

User interface options

Database Grid
Reports Automatically generate output database names
Automatically generate result names
Folders
[T] Disable popup help
Customize Ribbon

[T] Do not record field changes made through Editable fields in History
Quick Access Toolbar Do not allow the deletion of non-virtual fields

["] Enable IDEA Server Only Mode

[T] Disable the Re-run task for exports

Date options

Century cutoff: 30

weekends...

Files

Always use IDEA Library folders when opening or saving a file
Do not generate a "Bad Data”™ database when importing data
I Usze Recycle Bin for deleted files I

If the database does not reside on your local machine, but on a server, when deleting a
database it is removed to the recycle bin.

Deleting Other Files

Use Windows File Explorer to delete other files, such as record definitions, view, equations, and
masks.

Cancel
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It is sometimes necessary to have the same database in two different project folders. IDEA allows
databases to be copied to multiple project folders. To copy one or more selected databases to
another project folder:

1.
2.
3.

4.
5,

Select the required databases in the File Explorer window.

Right-click over the File Explorer.
Select Copy To.

Open...

Rename

Delete

Append with Open Database...
Join with Open Database...

Copy To.. I},
Move To...

Find Database in Project Overview..,
Flag File

Force Unlock

Convert to Current Diatabase Format

Navigate to the required folder.

Click OK.

Move Data Files

To move one or more selected databases to another project folder:

1.

2
3
4,
5

Select the required databases in the File Explorer window.
Right-click over the File Explorer.

Select Move To.

Navigate to the required folder.

Click OK.
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Refresh the File Explorer

To update the IDEA File Explorer, select the File Explorer and click on the Refresh List button or
press the F5 key.

C q. =
File Explorer —
S o= 1 | Woov
(1]
s [ . o 2 | woo7
Desktop Projectay e
Mame Refresh List
o Accoy Update the list of databases in the File Explorer.

The File Explorer

Databases can be viewed and managed through the File Explorer window. The File Explorer
window displays a list of available IDEA databases (filename.imd) in the Working Folder. This is a
movable, dockable window and may be resized to display the following information about all IDEA
databases in the current Working Folder:

e  File name

e Number of records

e File size

e Date and time of last modification

e Date and time of creation

The order of the databases may be changed as follows:

. 4 i
File Explorer —
y = 1 [woo7
(1]

L3 BP\R" 2 | Woo7
Desktop g

Mame File Display

- Change haw your files are displayed within the File Explorer.

Show Hierarchy

Databases are normally displayed in a Hierarchy, showing the Parent - Child relationship between
databases. Each parent database node may be expanded to show the child databases or collapsed
to the parent level, as required. If the databases are not displayed as a Hierarchy, click the File
Display button on the File Explorer toolbar. This will become more relevant once testing has
commenced.
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Sorted Order

When the Show Hierarchy is turned off, the databases may be sorted by any information
parameter in the File Explorer window, such as by file name or file size.

Click the Show Hierarchy button. Double-click the heading bar of the parameter to sort the
databases in the ascending order. Double-click the heading bar again to sort the databases in
descending order.

File Explorer
s o m

Desktop Project

Mame . Records
..... "# Accounts Payable e
..... TH Authorized by HMY 399
..... 29 Authorized Supplier ... 2
..... 79 Authorized Supplier... 43
..... ¥ Benford First Digit 9
----- =§ Benford First Three.... Q00
----- =3 Benford First Two Di... a0
..... =# Benford Last Two Di... 100
----- ¢ Benford Second Digit 10
..... 19 Benford Second Ord.., 90
..... 1 Benford Summation 90
..... 1@ CASH in PAYEE name 20
..... 7 Duplicate Payments 3
..... °# Large Movements 14
..... 79 Payment days outsi... 85

Rename a Database
Database names may be changed and recorded in the History log.
To rename a database:
1. Make sure the database is closed.
2.  Click on the database name in the File Explorer window.
3. Edit the database name as required when the editing option becomes available.

Alternatively, right-click on the selected database name in the File Explorer window and select
Rename.
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Review and Standards should be set for the use of IDEA. These may vary from organization to organization
Housekeeping depending on the usage of IDEA and the existing procedures, style, and culture of the organization.
However, they should include:

e  Objectives

e Required documentation

e  Reconciliation/checks on files imported
e  Review of work done

e Security

e  Backup of work

e Housekeeping

The range of tests available within IDEA is so wide that a considerable amount of time and effort
can be wasted on irrelevant tests if objectives are not set. It always pays to know what is to be
achieved.

Documentation depends on an audit department's procedures but should cover all the points listed
above, perhaps with standard schedules for reconciliation, file details, and review.

Most files can be agreed to known control totals. These may be record counts, totals of certain
financial fields, or slightly more complex analysis of certain fields. In addition, it is usually a good
idea to agree each field in a selection of records with screen enquiries or printouts to check that
they have been imported correctly.

Mistakes can be made in using IDEA as with any technique. Hence, the work should be reviewed.
Review procedures are often compliance based, checking that documentation is complete and that
reconciliations have been carried out.

IDEA maintains a History log of all operations carried out on a database, including its import and
each audit test. It produces a linear log so that the process of how the database was created can be
traced. The History log cannot be modified or deleted.

The most common errors are:

e Incorrectly specified formula

e Joins with primary and secondary databases performed incorrectly
e Incorrect join method used (there are five join methods)

e Incorrect fields totaled on summarization

e On complex work involving several steps, performing joins, summarizations, and
extractions completed in the wrong order

These can all be checked and "ticked" in true auditing fashion on a printed (or electronic) copy of
the History log.

The History log is contained within the database's IDEA Merged Document (filename.imd).
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View the History Log of a Database
1. Click the History link in the Properties window.

2.  Each test or function is displayed in a collapsed node with its title, date and time, and the
user name.

Expand out a node to view its details by clicking on the plus button.
Expand out all nodes by clicking the Expand All Details button on the History toolbar.
Collapse a single node by clicking on the minus button.

Collapse all nodes by clicking the Collapse All button on the History toolbar.

N o o b~ ow

The History log can be printed by clicking on the Print button on the Operations toolbar or
from the File menu. The History log will be printed as displayed, either collapsed or
expanded.

Adding a Comment to the Database

The Comments option is used to add a comment to the active database. It may be used to:

e Annotate the audit steps, giving an explanation of the objective
e  Explain results
e Add review points
e Attach any documentation that can be cut and pasted into the comment
To add a comment:
1. Click the Add comment link in the Comments area of the Properties window.
2.  Enter your comment and then close the Database Comments dialog box.
3. View the comment in the Comments area of the Properties window.
To delete a comment:
1. Right<lick the comment link in the Comments area of the Properties window.
2.  Select Delete comment.
Accessing Project Overview
The History feature shows the actions taken to receive the database results. Project Overview is a
graphical overview of the actions performed within a Project Folder, including the creation,
deletion and modification of databases. Project Overview records all database interactions and
shows the complete history of what has transpired within the Working Folder. In the graphical
format of Project Overview, IDEA allows you to create a Visual Script or IDEA Script macro. A
table view format is also available.
To access Project Overview:

From the Home tab, in the Projects group, click Project Overview.

Alternatively, right-click on the database in the File Explorer menu and select Find database
in Project Overview...
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Managing the Use To get the most out of IDEA it needs to be used for an appropriate purpose and its use kept to the
of IDEA objectives. There may be an initial cost in downloading data. The payback depends on the audit
objectives and scope.

In managing the use of IDEA the following issues need to be considered:

Check that the planning has identified a series of good objectives. These may be
analysis work, exception tests, duplicates, matching or any of the tests that IDEA
will perform.

Check that work is not being duplicated. If IDEA is being used, then it is likely that
some manual work or tests can be dropped (unless IDEA is being used for new or
additional exercises).

The time to be spent on using IDEA should be budgeted. The time to perform
tests and create reports is relatively brief. What can take considerable time is
follow-up on items in the reports.

In addition to audit purposes, IDEA can generate a number of very useful reports
for management. The auditee’s needs should be considered and any extra value
that can be obtained added.

Another consideration is compliance with all relevant legislation. Some countries have laws
regarding the use of data, notably personal data, such as the province of Ontario’s Freedom of
Information and Protection of Privacy Act and Municipal Freedom of Information and Protection of
Privacy Act. Therefore, care needs to be taken that no legislation is being breached.



Section 6

Other Uses of IDEA

Introduction The audit manager of Dynamic Accountants has completed the year-end audit. Both the audit
manager and the Chief Financial Officer (CFO) of Bright IDEAs Inc. were satisfied with the work
that was completed for the previous sections. The CFO was especially pleased with the computer
assisted audit techniques used on the engagement.

The CFO is planning on engaging Dynamic Accountants to assist Bright IDEAs Inc. with
implementing IDEA within their organization. However, before the CFO plans to pursue this
strategy, he wanted to know what other tests can be completed within the organization.

This section summarizes other uses of IDEA that could be considered.

Case Scenario: 1pe crQ of Bright IDEAs Inc. wanted to know what other tests can be completed within the
Other Uses of IDEA organization. Some areas that he is specifically interested in are:

Sales transactions: Bright IDEAs Inc. recently implemented a new billing system
that connects to the existing inventory system. The sales managers are concerned
about the billing process. Based on their analysis of the financial statements, there
seems to be a discrepancy between the increase in inventory and sales revenue.

Travel expenses: Sales personnel can expense amounts related to travel for all
trips made outside their designated areas. Travel expenses have been increasing
and the CFO would like an explanation.

Payroll: Bright IDEAs Inc. has rolled out a plan to offer early retirement to
certain employees. The company is interested in costs savings and ensuring that
the company retains sufficiently qualified personnel within their departments. The
company is also concerned about complaints that they have received from their
employees regarding their bonuses. The bonus is calculated based on seniority,
number of days absent, and the employee’s annual evaluation score.

Security: As part of its monitoring of its security practices, management wishes
to assess the company's controls over access to the system and related data.

The company has approached you for advice on tests that could be done using IDEA to address

these issues.
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Other Potential
Tests

Sales Transactions
Mechanical Accuracy and Valuation
The following tests could be conducted:

e Total, sub-total by period, category, division, and so on.
o Check sales tax treatment.
e  Check discounts offered for adherence to company policy.

e Check commission sales for compliance with company policy.
Analysis
The following analyses could be conducted:

e Summarize sales by period, category, division, and so on.

e  Summarize sales returns by period, category, division, and so on.
Existence and Validity
The following tests could be conducted:

e Exception testing: Analyze sales transactions, isolating unusual transactions for
review.

e Statistical sampling: Select a statistical sample for compliance testing of
attributes such as approvals and supporting documents.

e Duplicates testing: Test for duplicate sales entries.
Completeness
The following tests could be conducted:

e Gap detection: Test the sales files for missing invoice numbers.

e Matching: Reconcile sales invoices, customer orders, and shipping notes.

Identify goods shipped, but not invoiced. This can be achieved by a 3-way match using the common
key between the documents (e.g., purchase order number).

Cut-off
The following test could be conducted:
e Check sales cut-off by checking shipment date and/or input date.
Travel Expenses
Mechanical Accuracy and Valuation
The following test could be conducted:

e Total, sub-total by period, category, division, and so on.



Section 6: Other User of IDEA | 257

Analysis
The following analysis could be conducted:

e Summarize expense claims by employee and determine if some employees have
unusually high totals.

Existence and Validity

The following tests could be conducted:

e Exception testing: Identify receipts submitted exceeding the maximum rate (i.e.,
as per company policy). Identify sales personnel without any expense claims
(they could be fictitious employees).

e  Statistical sampling: Select sample of expense claims and ensure that they
comply with company policies and are approved by the appropriate
personnel.

e Duplicates testing: Identify duplicate expense claims.
Cut-off
The following test could be conducted:

e Check if there are expenses claimed by the employee after the date of
termination.

Payroll
Mechanical Accuracy and Valuation
The following tests could be conducted:

e Re-perform calculation of net pay.

e Recalculate the allocation of shares to a company pension plan based on the
prescribed formula.

e Recalculate investment income allocated to each employee.
Analysis
The following analyses could be conducted:

e Summarize payroll expenses (e.g., by distribution category).

e Perform month-to-month or year-to-year comparisons (e.g., number of employees,
hours worked, and gross pay).

e Determine the impact of the early retirement program within given areas. For
example, areas with a significant number of early retirees could face a severe
shortage of resources to achieve specified goals.

e |dentify hiring needs based on departures.
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Existence and Validity

The following tests could be conducted:

Completeness

Exception testing:

e Analyze the stream of payments and extract unusual items (e.g.,
excessive hours and rates).

e Identify blank or invalid Social Insurance Numbers.

o |dentify employees without standard information (e.g., location, e-mail,
and extension).

e |dentify employees without pay, negative pay, or without deductions.

Statistical sampling: Select a statistical sample of payments for compliance
and/or substantive verification against supporting documentation in personnel
files.

Duplicates testing: Identify duplicate Social Insurance Numbers.

The following tests could be conducted:

Cut-off

Gap detection: [dentify gaps within sequence of employee numbers and obtain
explanations for those gaps.

Matching: Match gaps in employee numbers against list of terminated
employees.

The following test could be conducted:

Access Controls

Check for payments to employees after the date of termination and follow up to
ensure the payments were justified.

The following analyses could be conducted to test the effectiveness of access controls:

Analysis

Summarize access privileges by employee and determine whether employees have
incompatible access privileges (to ensure that segregation of incompatible
functions is enforced).

Summarize employee access privileges and determine whether employees have
greater access privileges than they need to perform their jobs (to ensure that the
principle of least privilege is enforced).

Summarize system accesses outside of normal business hours by employee and
determine whether there is unusual activity that needs to be followed up.
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Exception Testing

e Identify user accounts that deviate from the prescribed password policy.
e Identify user accounts that do not correspond to the normal naming conventions.

e Identify inactive or dormant accounts; i.e., access codes that have not been used
within the past 3-6 months. Such accounts should be purged from the system to
prevent their abuse.

Statistical Sampling

o  Select sample of employees and check that they were properly screened prior to
being given access to sensitive information.

e Select sample of accesses and trace to current employee file. Match user profiles
and privileges documented in the employee file to the user profile maintained in
the operating system (to ensure that only authorized personnel have access to the
system and that the privileges in effect do not exceed those granted by the
business unit).

Duplicates Testing

o Identify employees with multiple access codes and determine whether all of the
codes are needed. (Extra/infrequently used codes represent a security risk).

Matching
e  Reconcile vendors listed in master file to independent authorized list of vendors
(to ensure that systems personnel have not bypassed normal master file
authorization procedures).
e Summarize all users accessing the system and match users accessing the system
to employee file.
Cut-off

e Check list of terminated employees against users accessing the system after the
date of termination.
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IDEA Functionality IDEA Functionality Covered in this Workbook

Covered in this
Workbook

IDEA Functionality A/R Audit Inveﬁé;tion Inventory
Analysis
Project Setup
Create a new l\/lanag_ed project and .29 p. 100 p. 192
enter project properties.
Import Data
Microsoft Access database file .32
ASCII Delimited file p. 102 p. 193
Microsoft Excel worksheet p. 112
Print Report file .71
Verify Data
Open/Select a database p.218
Set a Control Total .37, p. 80 p. 121
Flag a database p.216
Analysis
Field Statistics .39 p. 116, p. 165 | p. 200, p. 203
Stratification p. 122 p. 206
Summarization . 68 p. 178 p. 214
Aging .53 p. 206
Pivot Table p. 217
Exception Testing
Extractions .42, p. 59, p. 132, p. 134, | p. 204
. 89 p. 159, p. 180
Criteria .62 p. 206, p. 218
@Functions p. 165 p. 206, p. 214,
p. 218, p. 222
Display All Records Containing . 88
Benford's Law p. 139
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IDEA Functionality A/R Audit A/P Inventory
Investigation
Analysis
Calculations
Field Manipulation (Virtual Fields) p. 65 p. 165 p. 214, p. 223
Field Manipulation (Editable fields) p. 171

Gaps and Duplicates

Gap Detection p. 154, p. 159
Duplicate Key Detection p. 149, p. 176
Duplicate Key Exclusion p. 151

Matching and Comparing

Join Databases p. 81 p. 171

Sampling

Random Record Sampling p. 50

Re-Run Task p. 246 p. 246 p. 246

Reporting and Printing

Create views and reports p. 231 p. 231 p. 231

Printing p. 243 p. 243 p. 243

Housekeeping

Create new projects p. 248 p. 248 p. 248
Manage folders and project properties | p. 246 p. 246 p. 246
Backup/Restore data files p. 249 p. 249 p. 249
Delete, copy, move data files p. 249 p. 249 p. 249
File Explorer p. 252 p. 252 p. 252
Rename a database p. 253 p. 253 p. 253

History Logs

Insert/Delete a comment p. 255 p. 255 p. 255
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IDEA Functionality e Importing EBCDIC and ASCII Fixed Length Files
Not Covered in

g e Importing Lotus 1-2-3 Spreadsheets
this Workbook

e Importing Variable Length Files
e Bad Data Handling

e Appending Databases

e Comparing Databases

e Show Field Stats

e  Customizing IDEA including Toolbars and Options
e Indexed Extraction

e  Key Value Extraction

e  Top Record Extraction

e Sorting Databases

e  Describe Sorted Order

e  Group Records

e  Character Gap Detection

e Date and Character Stratification
e Sampling Techniques other than Random Record Sampling
e IDEAScript Programming Tool

e  E-mailing Databases and Reports
e  Exporting Data

e  Correlation

e Trend Analysis

e Time Series

e  Visual Connector

e  Custom @Functions

e  Project Overview

e  Visual Script






